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Informations importantes destinées à l’utilisateur
En raison de la diversité des utilisations des produits décrits dans le présent manuel, les personnes qui en sont 
responsables doivent s'assurer que toutes les mesures ont été prises pour que l'application et l'utilisation des 
produits soient conformes aux exigences de performance et de sécurité, ainsi qu'aux lois, règlements, codes et 
normes en vigueur.
Les illustrations, schémas et exemples de programmes contenus dans ce manuel sont présentés à titre indicatif 
seulement. En raison du nombre important de variables et d'impératifs associés à chaque installation, la société 
Allen-Bradley ne saurait être tenue pour responsable ni être redevable (y compris en matière de propriété 
intellectuelle) des suites d'utilisation réelle basée sur les exemples et schémas présentés dans ce manuel.
La publication SGI-1.1, Safety Guidelines for the Application, Installation and Maintenance of Solid State Control 
(disponible auprès de votre agence commerciale Allen-Bradley) décrit certaines différences importantes entre les 
équipements électroniques et les équipements électromécaniques, qui devront être prises en compte lors de 
l�application de ces produits, comme indiqué dans la présente publication.
Toute reproduction partielle ou totale du présent manuel sans l'autorisation écrite de la société Rockwell 
Automation est interdite.
Des remarques sont utilisées tout au long de ce manuel pour attirer votre attention sur les mesures de sécurité à 
prendre en compte :

Les messages « Attention » vous aident à :
• identifier un danger ;
• éviter ce danger ;
• en discerner les conséquences.

Allen-Bradley, MicroLogix, ControlLogix, SLC, PLC, RSLogix, RSLinx, PanelView, PanelBuilder32 sont des marques commerciales de Rockwell Automation.
DeviceNet est une marque commerciale de l�Open DeviceNet Vendors Association.
Modbus est une marque commerciale de Modicon, Inc.
Microsoft, Windows et Windows NT sont des marques déposées de Microsoft Corporation aux Etats-Unis et/ou dans d�autres pays.

ATTENTION

!
actions ou situations risquant d�entraîner des blessures pouvant être mortelles, des dégâts 
matériels ou des pertes financières.

IMPORTANT Informations importantes dans le cadre de l�utilisation du produit.
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Préface

Le logiciel PanelBuilder32 permet de créer des applications de panneaux de commandes pour la gamme de 
terminaux PanelView standard. Ces terminaux offrent des options de communication souples qui permettent 
d'exécuter les applications dans une grande variété d'environnements, dont :

• DH+ 
• Voyants LED RIO 
• DH-485
• RS-232 (DH-485)
• DeviceNet 
• ControlNet
• EtherNet/IP
• DF1
• Protocoles Modbus et autres

Vous pouvez consulter en ligne le guide de mise en route de PanelBuilder32 avant de créer votre propre 
application. Ce manuel décrit les différentes étapes de la création d'une application et explique comment charger 
et exécuter une application dans un terminal PanelView. Il présente la logique à relais pour chacun des 
protocoles de communication mentionnés ci-dessus.

Public intéressé
Ce manuel s'adresse aux personnes chargées de concevoir des applications de panneaux de commandes 
exécutées sur les terminaux PanelView.

Il demande une bonne connaissance de base des automates PLC®, ControlLogix , SLC 500  et MicroLogix  
ainsi que du réseau de communication sur lequel sera exécutée l�application. Dans le cas contraire, il est conseillé 
de suivre un stage de formation approprié avant d'utiliser ce produit.

Objet de ce manuel
Ce manuel fournit les informations nécessaires à l'utilisation du logiciel PanelBuilder32 et complète l'aide en 
ligne du logiciel. 
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Contenu du manuel
Chapitre Titre Contenu

Préface Décrit l’objet et le contenu du manuel et répertorie la documentation connexe 
en ligne. Indique également à qui s'adresse le manuel.

1 Installation de PanelBuilder32 Décrit l'installation de PanelBuilder32 à partir du lecteur de CD-ROM.

2 Utilisation de PanelBuilder32 Présente les principes de base d’utilisation et de navigation du logiciel Panel 
Builder32. 

3 Applications et vues Décrit les principales opérations que l'on peut effectuer sur les fichiers 
d’application et les vues, telles que l'ouverture, la fermeture et 
l'enregistrement.

4 Objets Présente les objets de contrôle et d’affichage disponibles et explique 
comment créer et configurer ces objets. Ce chapitre couvre également 
certains principes de base de l'utilisation des objets, tels que la sélection, le 
dimensionnement, le déplacement, l'alignement et la modification d'objet.

5 Alarmes Décrit les composants des alarmes (bandeau, liste, messages et 
déclenchement) et explique comment les configurer.

6 Texte Indique comment saisir et formater le texte à l'intérieur des objets ou 
directement dans une vue. Explique également comment utiliser l’éditeur de 
texte de l’application pour manipuler les chaînes de texte et comment saisir le 
texte dans différentes langues. 

7 Graphiques Explique comment ajouter des graphiques simples tels que lignes, lignes 
brisées, rectangles, ellipses, symboles ISA et images bitmap dans les vues et 
les objets. Explique également comment importer des images bitmap créées 
dans d'autres programmes et comment les exporter pour les modifier.

8 Formatage des objets Décrit les différents outils utilisés pour modifier l'aspect des objets et 
appliquer des couleurs.

9 Utilisation de l’éditeur de 
points

Explique comme utiliser l’éditeur de points pour saisir et modifier les points de 
l’application et comment importer/exporter les points depuis/vers un format 
de fichier compatible.

10 Configuration de l’application Explique comment configurer le réseau pour permettre au terminal de 
communiquer avec un automate ; décrit la configuration du terminal à la mise 
sous tension et celle du port imprimante ; présente les options d’affichage et 
d'autres options évoluées.

11 Transfert des applications Présente les principes de base du chargement et du transfert d'applications, 
et les différentes options disponibles.
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Documentation en ligne
Par souci de commodité, une version PDF de tous les manuels PanelBuilder32 et PanelBuilder vient s'ajouter à 
l�aide en ligne. Ces fichiers PDF se trouvent sur le CD d�installation. Pour toutes informations concernant 
l'utilisation d�Adobe Acrobat pendant la visualisation d'un fichier PDF, sélectionnez Aide en ligne d�Acrobat 
depuis le menu Aide.

Les documents suivants existent sous forme de fichiers PDF.

Documents PanelBuilder32

Documents PanelBuilder 2.60

Documents PanelBuilder sur les protocoles de communication

Publication Description

2711-GR003C-FR-P Guide pratique de PanelBuilder32

2711-QS003C-FR-P Guide de mise en route de PanelBuilder32

2711-UM014C-FR-P Manuel d'utilisation des terminaux opérateur PanelView

Publication Description

2711-6.0FR Manuel d'utilisation du logiciel PanelBuilder

2711-6.2 PanelBuilder Getting Started Manual (Guide de mise en route de 
PanelBuilder)

Publication Description

2711-6.9FR Communication Modbus pour terminaux PanelView
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Support technique
Pour toute question concernant PanelBuilder32, consultez d�abord les manuels en ligne et l�aide en ligne. Si vous 
ne trouvez pas de réponses à vos questions, contactez les services de support technique de Rockwell 
Automation :

Rockwell Automation
Technical Support
6680 Beta Drive
Mayfield Village, Ohio 44143

Pour les Etats-Unis ou le Canada, appelez le +1 (440) 646-7800, le +1 (440) 646-5800 ou envoyez une télécopie 
au +1 (440) 646-7801 entre 8h et 20h (HNE), du lundi au vendredi. En dehors de ces pays, contactez le bureau 
local de Rockwell Automation. Vous pouvez aussi envoyer un message électronique à 
RACLeAsktheExpert@ra.rockwell.com.

Munissez-vous du numéro de série lorsque vous appelez. Ce numéro se trouve dans le menu Aide>A propos 
de du logiciel PanelBuilder32.

Questions fréquemment posées

Pour se procurer les documents répondant aux questions les fréquemment posées, les utilisateurs enregistrés 
peuvent :

• consultez le site Web www.rockwellautomation.com, puis sélectionner Support et Knowledgebase ; 

Mises à jour du logiciel et du firmware

Vous pouvez mettre à jour le logiciel PanelBuilder32 et le firmware PanelView pour bénéficier de nouvelles 
fonctionnalités et d�innovations au fur et à mesure qu'elles apparaissent. Pour recevoir ces mises à jour :

• contactez votre fournisseur ou bureau local Allen-Bradley
• appeler le + 1 (440) 646-5800 ou envoyer une télécopie au + 1 (440) 646-5801 ;
• ou consulter le site Web www.rockwellautomation.com, puis sélectionner Mises à jour logicielles, 

PanelBuilder32 ou rechercher 2711-ND3. Pour ce faire, vous devez être un utilisateur enregistré.
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Nouvelles fonctionnalités de PanelBuilder32, version 3.80 

Redimensionnement des bitmaps
Il vous est désormais possible de redimensionner des bitmaps (y compris ceux que vous importez et les 
symboles ISA). Le redimensionnement des bitmaps est possible lorsque vous :

• ajoutez un bitmap à une vue en sélectionnant Objets>Graphiques>Image ;
• ajoutez un bitmap à un objet en mode graphique intérieur (Format> Graphique intérieur). 

PanelBuilder32 conserve le bitmap à sa taille d'origine et aux nouvelles tailles. Au moment d'ajouter un bitmap à 
une vue ayant été redimensionnée, PanelBuilder32 ouvre une boîte de dialogue vous permettant de sélectionner 
une taille existante ou une nouvelle taille.

Boîte de dialogue Import/Export de graphiques

La boîte de dialogue Import/Export de graphiques a été mise à jour pour inclure une prise en charge 
supplémentaire. 
Lorsque vous ouvrez un bitmap destiné à être importé, la boîte de dialogue affiche : 

• la taille du bitmap (en pixels) et le nombre de couleurs ;
• un aperçu du bitmap (si la fonction est activée) ;
• un aperçu du bitmap tel qu'il serait affiché avec la palette 32 couleurs du terminal PanelView cible (si la 

fonction est activée) ;
• un aperçu du bitmap en noir et blanc (si la fonction est activée).

La boîte de dialogue comporte une zone consacrée à la méthode de réduction des couleurs pour les 
bitmaps dont le nombre de couleurs supérieur à celui supporté par le terminal PanelView cible (32 couleurs). Le 
nombre de couleurs de ces bitmaps doit être réduit par application d'une des méthodes disponibles.. 
Sélectionnez l'option donnant les meilleurs résultats à l'image. Cochez la case Aperçu avec la palette du terminal 
pour avoir un aperçu de l'image telle qu'elle s'affichera sur le terminal PanelView cible. 
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Recherche d'un point
Vous pouvez à présent lancer une recherche visant à trouver toutes les occurrences d'un point en particulier dans 
l'application en cours, grâce à la boîte de dialogue Recherche de points. Cette recherche inclut les points 
utilisés par les objets des vues ainsi que par les objets qui n'apparaissent à l'écran, tels que les variables 
incorporées ou les objets d'impression. Vous pouvez accéder à la boîte de dialogue Recherche de points de 
différentes manières :

• Dans l'éditeur de points, sélectionnez le point à rechercher, cliquez avec le bouton droit de la souris et 
sélectionnez l'option Utilisé par dans le menu contextuel.

• Cliquez avec le bouton droit de la souris sur un objet de la vue et sélectionnez un point dans le sous-menu 
Recherche de points.

Dans un cas comme dans l'autre, la boîte de dialogue Recherche de points s'ouvre pour répertorier toutes les 
occurrences du point sélectionné dans l'application. Un bouton Aller à permet de naviguer vers une vue 
spécifique utilisant le point.
Un autre moyen de rechercher un point consiste à sélectionner Edition>Recherche de points. Une fois la 
boîte de dialogue Recherche de points ouverte, sélectionnez le point à rechercher et cliquez sur le bouton 
Rechercher. 

Comptage et suppression de points
Pour rechercher les points inutilisés ou combien de fois un point est utilisé dans l'application, sélectionnez 
Outils>Comptage de points. Une boîte de dialogue s'ouvre. Elle affiche la liste de tous les points de 
l'application et le nombre d'utilisations de chaque point. La valeur 0 indique que le point correspondant n'est pas 
utilisé dans l'application. Vous avez la possibilité de supprimer les points inutilisés en cliquant sur le bouton 
Vider.

Palette de couleurs

PanelBuilder32 offre désormais une palette de 32 couleurs aux terminaux couleur PanelView standard dont le 
firmware est à la version 4.10 et suivantes.

Compatibilité avec les fichiers Float pour les automates MicroLogix

Les automates MicroLogix 1200 et 1500 sont à présent compatibles avec les fichiers Float.
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Chapitre 1

Installation de PanelBuilder32

Ce chapitre décrit comment installer PanelBuilder32 depuis votre CD sur votre disque dur et couvre les sujets 
suivants :

• spécifications du système ;
• notice d�installation ;
• lancement et fermeture de PanelBuilder32.

Présentation
PanelBuilder32 s�installe directement depuis votre CD sur votre disque dur. Le CD comprend également une 
procédure pour l�installation de la version 2.60, 16 bits de PanelBuilder. Reportez-vous à la version PDF de la 
publication 2711-6.0 pour plus d�informations sur l�installation.

Spécifications du système
• PC équipé d�un processeur Pentium® II 100 MHz ou supérieure
• Windows® 95, 98, 2000, ME, XP, NT ® 4.0 (ou ultérieure)
• Disque dur avec 30 Mo d�espace libre pour une installation minimale
• Disque dur avec 270 Mo d�espace libre pour une installation complète
• 32 Mo de RAM installée (48 Mo conseillés)
• Lecteur de CD-ROM
• 500 Ko libres de mémoire conventionnelle
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8          Installation de PanelBuilder32
Installation de PanelBuilder32
Avant de commencer l�installation, fermez tous les programmes en cours.

Pour installer PanelBuilder32 :

1. Insérez le CD dans votre lecteur de CD-ROM. Le programme d�installation s�exécute automatiquement. 
Dans le cas contraire, exécutez le fichier Setup.exe depuis le CD.

2. Suivez les instructions qui s�affichent à l�écran. Par défaut, PanelBuilder32 est installé dans le dossier 
C:\Program Files\Allen-Bradley\PanelBuilder32.

3. Le programme d�installation vous invite à sélectionner un type d�installation :
Installation typique : installe toutes les options de PanelBuilder32. Installation recommandée pour 
utilisateurs non avertis.

Installation typique (sans RSLinx) : installe PanelBuilder32 sans RSLinx. Sélectionnez cette 
option si vous avez déjà installé la version requise de RSLinx.

Installation compacte : installe PanelBuilder32 sans RSLinx, sans les polices externes et sans les 
fichiers de support. Sélectionnez cette option si vous installez l�application sur un ordinateur aux 
ressources limitées.

Installation personnalisée : sélectionnez cette option si vous êtes un utilisateur averti et que vous 
souhaitez personnaliser la sélection des options installées. L�espace disque nécessaire pour chaque option 
ainsi que l�espace encore disponible sur le disque dur sont affichés.

4. Une fois l�installation terminée, les programmes de PanelBuilder32 s�affichent dans le menu Démarrer 
sous Programmes>PanelBuilder32. 

Les programmes RSLinx s�affichent dans le menu Démarrer sous Programmes>Rockwell 
Software.

Composant personnalisé Description

Fichiers de programme Tous les fichiers nécessaires à l’exécution de PanelBuilder32. 

RSLinx Installe RSLinx pour permettre la configuration des drivers de 
communication en vue du transfert des applications.

Polices externes Installe l’utilitaire FontTool pour créer des fichiers de polices 
pour les applications PanelBuilder32. 

Fichiers de support Installe les fichiers de démo, les exemples, les bibliothèques et 
la documentation (aide en ligne incluse).
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Lancement et fermeture de PanelBuilder32
Pour lancer PanelBuilder32 :

1. Dans le menu Start (Démarrer), cliquez sur Programs (Programmes).

2. Sélectionnez PanelBuilder32, puis cliquez sur PanelBuilder32.

L�écran de démarrage affiche les informations de copyright et de version. Il est suivi d�une boîte de 
dialogue dans laquelle vous pouvez créer, ouvrir, télécharger ou transférer une application.

Pour quitter PanelBuilder32 :

1. Cliquez sur Fermer dans le menu Fichier. Toutes les vues de l�application courante se ferment.

Si vous avez effectué des modifications dans l�application depuis le dernier enregistrement, vous êtes 
invité à les enregistrer avant la fermeture de l�application.

2. Cliquez sur Quitter dans le menu Fichier.
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Chapitre 2

Utilisation de PanelBuilder32

Comme la plupart des applications Windows, PanelBuilder32 fonctionne par le biais de menus, barres d�outils, 
boîtes de dialogue et fenêtres. Ce chapitre décrit les éléments suivants :

• boîte de dialogue de démarrage ;
• fenêtre d�application ;
• fenêtre de vue ;
• barres d�outils ;
• barre d�état ;
• menus contextuels (clic avec le bouton droit de la souris) ;
• configuration des préférences et des valeurs par défaut ;
• aide en ligne.

Boîte de dialogue de démarrage
Au lancement de Panel Buider32, une boîte de dialogue s�ouvre pour vous indiquer les opérations que vous 
pouvez effectuer : création, ouverture, chargement ou transfert d�application. Les options de cette boîte de 
dialogue correspondent aux commandes du menu Fichier.

Suggestion : l�affichage de cette boîte de dialogue peut être désactivé dans l�onglet Général de la boîte de 
dialogue Options>Outils.

Correspond à Fichier>Nouveau

Correspond à Fichier>Ouvrir

Correspond à Fichier>Transférer

Correspond à Fichier>Charger
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Fenêtre d’application
La fenêtre d�application s�affiche lorsque vous ouvrez une nouvelle application ou une application existante. Elle 
offre une vue générale de l�application. Vous pouvez développer ou réduire les dossiers et accéder rapidement 
aux composants principaux de l�application. Il suffit de cliquer deux fois sur une icône d�un dossier pour ouvrir 
une vue, une boîte de dialogue ou une feuille de calcul. Les opérations qu�il est possible d�effectuer dans la 
fenêtre d�application sont également accessibles à partir des menus.

La fenêtre d�application peut être ancrée ou fixée sur le côté gauche de la fenêtre de PanelBuilder32 afin d�éviter 
qu�elle n�interfère avec la visualisation des vues de l�application. Lorsque cette fenêtre est détachée (ou flottante), 
elle peut être déplacée ou dimensionnée comme n�importe quelle autre. L�ancrage de la fenêtre d�application 
s�effectue par le biais du menu Affichage.

Si plusieurs applications sont ouvertes, une fenêtre d�application apparaît pour chacune d�elles.

Cliquer sur - pour réduire 
un dossier (ou le fermer)

Chaque icône représente un onglet de la boîte 
de dialogue Configuration de l’application.

Chaque icône représente une 
vue de l’application.

Cliquez sur + pour développer un dossier

Pour ouvrir une icône, cliquez deux fois 
dessus ou cliquez dessus avec le 
bouton droit de la souris et sélectionnez 
Ouvrir dans le menu contextuel.
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Dossiers de l’application Cliquez deux fois sur l’icône : Dossiers de l’application

Système

Description Entrer une description de l’application ou la renommer.

Impression seule Configurer un objet qui imprime les messages déclenchés (pour les 
terminaux qui supportent l’impression). 

Indicateurs de panneau Configurer les indicateurs LED/sonores pour certains terminaux.

Résultats Ouvrir la fenêtre de résultats qui affiche les erreurs et mises en 
garde se produisant lors de la validation de l’application.

Editeur de texte Accéder à toutes les chaînes de texte définies dans une application.

Base de données de points Ouvrir le tableur de l’éditeur de points qui définit tous les points 
de lecture et d’écriture de l’application.

Configuration de 
l’application

Configuration du terminal Sélectionner un terminal différent pour l’application.

Configuration de la communication Définir les paramètres d’exécution du terminal ou de l’automate.

Maintenance de l’afficheur Programmer le rafraîchissement de la vue de certains terminaux 
PanelView.

Polices externes Activer un fichier de polices externes permettant de saisir le 
texte dans une autre langue. Les fichiers de polices sont créés 
avec l’utilitaire FontTool.

Imprimante Configurer le port d’imprimante et les options d’impression pour 
un terminal muni d’un port RS-232.

Points d’état Définir les points utilisés par l’automate pour surveiller le numéro 
de la vue courante, l’heure ou la date.

Points de contrôle Définir les points utilisés par l’automate pour modifier la vue 
courante, l’heure ou la date.

Heure / Date Spécifier le format d’affichage de l’heure et de la date. Tous les 
objets qui affichent l’heure ou la date utilisent ce format.

Evoluée Configurer des options telles que l’écran de veille, les options 
d’affichage, la répétition automatique des touches/cellules tactiles.

Mise sous tension Définir les valeurs par défaut à la mise sous tension du terminal.

Projet Activer/désactiver l'utilisation d'un projet pour les points 
partagés.

Protection Définir la protection vues/terminal pour une application.

Alarmes

Configuration Configurer les paramètres globaux des alarmes.

Déclenchements d’alarmes Définir les déclenchements des messages d’alarmes.

Messages d’alarmes Configurer les messages d’alarmes.

Vues      Par exemple :
1 - Vitesse du moteur 1
2 - Etat du moteur 2

Ouvrir une vue. Pour chaque vue de l’application, une icône 
apparaît, avec le nom et le numéro de la vue. Les vues s’affichent 
dans l’ordre séquentiel dans le dossier Vues.
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Fenêtre de vue
La fenêtre de vue (semblable au panneau avant d�un terminal) apparaît à l�ouverture d�une nouvelle vue ou d�une 
vue existante. La barre de titre indique le nom et le numéro de la vue. Les vues peuvent être déplacées et 
dimensionnées comme les autres fenêtres.

Vous pouvez placer des objets dans la zone d�affichage de la vue ou sur une touche de fonction, selon le type de 
terminal. Le pointeur de la souris prend la forme d�une croix (+) lorsque les objets sont placés dans l�une ou 
l�autre de ces zones. Les objets sont accessibles à partir du menu Objets ou de la Boîte à outils (menu 
Affichage>Barres d’outils). Sélectionnez un objet et cliquez dans la vue pour le placer avec sa taille par 
défaut ou faites glisser le pointeur pour le dimensionner.

Quadrillage tactile
Les terminaux à écran tactile utilisent un quadrillage tactile permettant d�aligner sur les cellules tactiles les objets 
de contrôle tels que les boutons-poussoirs. Ceux-ci sont positionnés et dimensionnés par incréments de cellules 
tactiles. La taille du quadrillage tactile (nombre de cellules tactiles) est différente pour chaque terminal. Pour 
afficher ou masquer le quadrillage, sélectionnez Affichage>Quadrillage tactile. Le quadrillage tactile reste 
actif pour les objets d�entrée même s�il est masqué.

Utilisez le quadrillage pour aligner les objets d�affichage ou les objets graphiques sur les terminaux à écran tactile.

Quadrillage
Les terminaux à clavier utilisent un quadrillage pour aligner les objets. Dans les vues, l�espacement par défaut du 
quadrillage dépend du type de terminal. Vous pouvez modifier l�espacement du quadrillage lorsque vous créez 
une nouvelle vue ou modifiez les propriétés d�une vue. Pour afficher ou masquer le quadrillage, sélectionnez 
Affichage>Quadrillage.

Suggestion : pour les terminaux à 
clavier, vous pouvez afficher ou 
masquer le clavier à partir du menu 
Affichage.
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Barres d’outils
PanelBuilder32 comporte 9 barres d�outils. Elles vous permettent d�accéder aux commandes et aux boîtes de 
dialogue en cliquant simplement sur un bouton. Au départ, la plupart des barres d�outils sont ancrées (ou fixées) 
au-dessous de la barre de menus.

Toutes les barres d�outils peuvent être flottantes ou ancrées. Pour détacher une barre d�outils, cliquez sur l�un de 
ses bords et faites-la glisser vers le milieu de l�écran. Une fois détachée, la barre d�outils ressemble à n�importe 
quelle autre fenêtre. Pour ancrer une barre d�outils, faites-la glisser jusqu�au bord supérieur, inférieur, gauche ou 
droit de l�écran. Vous pouvez également cliquer deux fois sur une barre d�outils pour l�ancrer ou la détacher.

Affichage et masquage des barres d’outils
Pour accéder aux barres d�outils, cliquez sur Affichage>Barres d’outils, puis cochez les cases correspondant 
aux barres d�outils que vous souhaitez afficher. Pour masquer une barre d�outils, retirez la coche de la case 
correspondante. 

Info-bulles
Lorsque vous placez le pointeur de la souris sur une icône (barre d�outils, boîte à outils ou palette 
de couleurs) sans cliquer, un message d�aide s�affiche dans une info-bulle, sous l�icône. Les 
info-bulles sont activées ou désactivées dans le menu Affichage>Barres d’outils.
Pour obtenir plus d�aide, sélectionnez l�icône flèche dans la barre d�outils ou appuyez sur Maj+F1 
puis cliquez sur n�importe quelle icône.

Barre d’outils 
ancrée au bas de 
la fenêtre

Barre d’outils 
ancrée en haut de 
la fenêtre

Barre d’outils 
ancrée à droite 
de la fenêtre

Barre d’outils flottante
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Barre d’outils standard
Contient des outils de gestion de fichiers et de vues, ainsi que des outils d�édition.

Barre d’outils Etat
Permet d�accéder aux différents états d�un objet multi-états ou liste ainsi qu�aux modes texte intérieur et 
graphique intérieur. Contient également des icônes de zoom permettant de grossir ou de réduire la vue.

Barre d’outils Texte intérieur
Permet de saisir, formater et aligner le texte des objets. A partir de cette barre d�outils, vous pouvez modifier le texte dans la 
zone de texte, cliquer sur la flèche pour ouvrir la boîte de dialogue d�édition de texte ou ouvrir l�éditeur de texte de 
l�application. Sert également à insérer des variables dans le texte.

Barre d’outils Format
Permet d�appliquer des options de formatage aux objets, telles que type de ligne, motif de remplissage, forme, 
vidéo inverse et clignotement. Contient également des icônes permettant de grouper, de dissocier et d�empiler 

des objets.

Barre d’outils Graphiques
Fournit une liste d�images bitmap ou de symboles ISA pouvant être insérés dans un objet. Permet également 
d�importer des graphiques.

Boîte à outils des symboles ISA
Contient des symboles ISA standard pouvant être placés directement sur une vue ou insérés dans un objet (en 
mode graphique intérieur).

La boîte à outils s’affiche au départ 
sous forme de fenêtre flottante. 
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Boîte à outils
Contient des objets (contrôles, affichages, alarmes et graphiques) pouvant être placés sur une vue. Ces objets 
sont également accessibles à partir du menu Objets.

Palette de couleurs
Permet d�appliquer les couleurs de premier plan et d�arrière-plan aux objets, textes ou graphiques. Pour les 
terminaux couleur avec firmware 4.10 ou ultérieure, la palette gère 32 couleurs. Pour les terminaux en niveaux de 
gris, elle comporte quatre couleurs (niveaux de gris). Cliquez avec le bouton gauche de la souris pour appliquer la 
couleur au premier plan de la sélection. Cliquez avec le bouton droit de la souris pour appliquer la couleur à 
l�arrière-plan de la sélection.

Barre d’outils Langue
Permet de sélectionner une autre langue pour l�application. Si la prise en charge de plusieurs langues est activée 
dans l�application, celle-ci peut stocker du texte en 5 langues. 

Barre d’état
La barre d�état, en bas de la fenêtre, affiche des informations sur les commandes, les boutons de la barre d�outils, 
l�opération en cours ou l�emplacement du point d�insertion. 

Lorsque vous créez ou sélectionnez un objet dans une vue de l�application, la barre d�état affiche les 
informations suivantes :

La boîte à outils s’affiche au départ 
sous forme de fenêtre flottante. 

La case reflète les 
couleurs de premier 
plan et d'arrière-plan 
sélectionnées.

Emplacement du point d’insertion 

ID de l’objet (attribué par PanelBuilder32) 

Coordonnées (en pixels) du coin supérieur gauche de l’objet [par rapport au coin supérieur gauche de la vue (x = 0, y = 0)]

Largeur et hauteur de l’objet (en pixels) Objet sélectionné 
Publication 2711-GR003C-FR-P



18          Utilisation de PanelBuilder32
Menus contextuels
Des menus contextuels existent pour les tâches fréquemment utilisées. Il suffit de cliquer sur un objet avec le 
bouton droit de la souris pour choisir une option du menu. Ces menus sont disponibles lors des opérations 
suivantes :

• Edition d’un objet. Sélectionnez un objet puis cliquez avec le bouton droit de la souris pour copier, 
couper, coller ou supprimer l�objet, ou pour en modifier les propriétés.

• Edition d’une vue. Sélectionnez une vue dans le dossier Vues de la fenêtre d�application. Cliquez avec 
le bouton droit de la souris pour créer, ouvrir, copier, couper, supprimer ou modifier les propriétés de 
cette vue.

• Masquage ou affichage des barres d’outils. Cliquez dans la zone de la barre d�outils avec le 
bouton droit de la souris pour masquer ou afficher une barre d�outils, une boîte à outils ou une palette.

• Edition des états d’objets multi-états. Cliquez avec le bouton droit de la souris dans la feuille de 
calcul Etats de la boîte de dialogue d�un objet pour ajouter, supprimer ou modifier les états d�un objet, ou 
pour insérer une variable dans le champ de texte.

• Edition des messages et des déclenchements d’alarmes. Cliquez avec le bouton droit de la 
souris dans la feuille de calcul des messages d�alarmes ou des déclenchements d�alarmes de la boîte de 
dialogue Alarmes pour ajouter, supprimer et modifier des alarmes ou des déclenchements.

• Edition du texte de l’application. Cliquez avec le bouton droit de la souris dans l�éditeur de texte 
pour ajouter, supprimer ou modifier les chaînes de texte de l�application.

• Correction des erreurs de validation. Sélectionnez une erreur ou une mise en garde dans la 
fenêtre de résultats, puis cliquez avec le bouton droit de la souris pour atteindre la source de l�erreur ou 
pour corriger, imprimer ou obtenir de l�aide sur une erreur. Vous pouvez également masquer ou ancrer la 
fenêtre de résultats.

• Edition des points. Cliquez avec le bouton droit de la souris dans l�éditeur de points pour copier, 
couper, coller, insérer, reproduire, supprimer ou trier des points.
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Configuration des préférences et des options par défaut
Pour personnaliser ou configurer les paramètres par défaut des fonctions de PanelBuilder32, sélectionnez 
Options dans le menu Outils. 

Sélectionnez : Pour :

General (Général) • Activer/désactiver l’affichage de la boîte de dialogue de démarrage au lancement de PanelBuilder32.
• Activer/désactiver la création automatique de la vue 1 lors de la création d’une nouvelle application.
• Modifier le nombre des derniers fichiers utilisés apparaissant à la fin du menu Fichier.
• Activer/désactiver la création d’une copie de sauvegarde (.BAK) pour les applications de PanelBuilder32.
• Activer/désactiver l’affectation automatique de touches de fonction aux objets créés.

Default Terminal 
Selection 
(Sélection du 
terminal par défaut)

Sélectionner le terminal PanelView que vous souhaitez utiliser par défaut pour toutes les nouvelles applications.

Report Setup
(Configuration des 
rapports)

• Définir les rubriques ou les attributs à inclure dans les rapports de l’application.
• Définir le format de la page de titre et des en-têtes de page pour les rapports de l’application.

Objects (Objets) • Configurer le mode de placement des objets (objet unique ou plusieurs objets du même type ; affichage des 
propriétés de l’objet). Activer/désactiver les info-bulles et choisir le type d’info-bulle à afficher.

• Sélectionner la taille et l’alignement par défaut du texte pour les objets. 
• Définir la largeur de la ligne du rectangle de sélection qui apparaît lors de la sélection ou de la création d’objets.

Save (Enregistrer) • Enregistrer les fichiers .PBA et .PVA lors du chargement d’une application.
• Modifier l’emplacement par défaut d’enregistrement des fichiers d’application et des fichiers projet 
PanelBuilder32. Les paramètres par défaut sont définis à l’installation.

Tag Edit 
(Edition de points)

Définir les valeurs par défaut utilisées lors de la reproduction de points dans l’éditeur de points. Activez les 
options automatiques pour la création de moins de points à partir des adresses de points et la conversion 
des points pour un protocole différent lors de la conversion d’une application pour l’exécuter sur un terminal 
différent.

Pour plus de détails sur la configuration 
des préférences, consultez le livre 
Personnalisation de PanelBuilder32 
depuis l’onglet Sommaire de l’aide.
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Utilisation de l’aide en ligne de PanelBuilder32
PanelBuilder32 fournit une aide en ligne très complète pour vous assister dans le développement d�applications. 
L�aide en ligne comprend des informations générales, des instructions pas à pas et une aide contextuelle. Pour 
accéder à l�aide en ligne sous PanelBuilder32 :

• Sélectionnez Aide dans la barre de menus de PanelBuilder32.
• Cliquez sur le bouton Aide dans une boîte de dialogue.
• Appuyez sur F1 ou cliquez avec le bouton droit de la souris et sélectionnez Qu’est-ce que c’est ? dans 

une boîte de dialogue, une rubrique de menu ou une vue.

Aide générale

Sélectionnez Aide>Rubriques d’aide dans la fenêtre de PanelBuilder32.
• Cliquez sur l�onglet Contents (Sommaire) pour faire défiler la table des matières.
• Cliquez sur l�onglet Index pour rechercher des rubriques à l�aide de l�index des sujets abordés dans l�aide. 

Saisissez le mot (ou la rubrique) que vous recherchez ou faites défiler la liste.
• Cliquez sur l�onglet Find (Rechercher) pour effectuer une recherche sur des mots ou des phrases. 

 

Tag Defaults 
(Points par défaut)

Définir les valeurs par défaut des attributs de points. Ces valeurs par défaut sont utilisées lors de la création 
ou de l’importation de points dans l’éditeur de points.

Sélectionnez : Pour :

Cliquez deux fois sur un livre 
pour l’ouvrir ou le fermer. 
Cliquez deux fois sur une 
rubrique du livre pour afficher 
l’aide.
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Aide sur les boîtes de dialogue

Chaque boîte de dialogue de PanelBuilder32 contient un bouton Aide sur lequel vous pouvez cliquer pour 
obtenir des informations générales et des instructions pas à pas. L�exemple ci-dessous illustre l�aide que vous 
obtenez lors de la configuration d�un bouton-poussoir.

Aide contextuelle

Une aide est également disponible pour les champs des boîtes de dialogue.

Cliquez sur l’un des 
boutons pour afficher la 
rubrique correspondante.

Cliquez sur X pour fermer 
les fenêtres de l’aide.

Boîtes de dialogue avec ? : 
cliquez sur ? puis sur la rubrique 
que vous recherchez ou cliquez 
sur une rubrique avec le bouton 
droit de la souris et sélectionnez 
Qu’est-ce que c’est ?

Boîtes de dialogue sans ? : 
cliquez sur une rubrique avec le 
bouton droit de la souris et 
sélectionnez Qu’est-ce que 
c’est ? ou appuyez sur F1.

Cliquez dans la 
fenêtre contextuelle 
pour la fermer.
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Chapitre 3

Applications et vues

Ce chapitre explique comment :
• créer une application ;
• ouvrir une application ;
• travailler avec les vues d�application ;
• enregistrer et fermer les applications ;
• générer des rapports d�application ;
• vérifier la taille d'une application ;
• capturer des images des vues.

Pour plus d�informations sur les applications, ouvrez le livre Travailler avec des applications dans 
l'onglet Sommaire de l�aide.
Pour plus d�informations sur les vues, ouvrez le livre Travailler avec des vues dans l'onglet 
Sommaire de l�aide.

Types de fichiers
Les applications PanelBuilder32 utilisent les types de fichiers suivants :

• .PBA - désigne une application configurée et enregistrée dans PanelBuilder32. 
• .PVA - désigne une application enregistrée au format de terminal PanelView. 
• .BAK - désigne un fichier de sauvegarde créé automatiquement par PanelBuilder32.
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Création d'une application
Il existe deux façons de créer une application.

• Sélectionnez Create a New Application (Créer une nouvelle application) dans la boîte de 
dialogue de démarrage.

• Sélectionnez Fichier>Nouveau ou cliquez sur l�outil Nouveau fichier de la barre d�outils .

La boîte de dialogue Create a New Application (Créer une nouvelle application) s�ouvre.

La fenêtre d�application s�ouvre sur une vue vide.

Suggestion : vous pouvez entrer une description de l�application ou la renommer dans la boîte de dialogue 
Application>Description.

Donnez un nom à l’application (1 à 32 caractères).

Sélectionnez le type 
de terminal. Sélectionnez le protocole du terminal.

Sélectionnez le type d'entrée opérateur.

Définit le terminal 
comme terminal par 
défaut pour les 
nouvelles applications.

 Cliquez pour accéder aux différentes 
versions de firmware du terminal. 

Permet à l'application de 
stocker du texte pour 
plusieurs langues. 

Pour renommer la vue, 
sélectionnez Vue>Propriétés.

Un astérisque (*) apparaît après 
le nom de l’application jusqu’à 
ce que le fichier soit enregistré.
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Ouverture d’une application
Il existe deux façons d�ouvrir une application existante :

• Sélectionnez Open an existing application (Ouvrir une application existante) dans la boîte 
de dialogue de démarrage.
La boîte de dialogue affiche le nom de toutes les applications .PBA stockées dans le dossier d�applications 
par défaut. Sélectionnez un fichier et cliquez sur OK ou cliquez deux fois sur un fichier.

• Sélectionnez Fichier>Ouvrir ou cliquez sur l�outil Ouvrir de la barre d�outils standard .

Suggestion : si vous ouvrez une application 16 bits créée avec une version antérieure de PanelBuilder, celle-ci 
est automatiquement mise à jour. Lorsque vous enregistrez l�application, elle est enregistrée au format 32 bits.

La fenêtre d�application s�ouvre. Le dossier Screens (Vues) présente toutes les vues de l�application. 

Cliquez deux fois sur une vue pour l’ouvrir.
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Fonctionnement des vues
Chaque vue de l�application a les propriétés suivantes :

• nom (par défaut Vue 1, Vue 2, Vue 3, . . .) ;
• numéro (1 à 255 dans l�ordre séquentiel) ;
• arrière-plan (couleur de la vue pour les terminaux couleur/niveaux de gris) ;
• description facultative ;
• espacement par défaut du quadrillage.

Lorsque vous créez une nouvelle vue (Vue>Nouvelle) ou que vous modifiez les propriétés d�une vue 
(Vue>Propriétés), une boîte de dialogue s�ouvre pour vous permettre de modifier les paramètres par défaut. 

Quand vous quittez cette boîte de dialogue, une vue s�ouvre ; son nom et son numéro apparaissent dans la barre 
de titre. Une icône de la vue est également créée dans le dossier Vues avec les mêmes nom et numéro. 

Suggestion : la vue de démarrage peut être sélectionnée dans l'onglet Mise sous tension de la boîte de 
dialogue Application>Configuration. 

L’espacement du quadrillage peut être modifié une vue à la fois. Pour 
appliquer les paramètres de configuration à toutes les nouvelles vues 
créées pour un type de terminal, cliquez sur Set as Defaults (Utiliser 
par défaut). Pour restaurer les derniers paramètres par défaut 
enregistrés, cliquez sur Restore Defaults (Paramètres par défaut).

Cette description apparaît dans le rapport d’application.

Entrez un nom représentatif de l'application (jusqu'à 32 caractères)

N’apparaît que pour les terminaux couleur ou en niveaux de gris. Vous 
pouvez modifier la couleur une vue à la fois. Pour appliquer cette 
configuration à toutes les nouvelles vues, cliquez sur Set as Defaults 
(Utiliser par défaut). Pour restaurer les dernières valeurs par défaut 
enregistrées, cliquez sur Restore Defaults (Paramètres par défaut).

Numéro séquentiel attribué à la nouvelle vue.

Ne permet l’accès à la vue qu’aux 
opérateurs autorisés.
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Fonctions de base des vues

Suggestion : pour sélectionner les commandes des vues, vous pouvez également cliquer avec le bouton droit 
de la souris sur le dossier Vues et sélectionner une commande du menu contextuel.

Sélectionner une plage de vues

• Pour sélectionner une plage de vues du dossier Vues, maintenez enfoncée la touche Maj et cliquez sur la 
première puis sur la dernière vue de la plage.

• Pour sélectionner plusieurs vues non adjacentes, maintenez enfoncée la touche Ctrl pendant que vous 
cliquez sur chacune des vues.

Pour : Action :

Créer une nouvelle vue Sélectionnez Vue>Nouvelle.

Ouvrir une vue Cliquez deux fois sur une vue du dossier Vues ou cliquez une 
seule fois sur la vue et sélectionnez Vue>Ouvrir.

Modifier les propriétés d’une 
vue

Cliquez sur une vue du dossier Vues puis sélectionnez 
Vue>Propriétés ou cliquez avec le bouton droit de la souris et 
sélectionnez Propriétés.

Activer une vue Si plusieurs vues sont ouvertes, sélectionnez une vue en bas du 
menu Fenêtre ou cliquez n’importe où dans une vue. Dans le 
menu Fenêtre, la vue active apparaît au début de la liste des 
vues ouvertes.

Fermer une vue Cliquez sur X dans le coin supérieur droit de la fenêtre ou cliquez 
sur une vue et sélectionnez Vue>Fermer.

Supprimer une vue Cliquez sur une vue du dossier Vues puis sélectionnez 
Edition>Supprimer ou appuyez sur la touche Supprimer.
Les vues supprimées laissent un écart dans la numérotation. Les 
nouvelles vues créées portent le numéro disponible suivant.

Copier ou couper une vue • Sélectionnez une vue du dossier Vues, puis sélectionnez 
Edition>Copier ou Couper. 

• Sélectionnez Edition>Coller.
Les vues gardent leur même nom et numéro lorsqu’elles sont 
collées dans le dossier. Si ce numéro est déjà utilisé, la vue 
prend le plus petit numéro disponible. Les écarts de 
numérotation sont remplis.
Les vues peuvent également être copiées ou déplacées entre 
applications ; pour ce faire, cliquez avec le bouton droit de la 
souris sur le dossier Vues de la fenêtre d’application cible et 
sélectionnez Coller.
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Glisser-déplacer des vues

Au lieu d�utiliser les commandes Copier et Coller, vous pouvez glisser-déplacer des vues entre deux applications 
ouvertes. Vous pouvez faire glisser des vues individuelles ou le dossier Vues tout entier. Placez les fenêtres 
d�application l�une à côté de l�autre. Ouvrez le dossier Vues dans l�application source. Faites glisser le dossier 
Vues ou une vue individuelle dans le dossier Vues de la fenêtre d'application cible. Les vues collées gardent le 
même numéro à moins que ces numéros ne soient pas disponibles (les plus petits numéros disponibles sont alors 
utilisés). 

Utiliser le mode classeur

En mode classeur, les onglets des vues ouvertes sont espacés régulièrement au bas de l'espace de travail. Chaque 
onglet porte le nom de l�application ainsi que le nom et le numéro de la vue. Ces informations s'affichent lorsque 
le pointeur de la souris s'arrête sur un onglet. L'onglet de la vue active est toujours visible. Pour activer une vue, 
cliquez simplement sur son onglet.

Le mode classeur est activé ou désactivé dans le menu Affichage. Si la fenêtre d�application n�est pas ancrée, 
elle dispose également d�un onglet.

Protéger les vues

Vous pouvez limiter l�accès aux vues de l�application en exigeant que l�opérateur entre un mot de passe avant 
d'afficher une vue sur le terminal.

D�autres options de protection sont disponibles. Vous pouvez, par exemple, créer une vue exigeant que 
l�opérateur appuie sur une touche de connexion et entre un mot de passe pour se connecter au terminal. Vous 
pouvez également autoriser un opérateur à modifier les mots de passe d�autres opérateurs sur le terminal.

Pour plus d�informations sur la protection, ouvrez le livre Travailler avec des applications, puis le 
livre Protection des vues dans l�onglet Sommaire de l�aide.
Publication 2711-GR003C-FR-P 



Applications et vues          29
Enregistrement d’une application
Il existe deux options pour enregistrer une application.

• Sélectionnez Fichier>Enregistrer ou cliquez sur l�outil Enregistrer de la barre d�outils 
standard .

L�application est enregistrée dans l�emplacement par défaut, écrasant la version précédente. 

• Sélectionnez Fichier>Enregistrer Sous. Le fichier est enregistré sous un autre nom, laissant intact le 
fichier initial. 

La première fois qu�une application est enregistrée, la boîte de dialogue Save as (Enregistrer sous) s�ouvre. 
Le nom de fichier par défaut est celui de l�application. L�extension .PBA est ajoutée au nom du fichier.
 

Un fichier de sauvegarde du même nom (avec l'extension .BAK) est automatiquement créé pour l�application. Ce 
fichier .BAK est mis à jour chaque fois que l�application est enregistrée. Pour afficher le numéro de version ou la 
date d'enregistrement de l�application, cliquez sur Application>Description.

Enregistrer sous d’autres formats

Type de fichier Description

PanelBuilder32 (*.PBA) Enregistre l’application dans un fichier .PBA 32 bits. C’est l’option par défaut.

Terminal PanelView (*.PVA) Enregistre l’application au format de terminal PanelView (.PVA) pour qu’elle puisse 
être chargée dans un terminal.

PanelBuilder 2.6 (*.PBA) Enregistre l’application au format 16 bits compatible avec la version 2.60 (ou 
ultérieure) de PanelBuilder.

PanelView 2.6 (*.PVA) Enregistre l’application au format .PVA 16 bits compatible avec les versions antérieures du 
firmware du terminal PanelView. Le seul moyen de charger un fichier .PVA de 16 bits dans 
un terminal est d’utiliser l’utilitaire de transfert de fichiers WinPFT. 
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Fermeture d’une application
Pour fermer l�application et toutes les vues ouvertes, sélectionnez Fichier>Fermer ou cliquez sur X dans le 
coin supérieur droit de la fenêtre d�application. Si l�application a été modifiée depuis le dernier enregistrement, 
vous êtes invité à enregistrer le fichier avant de le fermer. 

Génération d’un rapport d’application
Vous pouvez générer un rapport pour documenter tous les aspects d�une application, ou certains aspects 
seulement. Les rapports sont utiles pour le suivi des mises à jour et des modifications d�une application. 

L�onglet Report Setup (Configuration des rapports) de la boîte de dialogue Outils>Options définit 
les informations à inclure dans le rapport ainsi que le format de la page de titre et des en-têtes de page. Le 
rapport peut être personnalisé selon les besoins. 

Pour imprimer le rapport avec les sélections ci-dessus, choisissez Fichier>Rapports. Avant de cliquer sur 
Imprimer dans la boîte de dialogue, vous pouvez spécifier si le rapport doit être généré pour :

• toutes les vues ;
• une plage de vues.

Vous pouvez également imprimer les images de chaque vue avec un récapitulatif des objets.
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Vérification de la taille d'une application
Pour comparer l'utilisation de RAM d�une application avec la taille du fichier et la limite de RAM du terminal 
PanelView, sélectionnez Application>Taille de l’application.

La boîte de dialogue indique la taille de l�application avec et sans les informations de transfert. Les informations 
de transfert comprennent le nombre d�octets nécessaires pour le transfert des composants suivants de 
l'application :

• objets ;
• points et équipements.

La boîte de dialogue indique également la taille de l�application sans ces informations de transfert. Vous pouvez 
transférer une application sans les données ci-dessus, mais vous devrez alors re-créer l�application avec toutes les 
vues, objets, points et paramètres de communication des équipements. 

Capture d'images de vues
Utilisez la boîte de dialogue Vue>Gestionnaire de capture pour réaliser des captures d'une ou plusieurs 
vues dans l'application courante, puis :

• copiez-les vers le presse-papiers ;
• copiez-les dans un fichier .BMP ;
• importez-les sous forme d'images bitmap dans l'application courante. Ces images sont alors disponibles 

dans la barre d'outils Graphiques en mode Graphique intérieur.

Les vues peuvent être capturées dans leur taille normale, en miniature ou selon un pourcentage de leur taille 
normale. Pour une résolution optimale, sélectionnez Affichage>Normal afin de rétablir la taille normale de la 
vue avant la capture de l'image. Si vous ne le faites pas, l'image capturée risque d'être déformée.
Vous pouvez capturer une seule vue ou plusieurs en une fois. Lors de la capture de plusieurs vues, vous pouvez 
enregistrer chaque image dans un fichier .bmp distinct ou les enregister toutes dans un seul fichier .bmp. Vous 
pouvez même spécifier la mise en forme des images dans le fichier (bande horizontale ou verticale ou un 
nombre spécifique d'images par ligne).

Suggestion : utilisez l'option Vue>Capturer vers le presse-papiers pour capturer rapidement la vue 
active vers le presse-papiers.
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Chapitre 4

Objets

Ce chapitre couvre les sujets suivants :
• présentation des objets des vues ;
• informations sur les objets ;
• création d'objets ;
• configuration des propriétés des objets ;
• configuration des états d�objets multi-états ou listes ;
• boutons-poussoirs ;
• sélecteurs Liste de contrôles ;
• contrôles d�entrée numérique ;
• contrôles d�entrée ASCII ;
• affichages de messages ;
• affichages de données ;
• sélecteurs de vues ;
• objets globaux.
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Présentation des objets
Les objets sont des graphiques qui s'affichent sur le terminal PanelView. Un objet peut être une simple ligne de 
texte, un graphique, un contrôle ou un bandeau d'alarmes. Certains objets sont statiques : ils fournissent des 
informations visuelles mais ne possèdent aucune fonction de contrôle. D'autres, tels que les sélecteurs Liste de 
contrôles, sont dynamiques et interagissent avec l�opérateur du terminal et avec l�automate. Les objets 
dynamiques sont reliés à l'automate par un point. Celui-ci contient l�adresse de l�objet et d'autres paramètres tels 
que le type de données et permet la lecture et l'écriture de données via un automate.

Pour plus de détails sur les objets disponibles, ouvrez le livre Créer des objets de contrôle et 
d'affichage dans l'onglet Sommaire de l�aide.

Boutons-poussoirs

Sélecteurs Liste de contrôles

Objets d’entrée numérique

Objets d’entrée ASCII

Momentané Change d’état lorsqu'il est actionné et reprend son état d’origine une fois 
relâché.

Maintenu Change d'état lorsqu'il est actionné et conserve cet état une fois relâché.

Avec bit de verrouillage Change d’état lorsqu'il est actionné et reste verrouillé jusqu'à ce qu'il soit libéré 
par l’automate.

Multi-états Prend en charge 2 à 16 états. Passe à l'état suivant chaque fois qu'il est 
actionné.

Standard Permet de sélectionner un état dans une liste déroulante comportant jusqu’à 
255 états. 

Pilotée Semblable au sélecteur Liste de contrôles standard, mais avec la possibilité de 
limiter l'accès à l’automate, à l’opérateur ou aux deux.

Pointeur Affiche la valeur courante d’une adresse d’automate. Lorsque cet objet est 
sélectionné, le pavé numérique s’ouvre pour permettre à l'opérateur d’envoyer 
une nouvelle valeur à l'automate.

Validation de clavier Lorsque cet objet est sélectionné, le pavé numérique s’ouvre pour permettre à 
l'opérateur d’envoyer une nouvelle valeur à l'automate.

Incr/Décr Incrémente une valeur numérique à l'aide du réglage fin ou grossier.

Pointeur Affiche une chaîne de caractères à une adresse d’automate. Lorsque cet objet 
est sélectionné, le pavé ASCII s'ouvre pour permettre à l'opérateur de saisir une 
nouvelle chaîne de caractères et de l'envoyer à l'automate. 

Validation de clavier Lorsque cet objet est sélectionné, le pavé ASCII s’ouvre pour permettre à 
l'opérateur de saisir une nouvelle chaîne de caractères et de l'envoyer à l'automate.
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Indicateurs et Affichages de données

Sélecteurs de vues

Variables

Touches de liste

Indicateur multi-états Affiche jusqu’à 2000 états particuliers. L’état affiché est déterminé par une 
valeur à l'adresse d’automate de l’objet.

Indicateur liste Affiche jusqu’à 256 éléments dans une liste déroulante. L'élément en cours est 
déterminé par une valeur à l'adresse d’automate de l’objet.

Bargraphe Affiche le changement de données sous forme de barre verticale ou horizontale. 
Ajoute une échelle linéaire.

Jauge Utilise une aiguille tournante pour afficher une variable de procédé. Elle 
contient une échelle circulaire graduée et accepte jusqu'à 4 aiguilles.

Echelle Echelle linéaire ou circulaire graduée. Les graduations sont des objets texte. 

Affichage numérique Présente la valeur courante d’une adresse d’automate (binaire, DCB, nombre 
entier ou flottant).

Affichage de messages Donne des informations d’état ou des instructions à un opérateur.

Message d’impression seule Similaire aux affichages de messages sauf que les messages s’impriment au 
lieu de s’afficher sur la vue.

Config indicateur de panneau Configure les différents états des indicateurs lumineux et sonores sur les 
terminaux qui acceptent ces fonctions.

Bouton Aller à Affiche une vue d’application spécifique.

Bouton Aller à Config Affiche le mode Configuration du terminal.

Bouton Retour Ramène à la vue précédente.

Sélecteur Liste de vues Affiche la vue sélectionnée dans une liste de vues.

Heure, Date Affiche l’heure et la date courantes dans une chaîne de texte ou un objet.

Variable ASCII Affiche une variable ASCII dans une chaîne de texte ou dans un objet.

Variable numérique Affiche une variable numérique dans une chaîne de texte ou un objet.

Monter, Descendre Contrôlent le mouvement du curseur dans un sélecteur Liste de contrôles ou de vues.

Page précédente, Page 
suivante

Montent ou descendent le curseur d’une page dans une liste de contrôles ou de 
vues.

Origine, Fin Placent le curseur sur le premier ou le dernier élément d’une liste de contrôles ou de 
vues.

Retour arrière Ramène le curseur sur l'élément précédent d’une liste de contrôles ou de vues.

Entrée Affiche ou confirme la sélection dans la liste.
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Touches de protection

Liste d'alarmes et boutons d'alarmes

Graphiques et Texte

Connexion Connecte l’opérateur au terminal lorsqu'il entre un mot de passe valide.

Déconnexion Déconnecte l'opérateur du terminal.

Sélectionner un opérateur Permet à un opérateur autorisé de modifier le mot de passe de l’opérateur 
sélectionné. Les touches Sélectionner un opérateur, Nouveau mot de passe et 
Vérifier le mot de passe doivent être utilisées ensemble.

Activer la protection Active ou désactive la protection du terminal. Quand elle est désactivée, aucune 
vue n'est protégée, ce qui signifie que tous les opérateurs ont accès à toutes les 
vues de l’application.

Nouveau mot de passe Demande à l’opérateur d'entrer un nouveau mot de passe sur le terminal. Les 
touches Sélectionner un opérateur, Nouveau mot de passe et Vérifier le mot de 
passe doivent être utilisées ensemble.

Vérifier le mot de passe Demande à l’opérateur de retaper le nouveau mot de passe entré sur le 
terminal. Les touches Sélectionner un opérateur, Nouveau mot de passe et 
Vérifier le mot de passe doivent être utilisées ensemble.

Bandeau d’alarmes Définit la zone de la vue où apparaissent les alarmes et les boutons de contrôle 
des alarmes.

Bouton Acquitter Acquitte l’alarme affichée.

Bouton Supprimer Supprime l’alarme mais ne l’acquitte pas.

Bouton Imprimer Imprime le message d’alarme actuellement affiché.

Bouton Tout acquitter Acquitte toutes les alarmes (en cours et en attente).

Liste d’alarmes Affiche une liste des alarmes déclenchées.

Bouton Imprimer la liste 
d’alarmes

Imprime toutes les alarmes de la liste.

Bouton Effacer la liste 
d’alarmes

Supprime la liste et le bandeau d’alarmes.

Ligne, Rectangle, Cercle, 
Ellipse

Formes graphiques

Forme libre Lignes de forme libre

Symboles ISA Symboles ISA standard

Graphiques importés Images bitmap

Texte d’arrière-plan Texte avec diverses tailles et styles de polices

Texte défilant Texte défilant de droite à gauche à une vitesse donnée
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Informations sur les objets
Pour plus de détails, ouvrez le livre Travailler avec des objets dans l'onglet Sommaire de l�aide.

Sélectionner et désélectionner les objets

Dimensionner et déplacer les objets

Pour : Action :

Sélectionner un objet Cliquez sur l’objet. Des poignées apparaissent autour de l’objet.

Désélectionner un objet Cliquez hors de l’objet ou cliquez sur un autre objet.

Sélectionner plusieurs objets Cliquez et entourez les objets d'un rectangle.
Ou maintenez la touche Maj enfoncée pendant que vous sélectionnez chaque 
objet.

Sélectionner tous les objets Cliquez sur Edition>Sélectionner tout.

Pour : Action :

Dimensionner un objet Sélectionnez l’objet, puis positionnez le pointeur sur l’une des poignées pour 
indiquer le sens du changement de taille de l’objet. Faites glisser la poignée 
jusqu’à ce que l’objet atteigne la taille souhaitée. 

Vous pouvez aussi utiliser les touches fléchées (haut, bas, gauche, droite) du 
clavier pour redimensionner un objet. Sélectionnez l'objet, maintenez la 
touche Maj enfoncée, puis appuyez sur les touches fléchées pour 
redimensionner l'objet horizontalement ou verticalement.     

Déplacer un objet Placez le pointeur sur l’objet, puis faites glisser l’objet jusqu’à son nouvel 
emplacement.

Vous pouvez également utiliser les touches fléchées (haut, bas, gauche, droite) du 
clavier pour déplacer l'objet en haut, en bas, à gauche ou à droite.
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Groupe et dissocier des objets

Empiler des objets

L�ordre dans lequel sont empilés des objets qui se superposent peut être modifié à l'aide des commandes du 
menu Réorganiser. 

Suggestion : sélectionnez Réorganiser>Placer les objets dynamiques devant pour placer tous les 
objets qui interagissent avec un automate devant les autres objets de la vue.

Pour : Action :

Grouper un ensemble d’objets Sélectionnez les objets à grouper, puis sélectionnez Réorganiser>Grouper. Un 
contour apparaît autour des objets groupés. 

Lorsque vous sélectionnez l'un des objets du groupe, l'ensemble du groupe 
est sélectionné. Vous pouvez déplacer, dimensionner, couper/copier/coller ou 
supprimer les objets en une seule opération. Vous pouvez également 
dimensionner un objet tout en maintenant son état de groupe.

Dissocier des objets Sélectionnez le groupe puis cliquez sur Dissocier dans le menu Réorganiser.
Désélectionnez le groupe avant de sélectionner un objet individuel.

Regrouper des objets Pour rétablir un ancien groupe d'objets, choisissez Réorganiser>Regrouper.

Placer devant Placer derrièrePile d’origine
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Aligner les objets sur un plan horizontal ou vertical

Vous pouvez aligner les objets horizontalement ou verticalement en prenant pour repère leur côtés, leurs bords 
supérieur ou inférieur ou encore leur centre, à l'aide du menu Réorganiser. Pour superposer plusieurs objets, 
alignez leur centre en utilisant la commande Aligner Centrer les points.

Espacement uniforme des objets horizontalement ou verticalement

Pour que 3 objets ou plus soient à la même distance l�un de l�autre, utilisez les commandes Espacer 
uniformément - Horizontalement ou Espacer uniformément - Verticalement du menu 
Réorganiser.

Permuter les objets horizontalement ou verticalement

Le menu Réorganiser vous permet également de permuter horizontalement (de gauche à droite) ou 
verticalement (de haut en bas) 2 objets ou plus.

Zoom avant et arrière

Vous pouvez agrandir la vue de l�écran pour que les objets paraissent plus grands ou plus petits que leur taille 
réelle. Sélectionnez Affichage>Zoom avant pour grossir la vue et Zoom arrière pour réduire la vue. La 
vue peut être grossie ou réduite plusieurs fois. Pour ramener la vue à sa taille normale, choisissez 
Affichage>Normal.

Aligner la 
gauche

Aligner la 
droite Aligner le centre

Aligner le bas

Aligner le milieu

Aligner le haut

Alignement vertical Alignement horizontal

Espacer uniformément verticalement Espacer uniformément horizontalement
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Copier ou déplacer des objets
Les objets peuvent être copiés ou déplacés : 

• sur la même vue ;
• vers une autre vue ;
• vers la vue d�une autre application.

Utilisez les commandes Edition>Copier, Couper et Coller pour copier ou déplacer les objets. Lorsque 
vous copiez ou coupez un objet, un contour de l�objet apparaît. Faites glisser le contour jusqu�à son nouvel 
emplacement puis collez-le. La vue de destination doit être ouverte pour utiliser ces commandes. Si la vue cible 
se trouve dans une autre application, la fenêtre et la vue de cette application doivent être toutes deux ouvertes. 

Suggestion : vous pouvez également sélectionner ces commandes avec le bouton droit de la souris.

Il est également possible de faire glisser les objets d�une vue à l�autre (ces vues pouvant être ouvertes ou 
fermées). Si vous faites glisser un objet depuis le dossier Vues vers une vue fermée, celle-ci s�ouvre 
automatiquement. Vous pouvez alors déplacer l�objet. Pour copier l�objet au lieu de le déplacer, appuyez sur Ctrl 
tout en le faisant glisser.

Les objets conservent leurs propriétés lorsqu'ils sont copiés et déplacés.

Afficher des info-bulles sur les objets

Les info-bulles permettent d'accéder rapidement aux informations sur les objets : type, adresse/nom du point, 
nom/adresse de la station de l�automate, nombre d'états, état global et état groupé. Il suffit d'arrêter le pointeur 
de la souris sur un objet pour que s'affichent les info-bulles qui s�y rapportent. 

Pour personnaliser le type d�informations présentées sur un objet ou pour désactiver les info-bulles, sélectionnez 
l�onglet Objets dans la boîte de dialogues Outils>Options.
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Création d’objets de vues
Tous les objets se placent sur une vue de la même façon. 

1. Sélectionnez un objet dans le menu Objects (Objets) ou dans la Toolbox (Boîte à outils). 

2. Positionnez le pointeur (+) sur la vue, à l�emplacement où vous voulez placer un seul objet.
Suggestion : pour modifier le mode de placement des objets, sélectionnez l�onglet Objets dans la boîte 
de dialogue Outils>Options. Vous pouvez placer un seul objet, plusieurs objets du même type et/ou 
ouvrir la boîte de dialogue de l�objet après l'avoir placé.

3. Cliquez pour placer l�objet avec sa taille par défaut ou faites glisser le pointeur pour redimensionner 
l'objet.
Certains objets sont créés avec un texte intérieur par défaut qui peut être modifié. Vous verrez un 
astérisque (*) si l�objet est trop petit pour le texte. Dans ce cas, redimensionnez l�objet.

Suggestion : vous pouvez placer des objets sur les touches de fonction au lieu de les voir apparaître à l�écran. 
C'est utile si les touches de fonction réalisent la même opération quelle que soit la vue affichée. Positionnez le 
pointeur (+) sur une touche de fonction et cliquez. Un graphique apparaît sur la touche de fonction indiquant le 
type de l�objet. Pour supprimer un objet d�une touche de fonction, sélectionnez la touche puis sélectionnez 
Edition>Supprimer.
Pour chaque objet placé sur la vue, la barre d�état indique :

• le numéro d�identité (ID) de l�objet (attribué par PanelBuilder32) ;
• les coordonnées X et Y du coin supérieur gauche de l�objet (en pixels) ;
• la largeur et la hauteur de l�objet (en pixels) ;
• le type d�objet (partie droite de la barre d�état).

Bouton-poussoir Bouton Aller à Sélecteur Liste de vues
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Configuration des propriétés des objets
La plupart des objets, sauf les graphiques et le texte, ont des propriétés qui définissent leur fonctionnement et 
leur interaction avec le terminal PanelView et l'automate. Pour accéder aux propriétés d'un objet, cliquez deux 
fois sur celui-ci. Vous pouvez aussi cliquer sur l'objet avec le bouton gauche de la souris, puis sélectionner 
Edition>Propriétés de l'objet.

Les propriétés sont propres à chaque objet. Pour les objets de contrôle, le champ Input (Entrée) permet de 
déterminer si l�objet est activé par une touche de fonction ou par une cellule tactile sur le terminal PanelView. 
Dans PanelView 300 Micro, vous pouvez également affecter des touches fléchées aux objets. Pour les terminaux 
à écran tactile, la cellule tactile est automatiquement activée.
Suggestion : pour les terminaux à clavier, les touches de fonction sont automatiquement affectées aux objets. 
Cette option peut être désactivée dans l�onglet Général de la boîte de dialogue Outils>Options.
Utilisez l�onglet Options pour :

• entrer une description de l�objet ;
• définir un objet pour une utilisation globale afin de pouvoir le réutiliser dans d�autres vues. Voir page 59 

pour plus de détails sur les objets globaux ;
• masquer l�affichage d�un objet de contrôle si l�espace est limité (la touche de fonction ou la cellule tactile 

demeurent actives). Pour les écrans tactiles, placez un graphique sur l�objet, sinon un opérateur pourrait 
par inadvertance toucher cette zone et activer la fonction.

Les objets d'affichage possèdent un point de lecture 
(Read Tag). Ce point définit l'adresse de l'automate que 
le terminal lit pour afficher les données de l'objet.

Les objets de contrôle possèdent un point d'écriture (Write Tag). Ce 
point définit l'adresse de l'automate où le terminal écrit les données de 
l'objet. Les objets peuvent être associés à plus d’un point.

Après avoir saisi le nom du point, 
cliquez sur le bouton Edit Tag (Editer 
le point) pour en modifier la définition 
ou utilisez l’éditeur de points pour 
entrer toutes les définitions des 
points en même temps.

Objet de contrôle Objet d’affichage
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Configuration des états d’objets multi-états ou listes
Les boîtes de dialogue des objets multi-états ou listes comportent un onglet States (Etats). Cet onglet s�ouvre 
comme une feuille de calcul, ce qui simplifie la saisie du texte et des options de formatage des états.
Chaque ligne de la feuille de calcul représente une entrée ou un état particulier. Les champs de ces lignes 
définissent le texte et les autres options de formatage pour chaque état. Certains champs doivent être complétés 
avec du texte, d�autres fournissent une liste déroulante d�options et d�autres présentent une case à cocher pour 
activer ou désactiver une option. Les champs de chaque ligne sont spécifiques à l�objet. 

Plusieurs opérations sur les états peuvent être réalisées par le biais d'une commande de 
menu contextuel. Lorsque vous cliquez sur le bouton droit de la souris ou que vous 
appuyez sur Ctrl+M dans l'onglet States (Etats), un menu s�ouvre. 

Par exemple, pour ajouter ou retirer des états ou des entrées, cliquez avec le bouton 
droit de la souris dans l'onglet States (Etats) et sélectionnez Append State 
(Ajouter un état) ou Delete State (Supprimer l’état) dans le menu contextuel. 
N�utilisez que le nombre d�états ou d'entrées nécessaires pour l�application. Les états 
inutilisés occupent de la mémoire d�application.

Les autres commandes de ce menu vous permettent de déplacer, modifier et 
supprimer des états, ou d�insérer des variables dans la zone de texte d�un état. Vous 
pouvez même copier un texte déjà présent dans l�application avec la commande 
Utiliser un texte existant.

Sélecteur Liste de vuesBouton-poussoir multi-états
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Boutons-poussoirs
Les boutons-poussoirs des vues fonctionnent comme des boutons-poussoirs mécaniques ; une valeur logique de 
0 représente un contact ouvert et une valeur de 1 représente un contact fermé. Vous pouvez définir chaque 
bouton-poussoir comme ayant un contact normalement ouvert ou normalement fermé ou attribuer une valeur 
numérique à chacun des états du bouton-poussoir.

Bouton-poussoir momentané : change d'état lorsqu'il est actionné et reprend son état d'origine 
quand il est relâché. Le bouton-poussoir reste actionné pendant 500 millisecondes (1/2 seconde). Vous 
pouvez spécifier une autre durée dans l'onglet Propriétés de la boîte de dialogue 
Boutons-poussoirs.

Bouton-poussoir maintenu : change d'état lorsqu'il est actionné et conserve cet état une fois 
relâché. Il reprend son état initial s'il est actionné une deuxième fois. Un bouton-poussoir maintenu 
garde son dernier état en cas de changement de vue. Son état initial à la mise sous tension est défini dans 
l'onglet Mise sous tension de la boîte de dialogue Configuration de l’application.

Bouton-poussoir avec bit de verrouillage : change d'état lorsqu'il est actionné et conserve cet 
état une fois relâché. Le bouton ne reprend pas son état initial tant qu�il n�est pas déverrouillé par un bit 
ou une valeur d�échange. Il ne reste pas verrouillé après une nouvelle mise sous tension, mais reste 
verrouillé en cas de changement de vue. Le bouton ne peut être déverrouillé que si la vue courante 
affiche le bouton verrouillé.
Un point d�échange est nécessaire pour déverrouiller les boutons-poussoirs avec bit de verrouillage. Le 
bouton est déverrouillé lorsque l�adresse du point contient une valeur différente de zéro. 

Bouton-poussoir multi-états : comporte entre 2 et 16 états. A chaque état est attribué un bit ou 
une valeur. Chaque fois que le bouton-poussoir est actionné, il passe à l'état suivant. Après le dernier 
état, il reprend son état initial. L�état d�un bouton-poussoir est maintenu d�une vue à l�autre. Son état 
initial à la mise sous tension est défini dans l'onglet Mise sous tension de la boîte de dialogue 
Configuration de l’application.

Bit d’échange = 0
Bit de données = 0

Bit d’échange = 0
Bit de données = 1

Bit d’échange = 0
Bit de données = 1

Bit d’échange = 1
Bit de données = 0

Le programme de l’automate
remet le bit d’échange à 0

Etat initial du bouton Bouton actionné Bouton relâché
Programme de l'automate
définit le bit d'échange à 1

ARR ARR MCH  MCH
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Texte et graphique d’un bouton-poussoir
Les boutons-poussoirs peuvent comporter du texte ou un graphique intérieur, qui peuvent différer pour chaque état. 
Le texte intérieur peut aussi contenir une date, une heure ou une variable ASCII ou numérique. Lorsque vous créez 
un bouton-poussoir, le texte intérieur par défaut est ETAT 0 - ETAT 3. 

Modifier les états des boutons-poussoirs
Le texte et les options de formatage des états sont entrés dans l'onglet States (Etats) de la boîte de dialogue de 
l�objet. Pour ajouter ou supprimer des états d'un bouton-poussoir multi-états, cliquez avec le bouton droit de la 
souris dans l'onglet States (Etats) et sélectionnez Ajouter un état ou Supprimer l’état dans le menu 
contextuel. 

Considérations sur la sécurité

• Ne placez pas de boutons-poussoirs importants au milieu d�écrans tactiles. Ils peuvent parfois être 
bloqués par les messages d�alarmes, le bandeau d�alarmes ou le pavé.

• Espacez les boutons-poussoirs sur l�écran tactile pour éviter que l�opérateur n'actionne accidentellement 
deux objets à la fois, ce qui entraînerait une opération imprévue.

• Tous les boutons-poussoirs sont désactivés pendant ½ seconde après un changement de vue. Le terminal 
ne répondra aux boutons-poussoirs de la nouvelle vue qu'une fois les boutons-poussoirs de la vue 
précédente relâchés.

ATTENTION

!
Ne placez pas de bouton d'arrêt d'urgence ni toute autre commande critique pour la 
sécurité sur une vue. Utilisez des équipements d'interface opérateur câblés séparément. 
Consultez l�intérieur de la couverture de ce manuel pour connaître les normes appropriées.

MCH

ARR

Texte Etat 0

Texte Etat 1

Bouton-poussoir Marche/Arrêt

Bas

Moyen

Haut

Bouton-poussoir multi-états

Texte Etat 0

Texte Etat 1

Texte état 2

Graphique état 0

Graphique état 1

Bouton-poussoir Marche/Arrêt

Le champ Value (Valeur) n’apparaît que 
si l’option Valeur est sélectionnée 
dans l'onglet Properties (Propriétés).
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Sélecteurs Liste de contrôles
Les sélecteurs Liste de contrôles reprennent la plupart des fonctions des boutons-poussoirs, comme les valeurs 
prédéterminées et les commandes marche/arrêt. Une liste de contrôles est une liste déroulante qui peut contenir 
jusqu�à 255 états différents. La valeur de l�état initial est définie dans l'onglet Propriétés de la boîte de dialogue. 
Cette valeur est envoyée à l�automate à la mise sous tension. 

Listes de contrôles standard

Pour les listes de contrôles standard, l�état est sélectionné par déplacement du curseur. Sur les terminaux 
à clavier, les touches fléchées haut et bas du terminal permettent de déplacer le curseur et la touche 
Entrée permet d�envoyer l�état à l�automate.

Sur les terminaux à écran tactile, il faut placer des touches de liste sur la vue pour permettre à l'opérateur de 
déplacer le curseur et d�envoyer un état à l�automate.

Si la vue contient plusieurs listes de contrôles, une barre verticale apparaît à gauche de la liste active. Pour en 
sélectionner une, l'opérateur peut appuyer sur l�écran tactile, sur la touche de fonction correspondante ou sur les 
touches fléchées gauche et droite.

Listes de contrôles pilotés

Utilisez une liste de contrôles pilotés pour limiter l�accès à la liste de contrôles. Pour chaque état, l�accès 
peut être limité à l�automate seulement, l�opérateur seulement, l�opérateur et l’automate. 
Vous pouvez également choisir l'option Pas d’accès. L�état initial doit permettre l�accès de l�opérateur.

Pour sélectionner un état, l�automate met la valeur du point de commande à 1 puis écrit la valeur de l�état à 
l�adresse du point de recherche. Le terminal PanelView lit la valeur du point de recherche puis marque l�état 
correspondant dans la liste de contrôles. Le terminal PanelView écrit alors la valeur d�état au point d�écriture 
attribué à la liste de contrôles. 

1/4 plein
1/2 plein

Touches de liste
 La barre de marquage montre la liste active (sélectionnée)

Vide

Contrôle du niveau de réservoir

Plein

1/4 plein
1/2 plein

Vide

Contrôle du niveau de réservoir

Plein
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Données d’écriture de bloc (liste de contrôles pilotés seulement)
Utilisez le point d�écriture de bloc pour écrire les valeurs de tous les états de la liste de contrôles dans un bloc 
d�adresses de l�automate. Le point de début d�écriture de bloc définit l�adresse de début de l'opération. Réservez 
une adresse suivant l�adresse de point d�écriture de bloc pour chaque état de la liste. Le nombre maximal d'états 
pris en charge par le point d'écriture de bloc dépend de la taille du type de données de points et des limites de 
transfert de données spécifiques à un protocole donné.

Etats inactifs (liste de contrôles pilotés seulement)
Les états inactifs de la liste ne peuvent pas être sélectionnés par l�opérateur. Le curseur apparaît vide quand il 
passe à un état inactif. Les états inactifs sont inclus dans les données d�écriture de bloc envoyées à l�automate. 

Modifier les états d’une liste de contrôles

Le texte et les autres options de formatage des états sont définis dans l'onglet States (Etats) de la boîte de 
dialogue de l�objet. Pour ajouter ou supprimer des états, cliquez avec le bouton droit de la souris dans l'onglet 
States (Etats) et sélectionnez Ajouter un état ou Supprimer l’état. N�utilisez que le nombre d�états 
nécessaire. Chaque état est limité à une ligne. Toute modification de la taille du texte s�applique à la liste entière.

Etat 1(100)
Etat 2(200)
Etat 3(300)
Etat  4(400)
Etat 5(500)
Etat 6(600)
Etat 7(700)
Etat 8(800)
Etat 9 (900)
Etat 10(1000)

400 
500 
600 
700 
800 

Liste de contrôles

Point de début d'écriture de bloc 

Données d’écriture de bloc
envoyées à l’automate

jusqu’à 29 adresses séquentielles

Etat 1  
Etat 2 
Etat 3 
Etat 4 
Etat 5

Etat 1  
Etat 2 
Etat 3 
Etat 4 
Etat 5

Etat inactif
Etat actif

Texte apparaissant pour chaque état
Le champ Access (Accès) n’apparaît que pour les listes de contrôles pilotés.
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Contrôles d’entrée numérique
La validation de clavier et le pointeur permettent à l�opérateur d�entrer une valeur numérique et de l�envoyer à 
une adresse d�automate. Ces deux contrôles d�entrée numérique ouvrent un pavé pour permettre à l�opérateur 
d'entrer une valeur numérique. Le contrôle Incr/Décr permet à l�opérateur d'augmenter ou de réduire une valeur 
par incréments prédéfinis. 

La valeur initiale des contrôles d�entrée numérique est définie dans l�éditeur de points. Cette valeur est envoyée à 
l�automate à la mise sous tension. (Tous les protocoles n�écrivent pas de valeurs dans l�automate à la mise sous 
tension). La valeur initiale n�est pas mise à l�échelle, elle doit donc être entrée dans l'unité utilisée par l�automate. 
Par exemple, le terminal utilise des degrés Celsius (° C) et l'automate des degrés Fahrenheit (° F). Pour initialiser 
le terminal à 32 degrés Fahrenheit, vous devez saisir dans l'éditeur de points une valeur initiale de 32 et non pas 
de 0.

Bouton de validation de clavier

Le bouton de validation de clavier est un bouton-poussoir momentané pouvant afficher une valeur à une 
adresse d�automate. Lorsqu'il est actionné, ce bouton ouvre le pavé numérique et active le clavier du 
terminal pour la saisie de données. 

Pointeur

Un pointeur est un cadre de données pouvant afficher une valeur stockée à une adresse d�automate. 
Lorsque le pointeur est sélectionné et que vous appuyez sur la touche Entrée ou sur une touche 
numérique, le pavé numérique s�ouvre et le clavier du terminal est activé pour la saisie de données.

L�opérateur sélectionne le pointeur en appuyant sur l�écran tactile, la touche de fonction attribuée ou les touches 
fléchées gauche et droite du terminal. La barre de marquage à gauche de l�objet indique quel pointeur est actif.

BOUCLE TEMPERATURE RESERVOIR #1

CV PV SP
0° F 

75° F 

150° F 

0%

50%

100%

20 35 26

SP = 

CV  = 

10
Entrée Temp.

50
Entrée Deg.

Boutons de validations de clavier

BOUCLE TEMPERATURE RESERVOIR #1

CV PV SP
0° F 

75° F 

150° F 

0 %

50 %

100 %

20 35 26

SP = 

CV  = 

50

10 %

û F

Pointeurs
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Contrôle Incr/Décr
Le contrôle Incr/Décr augmente ou diminue une valeur numérique par incréments prédéfinis. Chaque fois que 
l�opérateur appuie sur les touches Haut ou Bas, la valeur en cours est augmentée ou réduite selon l'incrément 
prédéfini, puis elle est envoyée à l�automate. Sur les terminaux à écran tactile, des touches de liste doivent être 
placées sur la vue pour incrémenter ou décrémenter la valeur.

Pavé numérique
Le pavé s�ouvre au centre de l�écran du terminal lorsqu�un contrôle d�entrée numérique est sélectionné. La valeur 
entrée s'affiche en haut du pavé. Au-dessous, se trouve la plage des valeurs que l�opérateur peut entrer. Les 
valeurs limites sont définies dans l�éditeur de points. L�apparence du pavé numérique varie selon les terminaux 
PanelView.

Les terminaux dépourvus de pavé numérique ou d'écran tactile (PanelView 300 ou 300 Micro) utilisent une roue 
codeuse pour saisir les caractères. Pour plus d'informations, recherchez le terme roue codeuse dans l'index de 
l'aide en ligne.

Mise à l’échelle des données

Les données entrées par l�opérateur peuvent être mises à l�échelle à l�aide de la formule suivante :

Les valeurs d�échelle et d�offset sont entrées dans l�éditeur de points. Si une valeur mise à l�échelle dépasse la 
plage autorisée pour le type de données sélectionné, le terminal affiche un message d�erreur.

Valeur stockée
à l'adresse 
d'automate

= Valeur entrée - Echelle
d'offset

900/1000/1400 à écran tactile

Clavier et Clavier/Ecran tactile
550/600 à écran tactile sans clavier 

Valeur courante

Valeur entrée = 7,5 Valeur affichée = 8
Valeur d’automate = 8

(arrondie)
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Précision et arrondi - L�automate stocke toutes les valeurs sous forme d�entiers à l'exception des valeurs à 
virgule flottante. Les chiffres à droite de la virgule décimale sont arrondis. Toutefois, le terminal peut mettre à 
l�échelle des valeurs décimales en nombres entiers et inversement.

Contrôles d’entrée ASCII
Un contrôle d�entrée ASCII permet à l�opérateur d�envoyer à l�automate une chaîne alphanumérique (jusqu�à 128 
caractères). Tous les automates ne prennent pas en charge 128 caractères. Tout comme les contrôles d'entrée 
numérique, les contrôles d�entrée ASCII apparaissent sur l�écran du terminal sous forme de boutons de 
validation de clavier ou de pointeurs.

La valeur initiale des contrôles d�entrée ASCII est définie dans l�éditeur de points. Cette valeur est envoyée à 
l�automate à la mise sous tension et peut également être configurée pour s�afficher sur l�objet. 

Bouton de validation de clavier

Le bouton de validation de clavier est un bouton-poussoir momentané qui affiche une chaîne de 
caractères ASCII à l'adresse d'un automate. Lorsqu'il est actionné, ce bouton ouvre le pavé ASCII pour 
permettre à l'opérateur de saisir une nouvelle chaîne de caractères et de l'envoyer à l'automate.

Pointeur

Le pointeur est un cadre de données qui affiche une chaîne de caractères ASCII à l'adresse d'un 
automate. Plusieurs pointeurs peuvent apparaître sur une vue. Une barre de marquage à gauche de 
l�objet indique quel pointeur est actif. L�opérateur sélectionne le pointeur en appuyant sur l�écran tactile, 
la touche de fonction correspondante ou les touches fléchées gauche et droite du terminal.

Lorsque vous entrez une chaîne dans le pavé, un mot de passe par exemple, une fonction de sécurité permet de 
masquer les caractères. Par exemple, si l'opérateur entre le mot de passe LETMEIN, les caractères apparaissent 
dans le pavé comme #######, chaque caractère étant remplacé par un signe #.

Numéro de pièce A123-BZO

Mot de passe : ##########
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Pavé ASCII

L�apparence du pavé ASCII varie selon les terminaux PanelView.

Les caractères sélectionnés sur le clavier du pavé apparaissent dans la zone d�affichage. Du fait que cette zone 
défile, tous les caractères de la chaîne peuvent ne pas être visibles. Les caractères sont tous envoyés à l'automate, 
même s'ils ne sont pas visibles. Les contrôles de saisie des caractères diffèrent selon les pavés. Consultez l�aide en 
ligne à ce sujet. 

Lorsque l�opérateur appuie sur la touche Entrée sur le clavier du terminal ou sur l�écran tactile, la chaîne est 
envoyée à l�automate. Le caractère le plus à gauche est placé dans l'octet fort du premier mot (à l�aide de l'adresse 
de point écriture), le caractère suivant dans l'octet faible et ainsi de suite. Le protocole DeviceNet permet la 
permutation des octets. 

Les terminaux dépourvus de pavé numérique ou d'écran tactile (PanelView 300 ou 300 Micro) utilisent une roue 
codeuse pour saisir les caractères. Pour plus d'informations, recherchez le terme roue codeuse dans l'index de 
l'aide en ligne. 

Prise en charge de différentes langues sur le pavé

Le pavé ASCII est disponible avec un clavier français, allemand, italien ou espagnol. Si le terminal PanelView est 
configuré pour fonctionner dans l'une de ces langues, le pavé ASCII affiche automatiquement le clavier 
approprié.

900/1000/1400 à écran tactile
550 à écran tactile sans clavier

Clavier ou Clavier/Ecran tactile
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Affichages de messages
Les affichages de messages donnent des informations d�état ou des instructions à un opérateur. Ils 
peuvent afficher différentes informations :
• état d�un procédé ;
• invites opérateur ;
• heure / date ;
• variable numérique ou ASCII.

Les affichages de messages peuvent être déclenchés par :
• bit unique ;
• bit de poids faible ;
• valeur.

0

50

50

0

gal

gal

*** Réservoir niveau haut ***

Entr.

Sortie

Entr.

Sortie

FerméeOuverte

SortieEntrée

Réservoir 1

Réservoir 1

FerméeOuverte

SortieEntrée

*** Réservoir niveau bas ***Exemple de message

Exemple de message
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Configurer les messages

Le texte et les autres options de formatage des messages sont définis dans l'onglet Etats de la boîte de dialogue 
de l�objet. Pour ajouter ou supprimer des messages, cliquez avec le bouton droit de la souris dans l'onglet Etats et 
sélectionnez Ajouter un état ou Supprimer l’état dans le menu contextuel. N�utilisez que le nombre de 
messages nécessaires pour l�application.

Les affichages de messages ont un état d�erreur qui avertit un opérateur quand les données dépassent la plage 
autorisée ou sont indisponibles. Vous pouvez modifier le texte par défaut de l'état d'erreur ou utiliser un 
graphique, mais vous ne pouvez en aucun cas supprimer cet état d'erreur. 

Créer des objets pour imprimer des messages

Vous pouvez créer un objet d'impression seule qui envoie tous les messages déclenchés à l�imprimante plutôt 
que de les afficher sur la vue. Toutes les variables du message s�impriment aussi. Les objets d�impression ne sont 
pas associés à une vue spécifique comme les affichages de messages et peuvent donc déclencher les messages à 
n�importe quel moment de l�exécution de l�application. Pour créer un objet d�impression, sélectionnez 
Application>Config impression seule. 
Les objets d�impression sont uniquement pris en charge par les terminaux munis d�un port imprimante série 
RS-232. Vous les saisissez de la même façon que pour les affichages de messages, mais sans les options de 
formatage. 

Texte du messageEtat d’erreur
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Affichages de données
Les bargraphes, les indicateurs multi-états, les indicateurs listes et les affichages numériques affichent la valeur 
numérique ou la représentation graphique de données stockées à une adresse d�automate.

Les indicateurs n�ont pas de « zone morte » dans laquelle toute une plage de valeurs est interprétée comme un 
état unique. Pour la plupart des applications, la logique à relais devrait permettre d'interpréter comme un même 
état une plage de valeurs autour de la valeur spécifiée.

Indicateurs multi-états

Les Indicateurs multi-états peuvent afficher jusqu'à 2000 états différents. Chaque état peut afficher une 
valeur numérique ou un graphique particulier. Les états peuvent être déclenchés par un bit, un bit de 
poids faible ou une valeur.

Bargraphes

Les bargraphes offrent une représentation visuelle d�une valeur numérique à l�adresse de l�automate. 
Vous pouvez spécifier le sens de remplissage des bargraphes et la plage de valeurs représentées. Des 
échelles indiquant la plage de données peuvent être ajoutées. Utilisez l'outil Texte pour créer des 
étiquettes de graduation pour l'échelle. Vous pouvez également créer un texte intérieur à l'intérieur d'un 

bargraphe pour pouvoir l'identifier.  

Erreur
L’état d’erreur indique que les données sont hors
plage ou que plusieurs états sont déclenchés.

Etat 0

Etat 1

Etat 2

Etat E

Rempli à partir du haut, 
Echelle ˆ gauche

Rempli à partir du bas, 
Echelle à droite

Rempli à partir de la gauche, 
Echelle au-dessous

Rempli à partir de la 
droite, Echelle au-dessus

0

25
50

75

100

0

25
50

75

100
Si une valeur dépasse la 
plage fixée pour ce type de 
données, le bargraphe 
apparaît vide ou plein.

Groupe de bargraphes

Valeur égale ou 
supérieure à la 
plage maximale des 
données. Valeur au-dessous de la plage minimale
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Jauges analogiques

La jauge analogique est un indicateur à aiguille tournante servant à afficher une variable de procédé telle que la 
vitesse, la température ou la pression. Elle comprend une échelle circulaire graduée, 1 à 4 aiguilles et une 
étiquette avec un texte intérieur statique ou des données variables. L�échelle circulaire fait partie de la jauge, mais 
vous pouvez la créer séparément ou créer une échelle secondaire pour la jauge. Utilisez l'outil texte pour créer les 
étiquettes de graduation. 

Chaque aiguille a son propre point de lecture, servant à faire le suivi d'une variable de procédé. Vous pouvez 
activer ou désactiver la butée pour une aiguille. La butée empêche l'aiguille de dépasser les valeurs minimum et 
maximum fixées pour l'aiguille. 

L'aiguille possède des attributs que vous pouvez ajuster, tels que la longueur, l'épaisseur et la forme. Vous pouvez 
également créer une aiguille avec une ombre ou bicolore. 

Lorsque vous redimensionnez une jauge, l'aiguille est également mise à l'échelle en fonction de la plus petite 
dimension (hauteur ou largeur) de la jauge. L'aiguille garde sa position relative par rapport à la jauge.

Indicateurs listes

Un indicateur liste est une liste déroulante contenant jusqu�à 255 entrées. L�entrée courante est marquée. 
Les entrées de la liste peuvent être déclenchées par un bit, un bit de poids faible ou une valeur.

0

20

40

100

60

80 120

140

160

180

200

Pression

Etat d’erreur - Aucun état n’est marqué. 
Cela se produit si les données sont hors de la 
plage valide ou si plusieurs états sont déclenchés.

Vide

Plein

1/4

1/2

Arrêté
Température basse

Réglages températureNiveau de réservoir

Température haute
Normale
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Affichages numériques

Les affichages numériques affichent une valeur brute ou une valeur mise à l�échelle à une adresse 
d�automate. Vous pouvez spécifier la largeur de champ (1 à 12 chiffres), une virgule décimale fixe ou 
flottante et si des zéros doivent compléter la valeur. Vous pouvez même ajouter du texte autour de la 
valeur.

Mise à l’échelle

Les données de l�automate peuvent être mises à l�échelle par le terminal PanelView avant d�être affichées. Les 
valeurs numériques brutes transmises par des équipements tels que des capteurs ou des thermocouples peuvent 
être converties en unités standard (kilogrammes, litres ou degrés Celsius, par exemple). Les données sont mises à 
l�échelle à l�aide de la formule suivante :

 

Les valeurs d'échelle (facteur multiplicatif) et d�offset sont entrées dans l�éditeur de points pour l�objet 
d�affichage. Les valeurs peuvent être stockées sous forme de nombre entier puis mises à l�échelle par le terminal 
pour apparaître avec une virgule fixe ou flottante.

Valeur sans zéros Virgule flottante 
PSI PSI PSI ***** PSI

Si une valeur dépasse la largeur du champ 
spécifiée, elle est remplacée par des astérisques.

90 090 90,25
Valeur avec zéros

Valeur mise à l’échelle = (Facteur d’échelle x valeur de l’automate) + Offset
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Sélecteurs de vues
Les contrôles Sélecteurs de vues permettent à l�opérateur de se déplacer d�une vue à l�autre de l�application. 
Quand l�espace est limité sur la vue, utilisez plutôt des boutons. 

Boutons sélecteurs de vues

Les boutons sélecteurs de vue ci-dessous sont disponibles. Placez les boutons sélecteurs de vue à la même 
position sur chaque vue pour permettre à l�opérateur de passer rapidement d�une vue à l�autre.

Bouton Aller à : ce bouton-poussoir momentané affiche une vue d�application spécifique.

Bouton Retour : ce bouton-poussoir momentané ramène à la vue précédente. Il permet uniquement de 
reculer d'une vue et n'offre pas de lien continu jusqu'à la première vue de l�application. 

Bouton Aller à config : ce bouton-poussoir momentané affiche le mode Configuration du terminal. Ce 
menu permet d�accéder aux fonctions du terminal telles que les paramètres de communication, le format 
d�heure et de date et les paramètres de langue. 

Sélecteur Liste de vues

Le Sélecteur Liste de vues contient un menu (ou une liste) de vues parmi lesquelles l�opérateur peut faire 
une sélection. Un curseur indique la sélection courante. Sur le clavier du terminal, l'opérateur utilise les 
touches de déplacement haut ou bas pour déplacer le curseur et la touche Entrée pour valider la 
sélection. 

Sur les terminaux à écran tactile, il faut placer des touches de liste sur la vue pour permettre à l'opérateur 
de déplacer le curseur et de sélectionner une vue.

  

Plusieurs listes de vues peuvent être utilisées sur la même vue. Pour sélectionner une liste, l'opérateur appuie sur 
la touche de fonction correspondante ou sur l'écran tactile. Un autre moyen de sélectionner entre les listes est 
d'utiliser les touches fléchées gauche ou droite du clavier du terminal.

Pompe

Chaudière

Touches de liste La barre de marquage montre la liste active (sélectionnée)

Convoyeur

Pompe
Chaudière

Convoyeur
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Configurer les entrées des listes de vues

Les entrées d�une liste de vues sont définies dans l'onglet Etats de la boîte de dialogue de l�objet. Une liste de 
vues peut comporter jusqu'à 255 entrées. N�utilisez que le nombre d�entrées nécessaires pour l�application.

Pour ajouter ou supprimer des entrées de la liste de vues, cliquez avec le bouton droit de la souris dans l'onglet 
Etats et sélectionnez Ajouter un état ou Supprimer l’état dans le menu contextuel. Chaque entrée est 
limitée à une ligne. Toute modification de la taille du texte affecte toutes les entrées de la liste.

Touches de liste

Les touches de liste permettent à un opérateur d�effectuer des opérations sur les listes, telles qu�un sélecteur Liste 
de contrôles ou de vues. Ces touches, indispensables sur les terminaux à écran tactile, peuvent également être 
utilisées sur les terminaux à clavier. Elles sont accessibles à partir du menu Objets>Touches de liste ou de la 
boîte à outils.

Avec le terminal PanelView 300 Micro, vous pouvez affecter des touches de déplacement aux objets, comme s'il 
s'agissait de touches de fonction. Cependant, si une vue dispose d'un sélecteur Liste de contrôles ou de vues, les 
touches de déplacement ne peuvent être affectées aux objets et utilisées pour déplacer le curseur dans une liste. 

Changement de vues par l’automate

L�automate peut contrôler les changements de vues et renvoyer le numéro de la vue courante. Les points de 
commande et d�état sont utilisés pour effectuer ces fonctions de l�automate. Pour plus de détails, reportez-vous 
au chapitre 10, page 131.

Vue associée à une entrée de la liste. Texte apparaissant dans la liste pour chaque vue.

Origine

Fin

Page précédente

Page suivante

Retour arrière

Entrée

Monter

Descendre
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Utilisation d’objets globaux
Un objet global est un objet unique qui peut être utilisé plusieurs fois dans une application tout en conservant 
ses attributs. L�objet est créé et stocké une seule fois dans le terminal PanelView quel que soit le nombre de fois 
où il est utilisé. Les objets globaux permettent de gagner du temps et d'économiser de la mémoire. 

Les propriétés d�un objet global peuvent être configurées à partir de n�importe quelle vue. Lorsqu'elles sont 
modifiées, toutes les reproductions de l'objet sont automatiquement mises à jour.

Suggestion : chaque objet de contrôle doit avoir un point d�écriture distinct à moins qu�il ne s�agisse du même 
objet global. Si plusieurs objets de contrôle (qui ne sont pas des objets globaux) utilisent le même point 
d�écriture, l�application ne sera pas validée. 

Un objet global ne peut être utilisé qu�une seule fois par vue, mais plusieurs objets globaux différents peuvent 
être placés sur une même vue. Les objets globaux ne peuvent pas être copiés ni collés.

Pour définir un objet comme global :

1. Cliquez deux fois sur l�objet.

2. Sélectionnez l�onglet Options.

3. Cochez la case Global sélectionné.

Suggestion : pour sélectionner un groupe d�objets comme objet global, cliquez deux fois sur le groupe et 
sélectionnez l�onglet Options. Si vous entrez une description de l�objet, les premiers caractères de cette 
description apparaissent dans la boîte de dialogue Objet global lorsque cet objet est réutilisé.
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Pour réutiliser un objet global :

1. Sélectionnez Objets>Objet global ou cliquez sur l�outil Objet global dans la boîte à outils .

La boîte de dialogue Global Objects (Objets globaux) s'affiche, identifiant chaque objet global par 
son nom de point, son ID et son type ou sa description.

2. Cliquez deux fois sur l'objet que vous voulez réutiliser ou sélectionnez-le, puis cliquez sur Copier vers.

3. Positionnez le curseur en croix (+) sur la vue, à l'emplacement où vous voulez placer l'objet, puis cliquez 
avec le bouton gauche de la souris.

L�objet global ne doit pas nécessairement apparaître au même endroit sur chaque vue. De plus, lorsqu�un objet 
global est réutilisé, une touche de fonction différente peut lui être affectée.

Toute modification apportée à un objet global s�applique à toutes les reproductions de cet objet à l�exception de 
son emplacement dans la vue et de la touche de fonction qui lui est affectée.

Trie le champ sélectionné. 

Ouvre une boîte de dialogue 
répertoriant toutes les vues 
dans lesquelles l'objet global 
sélectionné est utilisé.
Vous pouvez naviguer vers une 
vue spécifique.
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Chapitre 5

Alarmes

Ce chapitre couvre les sujets suivants :
• présentation du système d'alarmes ;
• bandeau et listes d�alarmes ;
• boutons d�alarmes ;
• configuration des alarmes (paramètres par défaut, déclenchements et messages compris) ;
• exemples de déclenchement d�alarmes.

Pour plus de détails sur les alarmes, ouvrez le livre Travailler avec les alarmes dans l'onglet 
Sommaire de l�aide.

Présentation du système d’alarmes
Les alarmes avertissent l�opérateur, au moyen d�une mise en garde visuelle ou imprimée, qu�une valeur de 
déclenchement a été atteinte ou dépassée. Cette valeur de déclenchement peut être associée via l�automate à 
différents capteurs ou programmes de surveillance du contrôle de production. Toutefois, certaines 
considérations de sécurité doivent être prises en compte :

Un message et une valeur de déclenchement sont définis pour chaque alarme. Vous devez spécifier si l�alarme 
doit être acquittée, affichée ou imprimée.

Liste d’alarmes : lorsque les alarmes sont déclenchées, elles sont ajoutées à une liste d�alarmes. Celle-ci 
permet à l�opérateur de visualiser et de gérer plusieurs alarmes.

Bandeau d’alarmes : définit la zone de la vue où l�opérateur peut visualiser les alarmes et les contrôles et y 
accéder. Quand une alarme est déclenchée, le bandeau d'alarmes s�affiche, quelle que soit la vue active.

ATTENTION

!
N'utilisez pas le terminal PanelView comme premier équipement de mise en garde dans le 
cas d�applications susceptibles d�entraîner des blessures, d�endommager les équipements ou 
d'entraîner des pannes importantes. Toute indication d�alarme critique et toute réponse de 
l�automate doit utiliser des verrouillages redondants, câblés ou mécaniques.
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Bandeau d’alarmes
Voici un exemple de bandeau d�alarmes avec un message d�alarme, une liste d�alarmes, et des contrôles d�alarme. 
La plupart des éléments présentés sont optionnels. Vous pouvez les moduler en fonction de vos applications.

Le bandeau d�alarmes (présenté ci-dessus) définit la zone de la vue où apparaissent les alarmes et leurs contrôles. 
Les messages d�alarmes sont affichés dans l�ordre chronologique de leur déclenchement. 

Le bandeau d�alarmes est un affichage global créé une seule fois dans une application mais apparaissant au même 
endroit sur chaque vue. Il n�apparaît que lorsqu�une alarme est déclenchée. Puisque le bandeau d�alarmes 
s'affiche par dessus les objets de contrôle et d�affichage, vous pouvez spécifier si vous voulez que tous les objets 
de la vue ou seuls les objets recouverts soient désactivés pendant l�affichage du bandeau. Le bandeau disparaît de 
la vue lorsque :

• l�opérateur appuie sur les boutons Acquitter, Effacer ou Tout acquitter ;
• l�automate supprime ou acquitte l�alarme ;
• le terminal passe en mode Configuration.

Température trop haute !

Effacer Acq Imprimer
Alarme

Imprimer
Alarme

Liste

Effacer
Alarme

Acq
Tout

Message d'alarme

Boutons d'alarmes
(facultatif)

Bandeau d’alarmes
arrière-plan

Liste d’alarmes
(facultatif)

19/06/99  16:55   Tempér*
06/19/99  16:30   LS101 *
19/06/99  15:00  19/06/99   15:05    Tempér*
19/06/99  14:50  19/06/99   14:52   Réserv*

Alarme Alarme Liste
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Créer un bandeau d’alarmes

Pour créer un bandeau d�alarmes, sélectionnez Vue>Créer le bandeau d’alarmes. 
La vue Bandeau d�alarmes apparaît dans le dossier Screens (Vues) de la fenêtre 
d�application. Contrairement aux autres vues, le bandeau d�alarmes ne porte pas de 
numéro et il ne peut pas être renommé.

Le bandeau par défaut est créé avec :
• une ligne de message d�alarme (qui ne peut pas être supprimée) ;
• le bouton de suppression d�alarmes.

Le bandeau d�alarmes peut être déplacé ou redimensionné, mais il ne peut pas avoir une taille inférieure à celle 
des objets qu�il contient. Désélectionnez le bandeau d�alarmes avant d�ajouter un objet ou de sélectionner un 
objet du bandeau. Pour ajouter des boutons d�alarme au bandeau, sélectionnez-les dans le menu 
Objets>Boutons d’alarmes. Pour ajouter une liste d�alarmes, sélectionnez Objets>Liste d’alarmes.

A propos des bandeaux d’alarmes

Emplacement du bandeau d’alarmes : sélectionnez Affichage>Position du bandeau d’alarmes 
pour visualiser l�emplacement du bandeau d�alarmes sur les vues de l�application. Cela vous permet de voir quels 
objets de la vue sont couverts (désactivés) lorsqu�une alarme est déclenchée.

Position / taille du bandeau d’alarmes : peuvent être modifiés dans la vue Bandeau d�alarmes. Pour 
ouvrir le bandeau d�alarmes, cliquez deux fois dessus dans le dossier Vues de la fenêtre d�application.

Apparence du bandeau d’alarmes : sur les terminaux couleur, l�arrière-plan par défaut du bandeau et des 
objets d�alarmes est rouge et le premier plan est blanc. Sur les terminaux monochromes ou en niveaux de gris, 
l�arrière-plan est noir et le premier plan est blanc. Vous pouvez modifier ces couleurs de premier et d'arrière-plan 
à partir de la palette des couleurs ou du menu Format.
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Liste d’alarmes
La liste d'alarmes contient un journal de toutes les alarmes déclenchées. Le nombre maximal d'alarmes dans la 
liste est de 100. Toutefois, le nombre maximal d�alarmes réellement stockées dépend de la RAM disponible dans 
le terminal.

Chaque liste d�alarmes peut apparaître dans le bandeau d�alarmes de plusieurs vues ou sur une vue distincte. 
Pour chaque alarme, la liste peut afficher :

• si l�alarme est acquittée ou non (facultatif) ;
• la date et l�heure de l�alarme ou de l�acquittement (facultatif) ;
• la valeur de déclenchement de l�alarme (facultatif) ;
• le texte de l�alarme (obligatoire).

19/06/99  16:55   Tempér*
06/19/99  16:30   LS101 *
19/06/99  15:00  19/06/99   15:05    Tempér*
19/06/99  14:50  19/06/99   14:52   Réserv*

Alarme non acquittée

Acquittement
non requis

Alarme acquittée

Date / Heure du déclenchement

Date / Heure de l’acquittement

Message d'alarme
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Créer une liste d’alarmes

La liste d�alarmes fonctionne comme un sélecteur Liste de contrôles en ce sens que l�opérateur utilise un curseur 
pour sélectionner des alarmes spécifiques et les acquitter. 

Comme pour les sélecteurs Liste de contrôles, les terminaux à écran tactile doivent comporter 
des touches de liste sur la vue afin que l�opérateur puisse déplacer le curseur et acquitter les 
alarmes. Pour créer une touche de liste, sélectionnez une option du menu Objets>Touches 
de liste.

Pour créer une liste d�alarmes, sélectionnez Objets>Liste d’alarmes. Cliquez deux fois sur l�objet pour ouvrir 
sa boîte de dialogue. Voici les propriétés que vous pouvez configurer pour chaque liste d�alarmes :

• Champs d’affichage : définissent les données à afficher pour chaque alarme de la liste : date/heure de 
l�alarme, date/heure de l�acquittement et valeur de déclenchement de l�alarme. 

• Options d'affichage de la liste : pour chaque entrée, vous pouvez également spécifier le nombre de 
lignes à afficher et la taille du texte. Vous pouvez aussi placer le curseur à une position donnée dans la liste 
pour que celle-ci puisse défiler, tout en gardant le curseur statique.

• Options d’affichage des alarmes : spécifient les conditions des alarmes (actives et/ou inactives) et 
les états d�acquittement (acquittées, non acquittées, acquittement non requis) qui doivent apparaître dans 
la liste. Vous pouvez créer plusieurs listes d�alarmes pour afficher des types particuliers d�informations. 
Par exemple, vous pouvez créer des listes distinctes pour afficher :
– les alarmes actives non acquittées
– les alarmes actives acquittées
– les alarmes inactives acquittées

A propos de la liste d’alarmes

Impression de la liste d’alarmes : créez un bouton Imprimer la liste d'alarmes pour pouvoir imprimer 
ponctuellement la liste ou configurez les alarmes pour les imprimer au moment où elles se produisent.

Liste d’alarmes pleine : si la Liste d�alarmes est pleine lorsqu'une alarme est déclenchée, l�alarme la plus 
récente s�ajoute au haut de la liste et :

• l�alarme la plus ancienne ne demandant pas d�acquittement est retirée de la liste (y compris les alarmes qui 
ont déjà été acquittées).

• si toutes les alarmes ne demandant pas d�acquittement ont été retirées, l�alarme la plus ancienne est 
supprimée.
Publication 2711-GR003C-FR-P



66          Alarmes
Boutons d’alarmes
Placez des boutons d�alarme dans le bandeau pour que l�opérateur puisse réagir à une alarme. Certains de ces 
boutons peuvent être utilisés hors du bandeau d�alarmes. Pour accéder aux boutons d�alarmes, sélectionnez 
Objets>Boutons d’alarmes.  

Bouton Description
Utilisé hors du 
bandeau 
d’alarmes ?

• Accuse réception de l’alarme actuellement affichée.
• Fait disparaître le bandeau d’alarmes mais n'efface pas la condition d'alarme.
• Marque l’alarme comme acquittée dans la liste d’alarmes

Non

• Fait disparaître le bandeau d’alarmes sans acquitter l’alarme.
• N’efface pas la condition d’alarme.

Si les alarmes ne sont pas configurées pour être acquittées individuellement, le 
bandeau d’alarmes doit contenir le bouton Effacer.

Non

Imprime le message courant du bandeau d’alarmes (terminaux avec port imprimante 
RS-232 seulement). Avec chaque message, vous pouvez imprimer :

• la date et l’heure de l’alarme
• la date et l’heure de l’acquittement
• la valeur de déclenchement

Non

• Acquitte toutes les alarmes de la liste.
• Fait disparaître le bandeau d’alarmes mais n'efface pas la condition d'alarme.
• Marque l’alarme comme acquittée dans la Liste d’alarmes

Oui

• Efface la liste d'alarmes.
• Efface aussi le bandeau d’alarmes même si la condition existe toujours.

La liste d’alarmes est automatiquement effacée lorsqu'une application est chargée.

Oui

Imprime toutes les alarmes de la liste (terminaux avec port imprimante RS-232 
seulement). Avec chaque message, vous pouvez imprimer :

• la date et l’heure de l’alarme
• la date et l’heure de l’acquittement
• la valeur de déclenchement

Oui

Acq

Effacer

Imprimer

Acq
Tout

Effacer

d'alarmes
la liste

d'alarmes
la liste
Imprimer
Publication 2711-GR003C-FR-P 



Alarmes          67
Configuration des alarmes
Pour chaque alarme créée, il faut configurer :

• le message d�alarme et les attributs de l�alarme ;
• le point de déclenchement de l�alarme et le type de déclenchement.

Vous pouvez également modifier les paramètres par défaut qui s�appliquent à toutes les alarmes.

Modifier les paramètres par défaut des alarmes

Certains paramètres s�appliquant à toutes les alarmes peuvent être modifiés. Par exemple, vous pouvez spécifier :
• si tous les objets de la vue ou seulement les objets recouverts doivent être désactivés lorsque le bandeau 

d�alarmes s�ouvre. Par défaut, tous les objets de la vue sont désactivés.
• la taille de la liste d�alarmes (25 par défaut) et si la liste doit être effacée à la mise sous tension.
• les données à imprimer avec chaque alarme (heure/date de l�alarme, heure/date de l'acquittement et 

valeur de déclenchement de l�alarme). Ces informations s�appliquent aux alarmes qui sont imprimées 
lorsqu�elles se produisent ou lorsque vous appuyez sur les boutons Imprimer la liste d'alarmes ou 
Imprimer.

• les points décentralisés utilisés par l�automate pour effacer ou acquitter toutes les alarmes ou pour 
recevoir le texte de toutes les alarmes déclenchées. Ces points ne sont activés que si la case Utiliser les 
champs optionnels est cochée. 
Pour modifier la définition d�un point, sélectionnez le nom du point et choisissez Editer le point dans 
le menu contextuel.

• les valeurs de temps utilisées pour les scrutations d�E/S lorsqu'une alarme est déclenchée ; ceci donne à 
l�automate assez de temps pour acquitter l�alarme (si nécessaire). 

Pour modifier les paramètres par défaut des alarmes :

• Ouvrez le dossier Alarms (Alarmes) dans la fenêtre d�application et cliquez deux fois sur l�icône 
Setup (Configuration) ou 

• Sélectionnez Application>Configuration des alarmes

Lorsque la boîte de dialogue s�ouvre, l�onglet Configuration est sélectionné. 
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Définir les déclenchements des alarmes
Chaque alarme est associée à un déclenchement. Pour chaque déclenchement, il faut définir :

• Un point de déclenchement : définit l�adresse d�automate surveillée par le terminal pour une valeur 
ou un bit de déclenchement d�alarme. La plupart des applications utilisent un seul point de 
déclenchement. 

• Un type de déclenchement : définit le type de données qui déclenchera l�alarme (bit, valeur, bit de 
poids faible).

Les déclenchements sont attribués aux alarmes individuelles dans l'onglet Messages d�alarmes de la boîte de 
dialogue Alarmes.

Pour définir les déclenchements d’alarmes :

• Ouvrez le dossier Alarms (Alarmes) dans la fenêtre d�application et cliquez deux fois sur l�icône 
Alarm Triggers (Déclenchements d’alarmes) ou 

• Sélectionnez Application>Configuration des alarmes, puis l'onglet Déclenchements 
d’alarmes.

L'onglet Déclenchements d�alarmes ressemble à une feuille de calcul. Chaque ligne définit un déclenchement 
distinct. Les champs de chaque ligne définissent les attributs du déclenchement. Certains champs doivent être 
complétés par du texte alors que d�autres demandent la sélection d�une option dans une liste déroulante.

Vous devez au moins entrer un nom de point et sélectionner un type de déclenchement (bit, LSBit, valeur). Vous 
pouvez activer les champs de point facultatifs pour les déclenchements en sélectionnant Champs optionnels 
dans le menu contextuel.
L'adresse de point de déclenchement de l'automate doit être l�adresse la plus basse de l�alarme correspondante. 

IMPORTANT
Les types de données sont différents pour les applications ControlLogix. 
Reportez-vous à l�aide en ligne.

La plupart des opérations de déclenchement s'effectuent à l'aide d'une commande du menu contextuel. Par 
exemple, pour ajouter un déclenchement, cliquez avec le bouton droit de la souris (ou appuyez sur Ctrl + M) 
et sélectionnez Append trigger (Ajouter un déclenchement). Pour modifier la définition d’un point de 
déclenchement, sélectionnez le champ Point de déclenchement, puis cliquez avec le bouton droit de la 
souris et sélectionnez Edit Tag (Editer le point).
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Définition des messages d’alarmes

Pour chaque message d�alarme, vous pouvez définir les attributs suivants :
• le message de l�alarme (jusqu�à 255 caractères)
• la valeur ou le bit qui déclenche l�apparition de l�alarme dans le bandeau ou dans la liste des alarmes. 

L'automate écrit la valeur ou le bit à l'adresse du point de déclenchement. Pour Bit ou LSBit, il s�agit en 
réalité d�un offset de bits à partir de l'adresse du point de déclenchement.

• le point de déclenchement associé à l�alarme (onglet Déclenchements d�alarmes)
• si l�alarme doit être acquittée par l�opérateur ou l�automate
• si l�alarme est imprimée quand elle est déclenchée
• si l�alarme est affichée dans le bandeau d�alarmes quand elle est déclenchée
• les couleurs d�arrière-plan/premier plan du texte de l�alarme
• l�envoi du message d�alarme à un équipement décentralisé lorsqu�une alarme est déclenchée

Les points de déclenchement, variables dans le message d'alarme, et les autres points d'alarmes (s'ils sont utilisés) 
doivent faire partie du même groupe de scrutation.
Tous les terminaux PanelView peuvent prendre en charge jusqu'à 2 000 alarmes, sauf PanelView 300, 300 Micro 
et 550 qui ne peuvent en gérer que 1 000. 

Pour définir les messages d’alarmes :

• Ouvrez le dossier Alarmes dans la fenêtre d�application et cliquez deux fois sur l�icône Messages 
d’alarmes ou

• Sélectionnez Application>Configuration des alarmes, puis sélectionnez l�onglet Messages 
d’alarmes.

Chaque ligne de la feuille de calcul définit une entrée ou un état particulier. Les champs de chaque ligne 
définissent les attributs de chaque alarme. Certains champs doivent être complétés par du texte, d�autres 
contiennent une liste déroulante d�options et d�autres présentent une case à cocher permettant d'activer ou de 
désactiver une option. 

La plupart des opérations s'effectuent à l'aide d'une commande du menu contextuel. Par exemple, pour ajouter un 
message d’alarme, cliquez avec le bouton droit de la souris (ou appuyez sur Ctrl + M) et sélectionnez Append 
Alarm (Ajouter une alarme). Pour trier les messages selon le champ Texte, sélectionnez Sort by Message Text 
(Trier par texte). Pour filtrer les alarmes selon le champ de déclenchement, sélectionnez Filter by Trigger (Filtrer 
par déclenchement).
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Exemples de déclenchement d’alarmes
Alarmes déclenchées sur Bit ou LSBit
Cette section présente un exemple de 3 alarmes utilisant un déclenchement de type Bit. La plage des données 
pour un déclenchement sur bit va de 0 à 255 (bit, entier signé/non signé, DCB). Pour un ensemble de bits, la 
plage de valeurs correspond à la taille de l'ensemble. Si le point Acq. est utilisé, la plage de données commence 
par 1 au lieu de 0.
Dans l�exemple ci-dessous, 3 alarmes (A,B,C) sont attribuées au déclenchement d�alarmes alm_tag (point_alm). 
C�est un déclenchement de type Bit. Dans ce cas, le champ Value/Bit (Valeur/Bit) est un offset de bits depuis 
l�adresse du point de déclenchement (et non une valeur).

Dans l�éditeur de points, la définition du point point_alm est :

Le point gère au total 256 bits/alarmes consécutifs (0 à 255), N:15:0/0 à N15:15/15.

L'adresse du bit de déclenchement d'alarmes correspond au nombre qui se trouve dans le champ Valeur/Bit, 
plus l'adresse du point de déclenchement : Adresse du point de déclenchement + Valeur/Bit = Adresse du bit de 
déclenchement

Par exemple, l�alarme A se déclenche lorsque N15:1/0 passe de 0 à 1.

16 + N15:0/0 = N15:1/0

L�alarme B se déclenche lorsque N15:0/2 passe de 0 à 1.

2 + N15:0/0 = N15:0/2

Pour le déclenchement sur LSBit, l�alarme se déclenche lorsque le bit de déclenchement passe de 0 à 1 alors que 
tous les autres bits entre l'adresse du point de déclenchement et celle du bit de déclenchement sont à zéro. 
L�adresse du point de déclenchement étant N7:12/4 et la Valeur/Bit 6, une alarme est déclenchée lorsque 
N7:12/10 passe de 0 à 1. C�est le seul bit configuré entre N7:12/4 et N7:12/10. 

Si N7:12/4 est à 1 lorsque N7:12/10 passe à 1, l�alarme correspondant à N7:12/10 ne sera déclenchée qu�après 
la remise à 0 de N7:12/4.

Nom du point Type de données Adresse de point Nom de station

point_alm Bit N15:0/0 SLC_1
Publication 2711-GR003C-FR-P 



Alarmes          71
Alarmes déclenchées sur Valeur

Cette section présente un exemple de 3 alarmes utilisant un déclenchement de type Valeur. Les valeurs de 
déclenchement ne doivent pas sortir de la plage du type de données sélectionnées pour le point de 
déclenchement (entier signé/non signé, DCB).

Dans l�exemple ci-dessous, 3 alarmes (A,B,C) sont attribuées au déclenchement d�alarmes alm_tag (point_alm). 
C�est un déclenchement de type Value (Valeur). Le champ Value/Bit (Valeur/Bit) indique une valeur différente 
(1, 2, 3) pour chaque alarme. La valeur 0 est réservée.

Dans l�éditeur de points, la définition du point point_alm est :

Chaque alarme est déclenchée lorsque la valeur qui lui est attribuée est entrée en N15:0. Par exemple, lorsque la 
valeur 2 est entrée en N15:0, l�alarme B est déclenchée.

Nom du point Type de données Adresse de point Nom de station

point_alm Entier non signé N15:0 SLC_1
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Chapitre 6

Texte

Ce chapitre explique comment :
• modifier le texte intérieur des objets ;
• ajouter des variables au texte ;
• entrer du texte de vue ou du texte défilant ;
• modifier l�apparence du texte ;
• utiliser l�éditeur de texte de l�application ;
• stocker du texte traduit en plusieurs langues dans l'application ;
• utiliser des fichiers de polices pour traduire du texte dans une autre langue.

Pour plus de détails sur l�utilisation du texte, ouvrez le livre Ajouter du texte, des graphiques 
intérieurs et des variables dans l'onglet Sommaire de l�aide.

Modification du texte d’un objet
Par défaut, la plupart des objets sont créés avec un texte intérieur modifiable. Ce texte apparaît dans l�objet et lui 
est associé. Quand vous déplacez ou supprimez l�objet, le texte intérieur est également déplacé ou supprimé.

Les boutons-poussoirs et les objets multi-états peuvent avoir un texte intérieur différent pour chaque état.

Arrêté

Moyen
Haut

Bas
Vue 

Sélecteur Liste de contrôles Sélecteur Liste de vues Bouton Retour

Entrée de données
Chaudière

Pompe

Convoyeur
précédente

MCH

ARR

Texte Etat 0

Texte Etat 1

Bouton-poussoir Marche/Arrêt

Bas

Moyen

Haut

Bouton-poussoir multi-états
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Modifier le texte intérieur d’un objet sans états

1. Sélectionnez l�objet.

2. Cliquez sur l�outil Texte intérieur  ou sélectionnez Format>Texte intérieur. La barre d�outils 
Texte s�ouvre.

Pour les objets d'affichage ou d'entrée numérique, la marque de réservation de variable numérique  /*N:6   
NO FILL FIX:0*/ apparaît dans la zone de texte. Vous ne pouvez pas effacer la variable (les caractères 
entre les barres obliques /*N . . . /), mais vous pouvez ajouter du texte avant et après. 

3. Modifiez le texte ou cliquez sur la touche fléchée bas, située sur le côté droit de la zone de texte pour 
ouvrir la boîte de dialogue Edition de texte. Cette boîte de dialogue vous permet d�entrer du texte et 
des variables.
Au fur et à mesure que le texte est modifié, il est entré dans l'objet. Quand vous appuyez sur Entrée pour 
commencer une nouvelle ligne, les caractères /*R*/sont insérés pour indiquer un retour chariot. Un 
astérisque (*) apparaît si le texte dépasse la taille de l�objet.

4. Le cas échéant, redimensionnez l�objet pour que tout le texte y tienne.

Modifier le texte intérieur d’un objet multi-états ou liste

1. Sélectionnez l�objet.

2. Cliquez sur l�outil Texte intérieur  ou sélectionnez Format>Texte intérieur. La barre d�outils 
Texte s�ouvre.

3. Sélectionnez l�état dans la zone State (Etat) de la barre d�outils Etat ou sélectionnez 
Format>Etat suivant ou Etat précédent.

4. Modifiez le texte ou cliquez sur la touche fléchée bas, située sur le côté droit de la zone de texte pour 
ouvrir la boîte de dialogue Edition de texte. Cette boîte de dialogue vous permet d�entrer du texte et 
des variables. 
Au fur et à mesure que le texte est modifié, il est entré dans l'objet. Appuyez sur Entrée pour commencer 
une nouvelle ligne. Un astérisque (*) apparaît si le texte dépasse la taille de l�objet.

5. Répétez les étapes 3 et 4 pour modifier le texte d�un autre état.

6. Le cas échéant, redimensionnez l�objet pour que tous les textes y tiennent.
Suggestion : pour les objets multi-états ou listes, vous pouvez entrer le texte de chaque état dans l'onglet Etats 
de la boîte de dialogue de l'objet.

Le numéro à gauche du cadre est 
un numéro interne  à ignorer.
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Ajout de variables dans un texte
Vous pouvez insérer, dans un objet ou dans un texte, une variable d�heure, de date, de caractère ou une variable 
numérique. L'heure et la date sont formatées dans l'onglet Heure/date de la boîte de dialogue 
Configuration de l’application. La variable numérique et la variable de caractère sont formatées selon les 
propriétés définies dans la boîte de dialogue.

Pour une variable d�heure ou de date, l�objet de la vue montre comment la variable apparaîtra sur le terminal 
PanelView. Pour une variable numérique ou de caractère, l�objet de la vue affiche les caractères ### pour 
indiquer la largeur de champ de la variable.
  

Ajout d'une variable d’heure ou de date

1. Sélectionnez l�objet.

2. Cliquez sur l�outil Texte intérieur  ou sélectionnez Format>Texte intérieur. La barre d�outils 
Texte s�ouvre.

3. Pour un objet multi-états, sélectionnez l�état dans la zone State (Etat) de la barre 
d�outils Etat ou sélectionnez Format>Etat suivant ou Etat précédent.

4. Cliquez dans la zone de texte, à l�endroit où vous voulez insérer la variable.
Vous pouvez également cliquer sur la touche fléchée bas située à droite de la zone de texte pour ouvrir la 
boîte de dialogue Edition de texte. Cette boîte de dialogue vous permet d�entrer du texte et des 
variables. 

5. Sélectionnez Heure ou Date dans le menu Format>Variable incorporée ou dans le menu qui s�ouvre 

lorsque vous cliquez sur l�outil Variable incorporée  dans la barre d�outils Texte.
 

6. La marque de réservation d'heure /*T*/ ou de date /*D*/ est insérée dans la zone de texte et inclut leur 
format.

7. Le cas échéant, redimensionnez l�objet pour que tout le texte y tienne.

Suggestion : pour supprimer une variable, il suffit de cliquer sur la marque de réservation dans la zone de texte 
ou dans la boîte de dialogue d�édition de texte et d�appuyer sur la touche Supprimer.

L’heure actuelle est
1H:MM:SS PM

La date actuelle est
JJ/MM/AA

La température actuelle est 
### degrés.
Publication 2711-GR003C-FR-P



76          Texte
Ajouter une variable numérique

La variable numérique affiche une valeur numérique lue à une adresse d�automate. La variable peut afficher 
jusqu'à 12 chiffres avec une virgule fixe ou flottante, avec ou sans zéros non représentatifs. 

1. Sélectionnez l�objet.

2. Cliquez sur l�outil Texte intérieur  ou sélectionnez Format>Texte intérieur. La barre d�outils 
Texte s�ouvre et affiche le texte existant.

3. Pour un objet multi-états, sélectionnez l�état dans la zone State (Etat) de la barre 
d�outils Etat ou sélectionnez Format>Etat suivant ou Etat précédent.

4. Cliquez dans la zone de texte, à l�endroit où vous voulez insérer la variable.

Vous pouvez également cliquer sur la touche fléchée bas située à droite de la zone de texte pour ouvrir la 
boîte de dialogue Edition de texte. Cette boîte de dialogue vous permet d�entrer du texte et des 
variables. 

5. SŽlectionnez Numérique dans le menu Format>Variable incorporŽe  ou dans le menu qui 

sÕouvre lorsque vous cliquez sur l�outil Variable incorporée dans la barre d�outils Texte.

Une boîte de dialogue s�ouvre, spécifiant la largeur de champ, le format de virgule décimale et l�adresse du 
point de lecture de la variable. Lorsque vous quittez cette boîte de dialogue, une marque de réservation est 
insérée dans la zone de texte, incluant les informations de formatage.

 

Une chaîne de caractères ####### contenant le nombre de caractères du champ est insérée dans 
l�objet de la vue.

6. Le cas échéant, redimensionnez l�objet pour que tout le texte y tienne.

Suggestion : pour modifier une variable numérique, cliquez sur la marque de réservation de la variable dans la 
zone de texte et sélectionnez Edition de variable dans le menu Variable incorporée. Pour supprimer la 
variable, sélectionnez-la et appuyez sur la touche Supprimer.
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Ajout d'une variable de caractères

La variable ASCII affiche une chaîne de caractères (12 maximum) lue à une adresse d�automate. Elle est mise à 
jour chaque fois que la chaîne est modifiée. Cette variable peut afficher tout caractère du jeu ASCII étendu. Les 
caractères sont traités dans l�ordre, jusqu�à réception d�un caractère nul (tous les bits à 0).
La chaîne est stockée dans la table de données comme une suite de caractères. Le format de la chaîne doit être le 
suivant :

1. Sélectionnez l�objet.
2. Cliquez sur l�outil Texte intérieur  ou sélectionnez Format>Texte intérieur. La barre d�outils 

Texte s�ouvre et affiche le texte existant.

3. Pour un objet multi-états, sélectionnez l�état dans la zone State (Etat) de la barre 
d�outils Etat ou sélectionnez Format>Etat suivant ou Etat précédent.

4. Cliquez dans la zone de texte, à l�endroit où vous voulez insérer la variable.
Vous pouvez également cliquer sur la touche fléchée bas située à droite de la zone de texte pour ouvrir la 
boîte de dialogue Edition de texte. Cette boîte de dialogue vous permet d�entrer du texte et des 
variables.

5. SŽlectionnez Caract•res dans le menu Format>Variable incorporŽe  ou dans le menu qui sÕouvre

lorsque vous cliquez sur l�outil Variable incorporée de la barre d�outils Texte.

Une boîte de dialogue s�ouvre, spécifiant la largeur de champ et l�adresse du point de lecture de la chaîne 
de caractères. Lorsque vous quittez cette boîte de dialogue, une marque de réservation est insérée dans le 
texte, incluant les informations de formatage.

 

Une chaîne de caractères ####### contenant le nombre de caractères du champ est insérée dans 
l�objet.

6. Le cas échéant, redimensionnez l�objet pour que tout le texte y tienne.

Suggestion : pour modifier une variable de caractères, cliquez sur la variable dans la zone de texte et 
sélectionnez Edition de variable dans le menu Variable incorporée. Pour supprimer la variable, 
sélectionnez-la et appuyez sur la touche Supprimer.

Bit 15 8 7 0

1er mot 1er caractère 2ème caractère

2ème mot 3ème caractère 4ème caractère

. . . . . .
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Ajout d’un texte d’arrière-plan à une vue
Dans une vue, vous pouvez ajouter du texte sans l'attacher ni l'associer à un objet : titres de vues, étiquettes 
d�objets, étiquettes de graduation pour échelles de bargraphes, etc.

Le texte d�arrière-plan peut contenir jusqu�à 255 caractères utilisant la taille de texte par défaut. Il peut apparaître 
n�importe où sur la vue. Vous pouvez redimensionner le texte et utiliser différents moyens de mise en valeur 
comme le soulignement ou l�application d�une couleur.

1. Cliquez sur l�outil Texte de la boîte à outils ou sélectionnez Objets>Texte.

2. Cliquez dans la vue à l�endroit où vous voulez placer le cadre du texte ou faites glisser le pointeur pour le 
dimensionner. 
La barre d�outils Texte s�ouvre pour vous permettre d�entrer le texte.

3. Entrez votre texte dans la zone vide située dans la barre d'outils. Vous pouvez également entrer du texte 
directement dans la boîte de dialogue Edition de texte en cliquant deux fois sur l'objet ou sur la touche 
fléchée bas située à droite de la zone de texte. Cette boîte de dialogue permet également d'insérer des 
variables dans le texte.

Au fur et à mesure de sa saisie, le texte apparaît dans la zone de texte. Lorsque vous appuyez sur Entrée 
pour commencer une nouvelle ligne, les caractères /*R*/sont insérés pour indiquer un retour chariot. Un 
astérisque (*) apparaît si le texte dépasse la taille de l�objet.

Suggestion : si le texte est coupé au milieu d�un mot, sélectionnez Format>Retour automatique. 
Le texte passera à la ligne à la fin d�un mot.

4. Le cas échéant, redimensionnez le bloc de texte de façon à ce que tout le texte y tienne.

Texte défilant
L'objet Texte défilant est utile dans les vues ayant un espace limité. Il est identique à l'objet Texte d'arrière plan, 
mais permet de faire défiler le texte de droite à gauche à une vitesse définie. Sélectionnez Objets>Texte 
défilant pour y accéder.

MCH

Vide

1/2 plein
Plein

1/4 plein

Contrôle du niveau de réservoir

0 kg

25 kg

50 kg

75 kg

100 kg

 Pompe 3

Exemples de textes de vues
Publication 2711-GR003C-FR-P 



Texte          79
Modification de l’apparence du texte
Vous pouvez modifier l�apparence d�un texte en utilisant diverses combinaisons d'options de taille, 
d�accentuation et d�alignement. En mode texte intérieur, les outils se sélectionnent dans la barre d�outils Texte 
ou dans le menu Format. Certaines commandes basculent entre actif/inactif tandis que d�autres ouvrent un 
menu. Pour modifier l'apparence d'un objet qui est déjà créé, il suffit de le sélectionner, puis de choisir une 
option de formatage.

La barre d�outils Texte est automatiquement activée en mode texte intérieur. Elle peut aussi être activée ou 
désactivée dans le menu Affichage>Barres d’outils. 

Pour plus de détails sur le formatage du texte, ouvrez le livre Formatage d'objets et de texte dans 
l'onglet Sommaire de l�aide.

Suggestion : pour les objets multi-états, il est possible d'appliquer différentes options de formatage du texte à 
chaque état. 

Cliquez sur : Pour :

Clignotant

Activer le clignotement du texte intérieur d'un objet. Le clignotement s’applique à toute 
la chaîne de texte. Le clignotement n’est pas disponible pour les objets listes. 
Le clignotement a lieu toutes les 0,5 secondes et n’est activé que lorsque l’application 
est chargée dans le terminal PanelView. 

Souligné

Activer/désactiver le soulignement pour le texte intérieur. Le soulignement s’applique à 
toute la chaîne de texte.

Bascule 
premier/arrière-plan

Inverser les couleurs de premier plan et d’arrière-plan du texte intérieur. Toute la chaîne 
de texte est affectée. Cette option n’est pas disponible pour les objets listes.
Les couleurs de premier plan et d’arrière-plan du texte peuvent être inversées 
indépendamment des sélections de couleurs de premier plan et d’arrière-plan de l’objet. 

Taille du texte

Modifier la taille du texte intérieur d’un objet. Pour les objets listes, la modification de la 
taille du texte affecte toutes les entrées de la liste. Les tailles de texte disponibles 
varient d’un terminal à l’autre.
Si les polices externes sont activées, les tailles de texte pour le fichier de polices externe 
apparaissent entre parenthèses au bas du menu de taille de texte. 

Alignement horizontal 
du texte

Aligner le texte intérieur d’un objet à gauche, au centre ou à droite. 

Alignement vertical 
du texte

Aligner le texte intérieur d'un objet en haut, au centre ou en bas.
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Pour appliquer des options de formatage au texte d'un objet existant :

1. Sélectionnez l�objet.

2. Pour un objet multi-états, sélectionnez l�état dans la zone Etat  ou sélectionnez Etat 

suivant ou Etat précédent dans le menu Format.

3. Dans la barre d�outils, cliquez sur les outils que vous souhaitez appliquer ou sélectionnez les commandes 
correspondantes dans le menu Format. 

Suggestion : pour les objets multi-états ou listes, vous pouvez sélectionner plusieurs options de formatage de 
texte dans l'onglet Etats de la boîte de dialogue de l'objet.

Utilisation de l’éditeur de texte de l’application
L�éditeur de texte est une feuille de calcul qui stocke toutes les chaînes de texte d�une application. Vous pouvez 
utiliser cet éditeur pour :

• entrer ou modifier un texte (avec des variables incorporées) ;
• supprimer un texte inutilisé ;
• copier un texte dans un objet ;
• renuméroter un texte ;
• filtrer ou trier des textes ;
• imprimer tous les textes de l�application.

Pour ouvrir l’éditeur de texte :

• cliquez deux fois sur l�icône Tag Editor (Editeur de texte) dans le dossier System (Système)

 

• sélectionnez Editeur de texte dans le menu Outils
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Ajouter ou modifier un texte
Vous pouvez ajouter une chaîne de texte sur la dernière ligne de la feuille de calcul ou à un emplacement 
spécifique.

• Pour ajouter un texte à la fin de la feuille de calcul, cliquez deux fois dans le champ Texte de la dernière 
ligne et remplacez le texte par défaut « Nouveau texte » par le vôtre.

• Pour insérer une chaîne de texte avant une ligne, sélectionnez la ligne, puis cliquez avec le bouton droit de 
la souris et sélectionnez Insérer un texte. Cliquez deux fois dans le champ Texte du message et 
remplacez le texte par défaut par le vôtre.
Pour entrer un retour chariot, appuyez sur la touche Entrée. Les caractères /*R*/ apparaissent pour 
indiquer une nouvelle ligne.
Le champ ID Texte prend automatiquement le numéro disponible suivant. Le champ Nombre reste à 0 
jusqu�à ce que la chaîne soit utilisée par un objet.

Si vous modifiez une chaîne de texte, ce texte est automatiquement mis à jour partout où il est utilisé dans 
l�application. 

Champ Description

Text ID (ID Texte) Numéro unique d’identification de la chaîne.

Count (Nombre) Champ en lecture seule qui spécifie le nombre d’utilisations de la chaîne dans l’application. 0 signifie 
que la chaîne n’est pas utilisée. 

Type Champ en lecture seule qui indique si le texte est utilisé dans un objet ou comme message d’alarme.

Message Text 
(Texte du message)

Texte avec ou sans variables incorporées.
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Insérer des variables dans un texte
Vous pouvez insérer l�heure, la date, une variable numérique ou une variable de caractères dans une chaîne de 
texte. Consultez à ce sujet les pages 75 à 77.

Cliquez deux fois dans le champ Texte du message puis positionnez le curseur au point d�insertion de la variable. 
Cliquez avec le bouton droit de la souris et sélectionnez une option dans le menu Variable incorporée. 
Lorsque vous sélectionnez Numérique (pour les valeurs numériques) ou Caractères, une boîte de dialogue 
s�ouvre pour vous permettre de spécifier le format de la variable à l�adresse du point de lecture.  

Pour les variables, les marques de réservation suivantes sont insérées dans la chaîne de texte.

Pour modifier une variable numérique ou une variable de caractères, sélectionnez la marque de réservation, cliquez 
avec le bouton droit de la souris et sélectionnez Variable incorporée>Edition. Pour supprimer la variable, 
sélectionnez la marque de réservation et appuyez sur la touche Supprimer.

Recherche et remplacement de texte
Utilisez les commandes Rechercher et Remplacer du menu contextuel pour chercher et/ou remplacer du texte 
dans une colonne spécifique. Cliquez sur la colonne dans laquelle vous voulez effectuer votre recherche, puis 
cliquez avec le bouton droit et sélectionnez Rechercher. Une boîte de dialogue s'affiche pour la recherche. 
Utilisez la commande Remplacer pour rechercher et remplacer du texte. A partir de ces deux commandes, 
vous pouvez lancer une recherche vers le haut ou vers le bas d'une colonne ou tenir compte de la casse du texte 
à rechercher.

Pour déterminer si une chaîne de texte donnée est utilisée dans l'application, sélectionnez une ligne, cliquez avec 
le bouton droit de la souris, puis sélectionnez Utilisé par dans le menu contextuel. Une boîte de dialogue 
s'ouvre, répertoriant tous les détails sur l'emplacement où l'objet est utilisé.

Trier des textes
Le tri se fait par colonne, numériquement ou alphabétiquement, en fonction du contenu de la colonne. 
Par exemple, si vous triez le champ Texte du message, toutes les lignes sont réorganisées par ordre 
alphabétique. Les chaînes de texte identiques sont regroupées.

Pour trier une colonne de données, sélectionnez une option dans la zone Sort By (Trier par). L�option Aucun 
indique qu�il n�y a aucune colonne de tri.

Variable : Marque de réservation :

Heure /*T*/ 

Date /*D*/

Numérique /*V:8  NOFILL  FIX:0*/

Caractères /*A:6  Read_Tag_Name*/
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Filtrer des textes

Vous pouvez filtrer les textes pour n�afficher ou ne travailler qu�avec un sous-ensemble de chaînes de texte de 
l�application. La liste filtrée peut être triée et imprimée.

Pour filtrer le texte, cliquez sur le bouton Filtrer. Une boîte de dialogue s�ouvre, contenant des cases à cocher 
pour tous les objets de l�application qui utilisent du texte. D�autres cases à cocher permettent de filtrer le texte 
inutilisé, les alarmes ou les objets d'impression seule.

Au départ, toutes les cases sont cochées. Pour travailler avec un sous-ensemble de texte, ne cochez que les cases 
appropriées ; supprimez les autres coches. Par exemple, pour visualiser toutes les chaînes de texte inutilisées de 
l�application (Nombre = 0), supprimez toutes les coches sauf celle de la case Inutilisé.

Renuméroter des textes

Vous pouvez consolider la mémoire pour éliminer les écarts dans la numérotation. Pour rechercher les écarts, 
triez le champ ID Texte.

Pour renuméroter : Action :

une seule chaîne de texte Cliquez deux fois dans le champ ID Texte et entrez un numéro. Si des numéros en 
double sont détectés, un message de mise en garde s’affiche lorsque vous 
fermez l’éditeur de texte.

toutes les chaînes de texte Cliquez sur le bouton Tout sélectionner, puis sur le bouton Renuméroter. Toutes les 
chaînes sont renumérotées en commençant par la valeur d’ID texte de la ligne 1.

un bloc de chaînes de texte Cliquez sur la première ligne du bloc et faites glisser la souris en maintenant le 
bouton gauche enfoncé jusqu’à ce que tous les lignes soient incluses dans le 
bloc. Ou cliquez sur une ligne, maintenez appuyée la touche Maj enfoncée et 
sélectionnez la dernière ligne.
Toutes les chaînes de texte du bloc sont renumérotées en commençant par le 
numéro de la première chaîne. Par exemple, un bloc de chaînes de texte 
numérotées 80, 84, 85, 88 sera renuméroté 80, 81, 82, 83.
Publication 2711-GR003C-FR-P



84          Texte
Déplacer des textes

Vous pouvez réorganiser les chaînes de texte en les faisant monter ou descendre d'une ligne ou en les plaçant à 
un emplacement spécifique.

Supprimer des textes
Vous pouvez supprimer des textes inutilisés. Une chaîne dont le champ Nombre est 0 n�est pas utilisée. Pour 
créer un sous-ensemble de tous les textes inutilisés :

• Triez le champ Nombre. Toutes les chaînes de texte avec un nombre de 0 apparaîtront en bloc au début 
de la feuille de calcul.

• Filtrez tous les textes à l�exception des chaînes de texte inutilisées. Cliquez sur le bouton Filtrer. 
Supprimez toutes les coches sauf celle de la case Inutilisé.

Après avoir trié ou filtré les textes inutilisés, vous pouvez les supprimer. Cliquez sur le bouton Tout 
sélectionner puis sur le bouton Vider. Tout texte inutilisé (Nombre = 0) est supprimé de façon permanente 
de la feuille de calcul.

Pour supprimer une ou plusieurs chaînes de texte inutilisées, sélectionnez les lignes (portant le nombre 0) puis 
cliquez sur le bouton Vider ou cliquez avec le bouton droit de la souris et sélectionnez Supprimer le texte.

Imprimer des textes

Vous pouvez imprimer tous les textes de l�éditeur de texte ou une plage de textes. Créez un sous-ensemble de 
textes à imprimer en utilisant l�option de filtrage. Vous pouvez également trier une liste filtrée ou une plage de 
textes avant de les imprimer. Pour chaque chaîne de texte, l�ID de texte et le texte du message sont imprimés. Un 
en-tête s�imprime en haut de chaque page.

Pour imprimer des textes de l�application, sélectionnez les textes à imprimer puis cliquez sur le bouton 
Imprimer. Dans la boîte de dialogue d�impression, sélectionnez les éléments à imprimer (Tout ou Sélection).

Pour déplacer une chaîne 
de texte :

Action :

d’une ligne vers le haut ou 
vers le bas

Sélectionnez la ligne, cliquez avec le bouton droit de la souris et 
sélectionnez la commande Monter le texte ou Descendre le texte.

vers un emplacement 
spécifique

Sélectionnez la ligne, cliquez avec le bouton droit de la souris et 
sélectionnez la commande Placer le texte en. Une boîte de dialogue 
s’ouvre. Entrez le numéro de la ligne où vous souhaitez placer le texte.

Le texte est déplacé et les autres lignes sont renumérotées.
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Copier un texte directement dans un objet

Tout texte stocké dans l�éditeur de texte peut être copié dans un objet. Si vous réutilisez plusieurs fois le même 
texte, une seule copie de la chaîne de texte est stockée.

Les procédures ci-dessous présentent les différentes façons de copier dans un objet un texte stocké dans 
l�éditeur de texte. 

Pour copier un texte de l’éditeur de texte dans un objet :

1. Sélectionnez l�objet dans lequel le texte doit être copié.

2. Cliquez sur l�outil Texte intérieur  ou sélectionnez Format>Texte intérieur. 

3. Pour un objet multi-Žtats, sélectionnez l�état dans la zone State (Etat) de la barre 
d�outils Etat ou sélectionnez Format>Etat suivant ou Etat précédent.

4. Cliquez sur l�outil Utiliser le texte existant de la barre d�outils Texte ou sélectionnez 
Edition>Texte existant. L�éditeur de texte s�ouvre en mode lecture seule.

5. Sélectionnez la ligne à copier.

6. Cliquez sur le bouton Mise à jour. Le texte de l�objet est remplacé par le texte sélectionné.

Pour copier un texte de l'éditeur de texte dans l'onglet Etat d’un objet multi-états :

1. Cliquez deux fois sur l'objet.

2. Sélectionnez l�onglet Etat.

3. Sélectionnez la ligne du texte que vous voulez remplacer par le texte de l�éditeur de texte.

4. Cliquez avec le bouton droit de la souris et sélectionnez Utiliser le texte existant. L�éditeur de texte 
s�ouvre en mode lecture seule.

5. Sélectionnez la ligne contenant le texte que vous voulez copier.

6. Cliquez sur le bouton Appliquer puis sur le bouton Fermer. Les champs ID de texte et Texte du 
message sont remplacés par les données du texte copié.
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Stockage de texte traduit en plusieurs langues
Consultez la section Traduction d’applications sous Travailler avec des applications dans 
l'onglet Sommaire de l�aide.

PanelBuilder32 permet de stocker du texte traduit en 5 langues dans une application. Les langues proposées sont 
les suivantes : 

• Anglais
• Français
• Allemand
• Italien
• Espagnol

En stockant le texte traduit des objets dans l'application, vous pouvez facilement modifier la langue pendant que 
l'application est en cours d'exécution sur le terminal. Les 5 langues peuvent être sélectionnées à n'importe quel 
moment, ce qui a pour effet de modifier la langue des objets dans l'ensemble de l'application. Cependant, une 
seule langue peut être active dans l'application à un instant donné. 

Vous pouvez activer le support multilingue pour de nouvelles applications ou les applications existantes.
• Pour de nouvelles applications, cochez la case Support multilingue de la boîte de dialogue Créer 

une nouvelle application.
• Pour des applications existantes, cochez la case Support multilingue de la boîte de dialogue 

Configuration de l'application.

Une fois le support multilingue activé, la barre d'outils Langue et le menu Affichage>Langue sont activés. 
Utilisez l'une de ces options pour faire passer l'application d'une langue à l'autre. Lors de ce passage, les attributs 
associés à chaque chaîne de texte, tels que la taille du texte, la police et l'alignement, sont conservés.

Pour stocker du texte traduit en plusieurs langues :

1. Créez le texte dans la langue que vous voulez utiliser par défaut, par exemple l'anglais.

2. Sélectionnez une langue dans le menu Affichage>Langue ou la barre d'outils Langue.
Chaque objet peut stocker du texte traduit en anglais, français, allemand, espagnol et italien. Seule une 
langue est active.

Remarque : même si vous sélectionnez l'une des 5 langues standard, vous pouvez encore entrer du 
texte dans une langue aux caractères ASCII  étendus. Vous pouvez utiliser une langue asiatique, mais ceci 
n'est pas recommandé en raison de la taille des polices.
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3. Traduisez le texte de tous les objets écran par écran à l'aide du mode Texte intérieur ou de l'option 
Outils>Editeur de texte. 

L'éditeur de texte possède également une liste Langue afin que vous puissez afficher le texte de 
l'application dans une autre langue.

L'application est téléchargée vers le terminal avec le texte traduit pour toutes les langues, mais l'application 
s'exécutera dans la langue spécifiée dans l'onglet Evolués de la boîte de dialogue Configuration de 
l'application. Vous pouvez modifier la langue active d'une application à partir du terminal en :

• envoyant un point interne @Write_CurrentLang vers le terminal à l'aide d'un bouton-poussoir ou d'un 
sélecteur Liste de contrôles dans l'application. Les valeurs de ce point sont les suivantes :

Français = 0
Allemand = 1
Italien = 2
Espagnol = 3
Anglais = 4

Nous vous recommandons de définir l'état initial sur 4 = Anglais ou sur la valeur correspondant à la 
langue par défaut de l'application.

• sélectionnant une langue depuis l'écran de configuration des langues du mode Configuration du terminal.

Conversion entre applications prenant en charge une seule langue et applications multilingues

• Si vous activez le support multilingue pour une application existante, tous les objets sont mis à jour pour 
prendre en charge plusieurs langues. Plusieurs chaînes de texte sont créées pour chaque objet dans 
chacune des 5 langues (même si aucune traduction n'a été entrée). Utilisez la barre d'outils Langue pour 
basculer entre les langues.

• Si vous copiez un objet d'une application possédant un support multilingue vers une application ne 
prenant en charge qu'une seule langue, l'objet est mis à jour pour ne gérer qu'une seule langue. L'objet 
conserve le texte dans la langue active au moment de la copie et tous les autres textes traduits sont 
supprimés.

• Si vous désactivez le support multilingue d'une application, seul le texte de la langue active est retenu ; 
tous les autres textes traduits sont supprimés.
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Utilisation de fichiers de polices pour traduire du texte d'application
Consultez la section Traduction d’applications sous Travailler avec des applications dans 
l'onglet Sommaire de l�aide.

Le terminal PanelView prend en charge les caractères anglais, français, allemands, espagnols et italiens. Pour les 
autres langues, une police compatible Windows peut être référencée dans une application PanelBuilder32. 

L'utilitaire FontTool permet de créer un fichier de polices (*.OTF) pour une langue spécifique, puis de l�activer 
dans PanelBuilder32. Le fichier de polices doit résider sur une carte mémoire dans le terminal PanelView 
pendant l�exécution de l�application. Le terminal utilise les caractères du fichier de polices pour les afficher à 
l'écran. Une carte mémoire associée au fichier de polices n'est pas requise pour l'anglais, le français, l'allemand, 
l'espagnol et l'italien, ces langues étant prises en charge par le terminal.

L�utilitaire FontTool peut créer des fichiers de polices pour tout groupe de langues (ou pages de codes) pris en 
charge par Windows. Les langues de l�Europe occidentale ont la page de code 1252. Arial et Times Roman sont 
des polices prises en charge par la page de code 1252. Le jeu de caractères de la langue que vous voulez utiliser 
doit être installé sur l'ordinateur.

Pour que vous puissiez entrer des caractères codés sur deux octets (32 bits) dans PanelBuilder32, votre 
ordinateur doit être équipé de l'un des programmes suivants :

• Version locale de Windows pour la langue ;
• Editeur de méthode d�entrée (IME).

Pour les caractères codés sur un octet, le texte de l�application peut être entré au moyen de :
• fichier de polices activé sous PanelBuilder32 ;
• clavier Windows ;
• table de caractères Windows ou pression sur la touche Alt + l�équivalent décimal à 4 chiffres d�un 

caractère ASCII étendu. Dans l'onglet Index de l�aide, recherchez entrer des caractères ASCII.
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Utiliser FontTool

Sélectionnez Programmes>PanelBuilder32>FontTool dans le menu Démarrer. Cet utilitaire possède 
ses propres barres de menus et barre d�outils.
 

Créer un fichier de polices

1. Sélectionnez File>New Font (Fichier>Nouvelle police) ou cliquez sur l�outil Nouvelle police 
de la barre d�outils.

2. Sélectionnez une police dans la zone Locale (Paramètres régionaux). Si cette police a un sous-type, 
son nom apparaît entre parenthèses, par exemple Chinese (Simplified).

3. Sous Available Sizes (Tailles utilisables), sélectionnez les tailles de caractères que vous voulez 
stocker dans le fichier de polices. 
Suggestion : la désélection de tailles de caractères réduit la taille de l�application.

Les tailles de texte augmentent par multiples de 8.

Les tailles sélectionnées apparaissent dans les 
menus de PanelBuilder32 en même temps que les 
tailles standard. Les tailles de texte provenant du 
fichier de polices sont placées entre parenthèses.

Pour les langues suivantes, codées sur un octet, 
sélectionnez Courier New dans le champ Police :
-anglais
-français
-italien
-allemand
-espagnol
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4. Sélectionnez un style de police dans la boîte de dialogue Polices. Le style doit être compatible avec la 
définition des polices. Par exemple, si vous sélectionnez Chinese (Simplified), il faut :
– qu�une police chinoise soit installée sur l�ordinateur ;
– que la page de codes appropriée soit installée sur l�ordinateur ;
– que le programme IME soit exécuté avec la langue appropriée.

Si le système exécute une version chinoise de Windows, un IME n�est pas nécessaire ; la page de codes 
appropriée est automatiquement disponible. 

5. Cliquez sur OK pour générer le fichier. Le temps nécessaire pour générer le fichier de polices dépend du 
nombre de caractères et de tailles de la définition ainsi que de la vitesse de votre ordinateur.

6. Pour chaque définition de police, un exemple de texte s�affiche dans le style sélectionné. Assurez-vous 
qu�il est correct.

Le fichier de polices *.OTF réside maintenant en mémoire mais pas sur le disque.
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Enregistrer un fichier de polices

Vous pouvez enregistrer un fichier de polices sur le disque et/ou sur une carte mémoire. Le fichier de polices doit 
résider sur une carte mémoire dans le terminal PanelView pendant l�exécution de l�application. Le terminal utilise ce 
fichier de polices pour afficher les caractères appropriés sur la vue.

Pour enregistrer le fichier de polices sur disque :

1. Sélectionnez Fichier>Enregistrer Sous.

2. Dans la zone Nom de fichier, entrez un nom descriptif avec l�extension .OTF.

PanelBuilder32 s�attend à trouver tous les fichiers de polices .OTF dans l�emplacement par défaut : Program 
Files>Allen-Bradley>PanelBuilder>Applications>Font.

Pour enregistrer le fichier de polices sur carte mémoire : 

1. Chargez une carte ATA uniquement (référence 2711-NM2xx8) dans le lecteur de carte ATA de votre 
ordinateur.
Les cartes ATA sont recommandées pour les langues codées sur deux octets car elles offrent une plus 
grande capacité.

2. Sélectionnez Fichier>Enregistrer sur carte mémoire ou cliquez sur l�outil Carte mémoire dans la 
barre d�outils.

3. Sélectionnez le lecteur de carte ATA dans la zone Enregistrer sous.

4. Dans la zone Nom de fichier, saisissez ou sélectionnez le nom du fichier .OTF à enregistrer sur la 
carte.

Suggestion : pour enregistrer le fichier de polices sur un lecteur de carte ATA dans PanelBuilder32, utilisez les 
commandes Fichier>Copier le fichier de polices>Enregistrer sous. 

Pour copier un fichier de polices sur une carte mémoire Flash (référence 2711-NM1x), utilisez la commande 
Fichier>Enregistrer sous dans PanelBuilder32.
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Utiliser un fichier de polices dans PanelBuilder32

Avant de pouvoir utiliser le fichier de polices dans PanelBuilder32, vous devez activer les polices externes et 
sélectionner le fichier de polices dans l'onglet Polices externes de la boîte de dialogue Configuration de 
l’application. Pour plus de détails, reportez-vous au Chapitre 10, page 133.

Les tailles de texte du fichier de polices (*.OTF) apparaissent entre parenthèses au bas 
des menus Format>Taille du texte dans PanelBuider32. 

Si vous les sélectionnez, PanelBuilde32 utilise les caractères du fichier de polices pour 
générer le texte qui apparaît sur la vue d�application. Si vous sélectionnez une taille de 
texte sans parenthèses, PanelBuilder utilise sa police standard.

Vous ne pouvez pas utiliser les tailles de texte du fichier de polices et la police standard 
dans la même chaîne de texte. Vous pouvez toutefois les utiliser conjointement dans 
l�application.

Pour entrer des caractères codés sur deux octets stockés dans le fichier de polices, l�ordinateur doit exécuter une 
version locale de Windows ou un éditeur IME avec la langue (page de codes) appropriée sélectionnée. Si aucun 
de ces deux logiciels n�est exécuté, le système d'exploitation affichera les caractères codés sur deux octets comme 
deux caractères codés sur un octet.

Exécuter l’application avec le fichier de polices

Chargez l�application dans un terminal PanelView comme expliqué au chapitre 11. Vérifiez que la carte mémoire 
contenant le fichier de polices est bien insérée dans son logement sur le terminal. Utilisez la fixation de carte 
mémoire livrée avec le terminal pour maintenir la carte mémoire dans son logement.

Traduire les textes d’une application sous Excel

Vous pouvez copier les textes d�une application PanelBuilder32 sous Excel, traduire le texte sous Excel, puis 
recopier le texte traduit dans PanelBuilder32. Ceci peut être utile si la personne traduisant les textes ne connaît 
pas bien PanelBuider32.

Pour plus de détails sur la traduction des textes sous Excel, ouvrez le livre Travailler avec des 
applications dans l'onglet Sommaire de l�aide. 

Tailles de 
texte du 
fichier de 
polices

Tailles de 
texte de 
la police 
par défaut
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Graphiques

Ce chapitre couvre les sujets suivants :
• utilisation des outils graphiques ;
• ajout de symboles ISA à une vue ;
• ajout de graphiques bitmap à une vue ;
• insertion d�un graphique dans un objet ;
• importation et exportation de graphiques.

Pour plus de détails sur les graphiques, ouvrez le livre Ajout de dessins et import de graphiques 
dans l'onglet Sommaire de l�aide.

Utilisation des outils graphiques
PanelBuilder32 fournit des outils graphiques pour créer des lignes, des formes et des dessins. Ces outils sont 
accessibles dans le menu Objets>Graphiques ou dans la boîte à outils. Contrairement aux objets de 
contrôle et d�affichage, les graphiques peuvent se chevaucher sur la vue. 

Cliquez sur : Pour :
Dessiner une ligne droite. Cliquez à l’endroit où vous voulez dessiner la 
ligne et faites glisser le pointeur de la souris.

Dessiner une ligne brisée ouverte ou un polygone simple comme un 
triangle. Cliquez à l’endroit où vous voulez commencer et terminer chaque 
ligne. Quand vous avez fini de dessiner les lignes, cliquez deux fois.
Dessiner un rectangle. Cliquez à l’endroit où vous voulez dessiner le rectangle 
et faites glisser le pointeur de la souris. Pour dessiner un carré, maintenez la 
touche Maj enfoncée pendant que vous faites glisser le pointeur.
Tracer un cercle. Cliquez à l’endroit où vous voulez dessiner le cercle et 
faites glisser le pointeur de la souris. 
Dans le terminal PanelView, le traitement des cercles se fait plus 
efficacement que celui des ellipses.
Dessiner une ellipse. Cliquez à l’endroit où vous voulez dessiner l’ellipse et 
faites glisser le pointeur de la souris.

Créer un tracé libre. Les tracés libres utilisent beaucoup de mémoire. Pour 
un dessin compliqué, créez une image bitmap avec un autre programme 
puis importez le graphique.
Placer un graphique sur la vue. 
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Ajout de symboles ISA
Vous pouvez placer des symboles ISA standard sur une vue. Pour accéder à ces symboles, cochez la case 
Symboles ISA dans la boîte de dialogue Affichage>Barres d’outils. 

Choisissez un symbole dans la boîte à outils et cliquez dans la vue, à l�endroit où vous voulez le placer. Les 
symboles ISA peuvent être déplacés et dimensionnés. PanelBuilder32 conserve l'image dans sa taille d'origine et 
dans ses tailles modifiées.

Ajout de graphiques à une vue
En plus des graphiques ISA, vous pouvez placer sur la vue des images bitmap créées dans d�autres programmes 
ou fournies par PanelBuilder32.
Pour placer un graphique sur une vue :

1. Cliquez sur l�outil Image de la boîte à outils ou sélectionnez Image dans le menu 
Objets>Graphiques.

2. Cliquez pour placer une bordure provisoire qui contiendra l�image. La barre d�outils Graphiques s�ouvre.
  

3. Sélectionnez un graphique dans la liste Graphics (Graphiques).
La bordure prend la taille du graphique puis disparaît. Dimensionnez le graphique comme vous le 
souhaitez. PanelBuilder32 conserve le graphique dans sa taille d'origine et dans ses tailles modifiées. Si 
vous sélectionnez un graphique qui est disponible en plusieurs tailles, une boîte de dialogue s'ouvre pour 
vous permettre de sélectionner l'une des tailles existantes ou d'en spécifier une nouvelle.

Conseil : Pendant que l�image est sélectionnée (la liste des graphiques apparaît en vidéo inverse), vous 
pouvez visualiser les autres graphiques à l�intérieur de la bordure en utilisant les touches fléchées haut et 
bas.

4. Désélectionnez l�objet pour quitter le mode graphique.
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Insertion d’un graphique dans un objet
Vous pouvez insérer un graphique dans un objet (à l'exception des objets listes). Pour les objets multi-états, vous 
pouvez entrer un graphique différent pour chaque état. Le graphique peut être un symbole ISA ou une image 
bitmap créée avec un autre programme.

Le graphique est relié à l�objet de la même façon que le texte intérieur. Si vous déplacez ou supprimez l�objet, le 
graphique est également déplacé ou supprimé.
Pour insérer une image bitmap ou un symbole ISA dans un objet :

1. Sélectionnez l�objet.
2. Pour un objet multi-états, sélectionnez l�état dans la zone Etat ou sélectionnez Format> Etat suivant 

ou Etat précédent.
Suggestion : pour supprimer le texte de l�objet, cliquez sur l�outil Texte intérieur et supprimez le 
texte.

3. Cliquez sur l�outil Graphique intérieur de la barre d�outils Etat ou sélectionnez 
Format>Graphique intérieur. La barre d�outils Graphiques s�ouvre.

4. Sélectionnez un graphique ou un symbole ISA dans la liste Graphiques.
Lorsque la liste de graphiques est en surbrillance, vous pouvez utiliser les touches fléchées haut et bas 
pour passer d�un graphique à l�autre.
Suggestion : pour retirer un graphique d�un objet, sélectionnez Aucun dans la liste.

5. Positionnez et redimensionnez le graphique dans l'objet. Positionnez le graphique en le faisant glisser. 
Redimensionnez le graphique en utilisant ses poignées. 
Si une image bitmap ou un symbole ISA est redimensionné, PanelBuilder32 conserve l'image dans sa 
taille d'origine et dans sa taille modifiée. Si vous sélectionnez un graphique qui est disponible en plusieurs 
tailles, une boîte de dialogue s'ouvre pour vous permettre de sélectionner l'une des tailles existantes ou 
d'en spécifier une nouvelle.

6. Redimensionnez l'objet, le cas échéant.
7. Désélectionnez l�objet pour quitter le mode graphique. 

Remarque : vous ne pouvez pas modifier le contenu d�une image bitmap ou d�un symbole ISA dans 
PanelBuilder32. Il vous faut exporter le graphique, le modifier avec un programme tel que Paint puis l'importer à 
nouveau. Pour ce faire, reportez-vous à la section suivante.

Bouton-poussoir Marche/Arrêt
Etat 0
Graphique 
intérieur

Etat 1
Graphique 
intérieur
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Importation et exportation de graphiques
Vous pouvez importer des images bitmaps couleur et monochromes à partir d�autres programmes. Ces images 
peuvent ensuite être placées sur une vue ou insérées dans un objet. Une image bitmap est importée dans sa taille 
d'origine.. Si l'image bitmap est redimensionnée, PanelBuilder32 conserve sa taille d'origine et sa taille 
redimensionnée.
Les images bitmaps importées ne peuvent dépasser le nombre de pixels pris en charge par l'affichage du 
terminal. Les grandes images sont coupées lors de l�importation.
Les images bitmaps couleur sont réduites à 32 couleurs à l'importation. Les terminaux PanelView standards 
(avec firmware 4.10 ou ultérieure) prennent en charge 32 couleurs. Sur les terminaux en niveaux de gris, les 
images bitmaps couleur sont réduites à 4 couleurs (nuances de gris). Ces fichiers sont exportés avec le même 
nombre de couleurs qu�à l�importation. 
Vous pouvez également exporter des graphiques dans un fichier ou le presse-papiers, les modifier en utilisant un 
autre programme puis les importer à nouveau. 
Pour importer ou exporter des graphiques bitmap, sélectionnez Fichier>Importer/exporter des 
graphiques.
 

Affiche une vue du 
graphique sélectionné.

Utilisez les touches fléchées 
haut et bas pour visualiser les 
graphiques disponibles.

Affiche la taille de l'image bitmap 
sélectionnée (en pixels et en 
octets) et le nombre de couleurs..

Affiche le nombre d'images 
bitmaps monochromes et couleur 
que vous avez importé.
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Pour importer une image bitmap :

1. Cliquez sur le bouton Importer de la boîte de dialogue Import/Export de graphiques.

2. Sélectionnez le fichier bitmap (*.bmp, .gif, .tif,...) à ouvrir dans la boîte de dialogue Import du 
graphique depuis le fichier.

Si vous importez une image bitmap comportant plus de 256 couleurs, la zone consacrée à la méthode de 
réduction des couleurs devient disponible. Sélectionnez l'option donnant les meilleurs résultats. Le 
nombre de couleurs d'une image sera réduit au nombre de couleurs pris en charge par l'affichage de votre 
terminal PanelView.

3. Cliquez sur Ouvrir. La boîte de dialogue Nom du graphique s'ouvre et affiche le nom de fichier de 
l'image bitmap. 

4. Acceptez le nom de fichier par défaut ou entrez un autre nom unique pour l'image bitmap.
5. Cliquez sur OK.

Vous retournez à la boîte de dialogue Import/Export de graphiques. Le nom du graphique apparaît 
dans Graphiques actuellement importés.

Cochez cette case pour afficher le 
graphique sélectionné dans la zone 
Aperçu. L'image est mise à jour à 
mesure que vous sélectionnez 
différents fichiers bitmaps. 

Cochez cette case pour afficher le 
graphique sélectionné pris en 
charge par le terminal PanelView.

N'apparaît que pour les images 
bitmaps comportant plus de 255 
couleurs.

Affiche la taille du graphique 
en pixels et en octets. 
Affiche aussi le format 
couleur du graphique.

Sélectionnez une méthode 
de réduction des couleurs. 
Le graphique est mis à jour 
dans la zone Aperçu à 
mesure que vous effectuez 
les sélections.

Affiche et importe un bitmap sous 
la forme d'une image en noir et 
blanc.
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Pour importer une image bitmap :

1. Cliquez sur le bouton Importer de la boîte de dialogue Import/Export de graphiques.
2. Dans la boîte de dialogue qui s�ouvre, sélectionnez le fichier *.bmp à importer.
3. Une autre boîte de dialogue s�ouvre ; remplacez le nom du fichier par un nom unique pour le graphique. 

Le nom saisi apparaîtra sous Graphiques actuellement importés.
Le graphique peut être importé comme image bitmap monochrome ou 16 couleurs. L�option Couleur 
n�existe pas lors de l�importation d�une image monochrome. Si vous importez une image bitmap couleur 
sur un terminal en niveaux de gris, l�image sera réduite à 4 couleurs.

Quand vous fermez cette boîte de dialogue, le nom du graphique apparaît dans la liste Graphiques actuellement 
importés. 

Pour coller une image bitmap depuis le presse-papiers :

1. Dans un autre programme tel que Paint, copiez ou coupez l�image bitmap dans le presse-papiers.
2. Dans PanelBuider32, sélectionnez Fichier>Importer/exporter des graphiques.
3. Cliquez sur le bouton Coller.
4. Dans la boîte de dialogue qui s�ouvre, attribuez un nom unique au graphique. Le nom saisi apparaîtra 

sous Graphiques actuellement importés. 
Lorsque vous fermez la boîte de dialogue, le graphique apparaît dans la liste Graphiques actuellement importés. 

Pour copier une image bitmap dans le presse-papiers :

1. Sélectionnez un graphique dans la liste Graphiques actuellement importés. 
2. Cliquez sur le bouton Copier. 

Vous pouvez maintenant coller le graphique dans un autre programme tel que Paint.

Pour exporter une image bitmap vers un fichier :

1. Sélectionnez le nom du graphique que vous voulez exporter. 
Les images bitmaps couleur sont exportées à mesure qu'elles sont stockées dans PanelBuilder32. Si une 
image bitmap couleur a été importée avec 32 couleurs, elle est exportée de même.

2. Cliquez sur le bouton Exporter.
3. Dans la boîte de dialogue qui s'ouvre, entrez un nom de fichier pour enregistrer le graphique (le type de 

fichier .bmp est ajouté) et cliquez sur OK. 

Pour supprimer un graphique :
1. Sélectionnez un graphique dans liste Graphiques actuellement importés.
2. Cliquez sur le bouton Supprimer. 

Les symboles ISA ne peuvent pas être supprimés.
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Formatage des objets

Ce chapitre explique comment :
• modifier l�apparence des objets ;
• utiliser la couleur pour modifier l�aspect des objets et du texte.

Pour plus de détails sur le formatage des objets, ouvrez le livre Formatage d'objets et de texte dans 
l'onglet Sommaire de l�aide.

ATTENTION

!
Certaines combinaisons d�options de formatage peuvent rendre invisible un objet de 
contrôle (objet confondu avec l�arrière-plan de la vue). Tous les contrôles d�un écran tactile 
doivent être visibles ou contenir un graphique indiquant l�emplacement de l�objet, au risque 
d'entraîner un accident ou un fonctionnement imprévisible.
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Modification de l’apparence des objets
Vous pouvez modifier les caractéristiques visuelles des objets à partir de la barre d'outils Format ou du menu 
Format. Certaines commandes basculent entre actif/inactif tandis que d�autres ouvrent un menu. 

La barre d�outils Format peut être affichée ou masquée dans le menu Affichage>Barres d’outils.

Suggestion : dans le cas des objets multi-états, vous pouvez définir des motifs de remplissage, basculer les 
couleurs de premier plan et d'arrière-plan et définir des options de clignotement séparément pour chaque état.

Cliquez sur : Pour :

Forme

Modifier la forme d'un bouton ou d'un graphique. Les cercles utilisent moins de mémoire et le 
terminal PanelView les traite plus efficacement que les ellipses.
La forme est redimensionnée pour s'adapter à la zone de l’objet initial. Les seuls motifs de 
remplissage conservés lors de la conversion d'une forme en cercle ou en ellipse sont : blanc, noir 
ou aucun.

Bordure

Modifier la bordure d’un objet.
Sur les terminaux monochromes, les choix de bordure sont : noire, blanche ou aucune. Sur les 
terminaux couleur et niveaux de gris, les choix de bordure sont : continue ou aucune.

Type de remplissage

Modifier le motif de remplissage d’un objet rectangulaire. Il est blanc par défaut. 
Sur les terminaux couleur ou en niveaux de gris, les cercles et les ellipses n’ont aucun 
remplissage. Sur les terminaux monochromes, le motif de remplissage des cercles et ellipses 
est : noir, blanc ou aucun.

Clignotant

Activer/désactiver le clignotement d’un objet ou d'un graphique (y compris le remplissage et la 
bordure). Le clignotement n’est pas disponible pour les objets listes. 
Le clignotement a lieu toutes les 0,5 secondes et n’est activé que lorsque l’application est 
chargée dans le terminal PanelView.
Le clignotement du texte est configuré indépendamment de celui de l’objet.

Bascule 
premier/arrière-plan

Inverser les couleurs de premier plan et d’arrière-plan d’un objet ou de son graphique. Cette 
option n’est pas disponible pour les objets listes.
Sur les terminaux monochromes, le premier et l’arrière-plan basculent entre noir et blanc. Sur les 
terminaux couleur et en niveaux de gris, les couleurs d’arrière-plan et de premier plan sont 
inversées.
Les couleurs de premier plan et d'arrière-plan des objets sont inversées indépendamment de 
celles du texte. 

• Pour basculer entre le premier et l'arrière-plan de l'objet, du texte ou du graphique, 
sélectionnez l'objet, puis cliquez sur l'outil Bascule premier/arrière-plan.

• Pour basculer uniquement le texte intérieur, cliquez sur l'outil Texte intérieur, puis sur 
l'outil Bascule premier/arrière-plan. 

• Pour basculer le graphique intérieur, cliquez sur l'outil Graphique intérieur, puis sur l'outil 
Bascule premier/arrière-plan.
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Pour appliquer les options de formatage aux objets :

1. Sélectionnez l�objet.

2. Pour un objet multi-états, sélectionnez l�état dans la zone State (Etat)  ou sélectionnez 

Etat suivant ou Etat précédent dans le menu Format.

3. Dans la barre d�outils Format, cliquez sur les outils que vous souhaitez appliquer ou sélectionnez les 
commandes correspondantes dans le menu Format. 

Suggestion : dans le cas des objets multi-états ou listes, vous pouvez modifier le motif de remplissage et 
activer le clignotement pour chaque état individuel dans l'onglet Etats de la boîte de dialogue de l'objet.
Suggestion : vous pouvez appliquer des options de formatage du texte différentes à chaque état des objets 
multi-états. 

Utilisation de la couleur
Pour les terminaux couleur et en niveaux de gris, utilisez la palette de couleurs pour sélectionner les couleurs de 
premier plan et d'arrière-plan des objets, du texte ou des graphiques. Les terminaux PanelView standards avec 
firmware 4.10 (ou ultérieur) prennent en charge 32 couleurs. La palette des niveaux de gris prend en charge 4 
couleurs (nuances de gris). La palette peut être affichée ou masquée à partir de la boîte de dialogue 
Affichage>Barres d’outils. 

Sur les terminaux couleur, par défaut l�arrière-plan est bleu et le premier plan est blanc. Sur les terminaux en 
niveaux de gris, par défaut l�arrière-plan est noir et le premier plan est blanc. 

Les couleurs de premier plan s�appliquent au texte, aux lignes, aux bordures d�objets, au curseur de liste et au 
type de remplissage. Les couleurs d�arrière-plan s�appliquent aux zones de texte et de remplissage des objets.

La case reflète les couleurs de 
premier plan et d'arrière-plan 
sélectionnées.

RAZ

Premier plan de l’objet

Arrière-plan de l’objet

ARR

Arrêté

Moyen
Haut

Bas

Premier plan du graphique

Arrière-plan du texte

Premier plan du texte

Arrière-plan de 
l’objet 

Premier plan du texte

Arrière-plan du graphique
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Application de la couleur aux objets

1. Sélectionnez l�objet.

2. Pour un objet multi-états, sélectionnez l�état dans la zone State (Etat)  ou sélectionnez 

Etat suivant ou Etat précédent dans le menu Format.

3. Pour modifier la couleur de premier plan, cliquez sur une cellule de la palette des couleurs ou sélectionnez 
une couleur dans le menu Format>Couleur de premier plan.

4. Pour modifier la couleur d�arrière-plan, cliquez sur une cellule de la palette des couleurs ou sélectionnez 
une couleur dans le menu Format>Couleur d’arrière-plan.
La couleur d�arrière-plan du texte d�un objet liste n�est pas modifiable.

Suggestion : dans le cas des objets multi-états ou listes, vous pouvez sélectionner les couleurs de premier et 
d�arrière-plan de chaque état dans l'onglet Etats de la boîte de dialogue de l'objet.

Application de la couleur au texte

1. Sélectionnez l�objet.

2. Cliquez sur l�outil Texte intérieur de la barre d�outils Etat ou sélectionnez Format>Texte 

intérieur.

3. Pour un objet multi-états, sélectionnez l�état dans la zone State (Etat)  ou sélectionnez 

Etat suivant ou Etat précédent dans le menu Format.

4. Pour modifier la couleur de premier plan, cliquez sur une cellule de la palette des couleurs ou sélectionnez 
une couleur dans le menu Format>Couleur de premier plan.

5. Pour modifier la couleur d�arrière-plan, cliquez sur une cellule de la palette des couleurs ou sélectionnez 
une couleur dans le menu Format>Couleur d’arrière-plan.

6. Désélectionnez l�objet pour quitter le mode texte intérieur.
Pour que l�arrière-plan du texte corresponde à l�arrière-plan de l�objet, sélectionnez les mêmes couleurs 
d�arrière-plan pour l�objet et le texte.

Suggestion : dans le cas des objets multi-états ou listes, vous pouvez sélectionner les couleurs de premier et 
d�arrière-plan du texte dans l'onglet Etats de la boîte de dialogue de l'objet.

MCH       MCH       
Couleurs d’arrière-plan identiques pour le 
texte et l’objet. 

Couleurs d’arrière-plan différentes 
pour le texte et l’objet. 
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Application de la couleur aux graphiques intérieurs
Des couleurs de premier plan et d'arrière-plan peuvent être définies pour les objets incluant des graphiques 
intérieurs monochromes (sans couleur). 

1. Sélectionnez l�objet.

2. Cliquez sur l�outil Graphique de la barre d�outils Etat ou sélectionnez Format>Graphique 

intérieur.

3. Pour un objet multi-états, sélectionnez l�état dans la zone State (Etat)  ou sélectionnez 

Etat suivant ou Etat précédent dans le menu Format.

4. Pour modifier la couleur de premier plan, cliquez sur une cellule de la palette des couleurs ou sélectionnez 
une couleur dans le menu Format>Couleur de premier plan.

5. Pour modifier la couleur d�arrière-plan, cliquez sur une cellule de la palette des couleurs ou sélectionnez 
une couleur dans le menu Format>Couleur d’arrière-plan.

6. Désélectionnez l�objet pour quitter le mode graphique intérieur.
Pour que l�arrière-plan de l�objet corresponde à l�arrière-plan du graphique, sélectionnez les mêmes 
couleurs d�arrière-plan pour l�objet et le graphique.

Suggestion : pour inverser les couleurs de premier et d�arrière-plan d�images bitmap monochromes, 
cliquez sur l�outil Basculer premier/arrière-plan en mode graphique intérieur.

 

Pour les images bitmaps placées sur une vue à l'aide de la commande Objets> Graphiques>Image, il suffit 
de sélectionner l'objet, puis la couleur de premier plan ou d'arrière-plan dans le menu Format ou la palette de 
couleurs.

Définition des couleurs par défaut des objets
Vous pouvez appliquer des couleurs par défaut aux objets de même type. Par exemple, vous pouvez utiliser la 
même couleur pour tous les boutons-poussoirs. Créez un bouton-poussoir, appliquez les couleurs et le 
formatage désirés puis sélectionnez Edition>Couleurs par défaut des objets. Tous les nouveaux 
boutons-poussoirs seront créés avec ces couleurs par défaut.

Les couleurs par défaut sont conservées d�une application à l�autre et d�une session PanelBuilder32 à l�autre.
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Chapitre 9

Utilisation de l’éditeur de points

Ce chapitre couvre les objets suivants :
• fiches de l'éditeur de points et boîte de dialogue Masque du point ;
• insertion ou ajout de points ;
• sélection, opérations de copier/couper, coller et suppression de points ;
• reproduction, tri, filtre, recherche et remplacement, et impression de points ;
• recherche de l'endroit où un point est utilisé dans l'application ;
• comptage et suppression des points ;
• enregistrement de points ;
• conversion de points et vérification d'erreurs dans les points ;
• importation et exportation de points ;
• utilisation d'une base de données de projets pour stocker les points.

Pour plus de détails sur l�utilisation de l�éditeur de points, ouvrez le livre Travailler avec l’éditeur de 
points dans l'onglet Sommaire de l�aide.

Qu’est-ce qu’un éditeur de points ?
L�éditeur de points est utilisé pour entrer des points dans l�application. Les points associent des objets à des 
adresses d�une table de données. Chaque point définit une adresse et des attributs de données que le terminal 
PanelView utilise pour lire ou écrire des données. Par exemple, un point de lecture est attribué à un bargraphe. 
Le terminal lit les données à l�adresse du point de lecture pour remplir le bargraphe. 
Les attributs d�un point dépendent du protocole. Les points sont enregistrés et chargés dans le terminal 
PanelView en même temps que l�application.
Pour ouvrir l’éditeur de points :

• Cliquez deux fois sur l�icône Editeur de points dans le dossier Système.

• ou cliquez sur Outils>Editeur de points
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Fiche de configuration de l’éditeur de points

L�éditeur de points utilise des fiches de configuration similaires à des feuilles de calcul Excel pour l'entrée et 
l'édition de points. L'onglet de la fiche de configuration identifie le protocole pour lequel les points sont créés. 
Certains protocoles supportant plusieurs options, tels que DeviceNet ControlNet et EtherNet/IP, disposeront 
de plusieurs onglets. Cliquez sur l'onglet approprié. L�éditeur de points possède ses propres barres de menus et 
barre d�outils qui sont activées lorsqu'il est ouvert.  

Figer les colonnes
Vous pouvez figer une ou plusieurs colonnes sur le côté gauche de la fenêtre pour les empêcher de 
défiler hors de l�écran. Cliquez sur l'en-tête d�une colonne, puis sur l�outil Figer les colonnes ou 

sélectionnez Affichage>Figer les colonnes. La colonne est mise en surbrillance. Cliquez de nouveau sur 
l�outil pour libérer la colonne. Pour figer plusieurs colonnes, maintenez la touche Ctrl enfoncée pendant que 
vous cliquez sur les en-têtes de colonnes.

Déplacer les colonnes
Pour déplacer une colonne, cliquez sur son en-tête et faites-la glisser vers son nouvel emplacement. Une ligne 
rouge apparaît aux emplacements (entre les deux colonnes) où vous pouvez placer la colonne. 

Quitter l’éditeur de points

Cliquez deux fois dans le coin supérieur gauche de la fenêtre  ou cliquez sur X dans le coin supérieur droit 
de la fenêtre. Les points ne sont pas automatiquement enregistrés lorsque vous quittez l�éditeur de points. Vous 
êtes invité à les enregistrer si vous les avez modifiés.
Si vous sélectionnez Fichier>Quitter alors que vous avez modifié les points, vous êtes invité à enregistrer les 
points et l�application. 

Faites glisser vers le 
haut ou le bas pour 
redimensionner les 
lignes

Faites glisser vers la 
gauche ou la droite 
pour redimensionner 
les colonnes

Onglet identifiant le protocole

Faites défiler les 
onglets vers la droite 
ou vers la gauche Faites défiler les colonnes vers la droite ou vers la gauche
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Autre façon d’entrer des points

Une autre façon d�entrer les points est d�entrer un seul point à la fois en utilisant la boîte de dialogue Tag Form 
(Masque du point). L�accès au masque d�édition se fait directement depuis la boîte de dialogue d�un objet. 
Cliquez sur le bouton Edit Tag (Editer le point), dans l'onglet Propriétés de la boîte de dialogue de l�objet.

Tous les points entrés dans la boîte de dialogue Tag Form (Masque du point) sont automatiquement 
ajoutés à la fiche de configuration.

Suggestion : si l�éditeur de points est ouvert au moment où vous entrez un point dans la boîte de dialogue 
Masque du point, sélectionnez Affichage>Rafraîchir pour afficher le point dans l�éditeur de points.

Les noms des points utilisés par 
l'objet doivent être entrés dans 
la boîte de dialogue de l’objet. 
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Description des champs de points

Les champs apparaissant dans la fiche de configuration et dans la boîte de dialogue Masque du point dépendent 
du protocole de communication sélectionné pour le terminal.

* La précision maximale est de 6 chiffres après la virgule. Si un signe (+ ou -) fait partie du nombre, il doit être 
placé devant (+ par défaut). Si un signe fait partie de l'exposant du nombre, il doit suivre immédiatement e ou E. 

Champ Description

Nom du point Nom unique pour le point. Ce même nom doit être entré dans la boîte de dialogue de l’objet 
utilisant ce point. Vous pouvez créer automatiquement des noms de points selon le modèle du 
contenu du champ Adresse. Cette option est activée dans l'onglet Edition de points de la boîte de 
dialogue Outils>Options.

Type de données Format de données du point. Cliquez sur la liste déroulante du champ pour voir les options 
disponibles. Le type de données doit être compatible avec le format de données sélectionné dans 
la boîte de dialogue de l'objet.

Description Description du rôle du point.

Taille de l'ensemble Taille de l'ensemble pour des données de type Ensemble de bits ou Ensemble de caractères. La taille 
d’un ensemble de bits va de 1 à 16. La taille d’un ensemble de caractères dépend du protocole.

Nom de station Nom de la station de l’automate associée au point. Le nom de station doit correspondre à celui 
entré dans la boîte de dialogue Configuration de la communication. 

Adresse Adresse du point dans la table de données du processeur. Par exemple, B3:0/1 ou N7:9 pour un 
SLC ou I:010/10 ou O:010/10 pour un PLC-5 RIO. Certains automates utilisent un point (.) au lieu 
d’une barre oblique (/) pour l’adressage de bits. Pour plus de détails sur l’adressage, consultez le 
manuel d’utilisation de l’automate. 

Vous pouvez générer des adresses séquentielles pour les données de type Bit et Nombre entier. 
Sélectionnez la colonne Adresse ou une plage de cellules, cliquez avec le bouton droit de la souris 
et sélectionnez Extrapoler. Les adresses de la colonne entière sont automatiquement mises à jour 
de manière séquentielle en prenant pour modèle la syntaxe de la première cellule. Par exemple, 
les adresses B3:0/3, B3:0/2, B3:0/9 prendront les numéros B3:0/3, B3:0/4, B3:0/5.

Valeur initiale La valeur de départ pour le point en unités procédé. Fournit une présélection pour les objets d’entrée 
numérique seulement. Les caractères valides sont 0 - 9, e, E, +, - et point (.). La précision maximale 
est de 6 chiffres après la virgule pour les valeurs autres que les valeurs à virgule flottante.

Les attributs étendus n’apparaissent que pour certains types de données  

Mise à l’échelle
Echelle :
‘m’ dans y = mx + b
Offset :
‘b’ dans y = mx + b

Valeurs à utiliser pour convertir la valeur entière courante du point processeur (x) en unités 
procédé (y)
Les caractères valides sont 0 - 9, e, E, +, - et point.*

Limites d'entrée des données
Minimum
Maximum

Valeurs minimale et maximale pouvant être affectées au point courant. Vous pouvez entrer un 
maximum de 12 caractères : 0 - 9, e, E, +, - et point.* 
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Insertion ou ajout de points

1. Cliquez sur l�outil Insérer un point  ou sélectionnez Edition>Insérer un point.

Une nouvelle ligne est ajoutée au début de la fiche de configuration. Pour insérer une ligne au-dessus 
d�une ligne spécifique, sélectionnez cette ligne puis cliquez sur l�outil Insérer un point. 

2. Cliquez deux fois dans un champ pour entrer, modifier ou sélectionner des données. 
Sur une ligne donnée, appuyez sur TAB pour vous déplacer de gauche à droite ou sur Maj+TAB pour 
vous déplacer de droite à gauche.

Conseil : les nouveaux points sont créés avec les valeurs par défaut configurées dans l'onglet Points par 
défaut de la boîte de dialogue Outils>Options. 

Sélection de points

Pour sélectionner : Action :

une seule colonne Cliquez sur l'en-tête de colonne.

des colonnes adjacentes Cliquez sur l'en-tête de la première colonne. Maintenez la touche Maj 
enfoncée et sélectionnez la dernière colonne. Ou cliquez sur l'en-tête de la 
première colonne, maintenez le bouton gauche de la souris enfoncée et 
faites-la glisser jusqu’à la dernière colonne.

des colonnes non adjacentes Cliquez sur l'en-tête de la première colonne. Maintenez la touche Ctrl 
enfoncée et cliquez sur l'en-tête des autres colonnes. 

une seule ligne Cliquez dans la colonne d’état de la ligne.

des lignes consécutives Cliquez dans la colonne d’état de la première ligne, maintenez le bouton 
gauche de la souris enfoncée et faites-la glisser jusqu’à la dernière ligne. 
Ou cliquez dans la colonne d’état de la première ligne, puis maintenez la 
touche Maj enfoncée et sélectionnez les autres lignes. 

des lignes non consécutives Cliquez dans la colonne d’état de la première ligne. Sélectionnez les autres 
lignes en maintenant la touche Maj enfoncée.

toutes les lignes et toutes les 
colonnes

Sélectionnez Edition>Sélectionner tout ou cliquez dans la zone vide située 
dans le coin supérieur gauche de la feuille de calcul.
Publication 2711-GR003C-FR-P



110          Utilisation de l’éditeur de points
Opérations de copier/couper, coller et suppression de points

Reproduction de points
Au lieu de créer de nouveaux points, vous pouvez reproduire des points ayant des attributs similaires. Les points 
peuvent être reproduits une fois ou plusieurs fois. 

Quand un point est reproduit, un suffixe (_01) est ajouté à son nom pour le distinguer du point initial. S�il est 
reproduit plusieurs fois, le suffixe à 2 chiffres est incrémenté avec chaque nouveau point. Les points reproduits 
sont placés à la suite du point sélectionné.

Suggestion : les points sont incrémentés selon les paramètres par défaut définis dans l'onglet Edition de 
points de la boîte de dialogue Outils>Options.

Pour : Sélectionnez une ligne, puis :

copier un point
cliquez sur  ou sélectionnez Edition>Copier. Les données du point ou 
la sélection sont copiées dans le presse-papiers.

couper un point 
cliquez sur  ou sélectionnez Edition>Couper. Les données de point ou 
la sélection sont placées dans le presse-papiers, sans aucune modification 
de la ligne. 

coller un point
cliquez sur  ou sélectionnez Edition>Coller. Les données du point ou 
la sélection sont remplacées par le contenu du presse-papiers.

insérer et coller un point sélectionnez Edition>Insérer et coller. Une ligne est insérée au-dessus de la 
ligne sélectionnée, avec le contenu du presse-papiers. 

supprimer un point
cliquez sur  ou sélectionnez Edition>Supprimer le point. Toutes les 
lignes sont renumérotées.

Pour reproduire un point : Sélectionnez la ligne que vous voulez reproduire, puis :

une fois
cliquez sur  ou sélectionnez Edition>Reproduire une fois.

plusieurs fois
cliquez sur  ou sélectionnez Edition>Reproduire plusieurs fois.
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Tri et filtrage de points
Vous pouvez trier les données d�une seule colonne dans un ordre croissant, alphabétiquement ou 
numériquement. Cliquez dans une cellule de la colonne à trier, puis cliquez sur l�outil Trier ou 
sélectionnez Affichage>Trier. Les données sont alors triées automatiquement.

Cliquez sur l'icône Filtrer pour visualiser des lignes de points contenant un élément de cellule commun. 
Vous pouvez, par exemple, choisir de n�afficher que les points utilisant des données de type Bit. Cliquez 
dans la cellule contenant les données que vous souhaitez filtrer, puis cliquez sur l�outil Filtrer. Seules 
sont visibles les lignes contenant l�élément sélectionné. Cliquez de nouveau sur l'outil pour visualiser tous 
les points. 

Recherche et remplacement de points
Vous pouvez rechercher un texte ou une valeur dans une colonne spécifique. Cliquez n�importe où dans 
la colonne puis cliquez sur l�outil Rechercher ou sélectionnez Edition>Rechercher. Dans la boîte 
de dialogue qui s�ouvre, saisissez les caractères à rechercher et le sens de la recherche (vers le haut ou vers 
le bas). Vous avez l�option de prendre en compte ou d�ignorer la casse des caractères. 

Pour rechercher et remplacer une occurrence ou toutes les occurrences d'un texte dans une colonne, cliquez sur 
l�en-tête de la colonne et sélectionnez Edition>Remplacer. 

Impression de points
Il est facile d�imprimer tous les points de la fiche de configuration active : il suffit de cliquer sur l�outil 
Imprimer ou de sélectionner Fichier>Imprimer. Il vous faudra peut-être modifier l�ordre ou la 
largeur des colonnes avant d�imprimer. Les points imprimés utilisent le format défini dans la boîte de 

dialogue Fichier>Configuration de l'impression.

Une autre façon d�imprimer les points est de les inclure dans le rapport d�application. Dans l'onglet 
Configuration des rapports de la boîte de dialogue Outils>Options, cochez la case Attributs des 
points. Pour imprimer le rapport avec les points, sélectionnez Rapports dans le menu Fichier.
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Recherche de l'endroit où un point est utilisé 
Vous pouvez rechercher toutes les occurrences d'un seul point dans l'application en cours. Cette recherche inclut 
les points utilisés par les objets des vues ainsi que par les objets qui n'apparaissent à l'écran, tels que les variables 
incorporées ou les objets d'impression. 
Sélectionnez la ligne du point à rechercher, puis cliquez avec le bouton droit de la souris et sélectionnez Utilisé 
par dans le menu contextuel. Une boîte dialogue s'ouvre et affiche toutes les occurrences du point sélectionné 
dans l'application. Pour chaque occurrence (ou ligne), les champs suivants s'affichent : 

• nom du point ;
• nom de la vue (dans laquelle le point est utilisé) ;
• numéro d�identité (ID) de l�objet (utilisant le point) ;
• type d�objet (type de l'objet utilisant le point) ;
• détails (fournit des informations sur un point utilisé par des variables incorporées ou des objets 

d'impression quand ces objets n'apparaissent pas dans une vue).
Vous pouvez naviguer vers une vue utilisant le point en sélectionnant une ligne de point, puis en cliquant sur le 
bouton Aller à. La vue est ouverte et l'objet utilisant le point est sélectionné. Le bouton Aller à n'est 
disponible que pour les objets qui apparaissent dans une vue.

La boîte de dialogue Recherche de points s'ouvre en mode épinglé ce qui vous permet d'exécuter d'autres 
opérations sans la fermer. Si la boîte de dialogue n'est pas épinglée, elle se ferme dès que vous cliquez à 
l'extérieur.

Cliquez avec le 
bouton droit de la 
souris sur la ligne du 
point et 
sélectionnez Utilisé 
par dans le menu 
contextuel.
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Vous pouvez aussi rechercher des points dans PanelBuilder32 (sans ouvrir l'éditeur de points) : 
• Cliquez avec le bouton droit de la souris sur un objet de vue, puis sélectionnez un point dans le 

sous-menu Recherche de points. Ce menu affiche la liste de tous les points susceptibles d'être définis 
pour l'objet sélectionné. Les points définis pour l'objet apparaissent dans le menu avec un nom de point. 
Les points non définis s'affichent en grisé et sont indisponibles pour la recherche. Lorsque vous 
sélectionnez un point, la boîte de dialogue Recherche de points s'ouvre. 

.

• Sélectionnez Edition>Recherche de points. A l'ouverture de la boîte de dialogue Recherche de 
points, sélectionnez un point dans la liste Nom du point, puis cliquez sur le bouton Rechercher. La 
boîte de dialogue mise à jour affiche toutes les occurrences du point. 

L'objet d’entrée numérique a un seul point 
d'écriture défini, appelée 
Set_Max_Motor_Speed (Vitesse_maxi_moteur).
Lorsque vous sélectionnez ce point, la boîte de 
dialogue Recherche de points s'ouvre. 

La boîte 
de 
dialogue 
est 
épinglée.

Cliquez sur Rafraîchir pour mettre à jour 
la liste des noms de points avec les 
nouveaux points ajoutés à l'application 
alors que la boîte de dialogue Recherche 
de points est ouverte. 
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Comptage et suppression de points
Il est recommandé de rechercher les points inutilisés dans l'application et de les vider. Cette suppression des 
points inutilisés réduit la taille de l'application. Sélectionnez Outils>Comptage de points Une boîte de 
dialogue s'ouvre. Elle affiche la liste de tous les points définis dans l'application et le nombre d'utilisations de 
chaque point. Les points non utilisés par l'application ont un nombre d'utilisations de 0. Les points utilisés 
par des objets affichent un Nombre d'utilisations supérieur à 0.
Vous pouvez vider les points inutilisés, mais pas les autres. Vous pouvez vider un seul point ou une plage de 
points. Pour vider tous les points inutilisés, triez le champ Nombre d'utilisations afin de regrouper tous les points 
inutilisés (Nombre d'utilisations de 0). Sélectionnez tous les points inutilisés en cliquant sur la première ligne, 
puis en maintenant la touche Maj enfoncée, cliquez sur la dernière ligne de la plage. Cliquez sur le bouton Vider. 
Les points inutilisés sont supprimés de l'application de façon permanente.

Conversion de points
Lorsque vous convertissez une application pour l'exécution sur un terminal différent, vous devez également 
convertir les points pour qu'ils utilisent des champs de données adaptés au nouveau protocole. Cette conversion 
se produit automatiquement si vous cochez la case Conversion de la zone Options automatiques dans 
l'onglet Edition de points de la boîte de dialogue Outils>Options. 
Une fiche de configuration est créée pour le protocole sélectionné. Elle est munie d'un onglet portant le nom du 
protocole. Les données de points de l'ancienne fiche de configuration sont importées dans la nouvelle fiche. 
Aucune des données n'est modifiée. Vous devez actualiser, comme il convient, les données de chaque champ. 
Pour convertir les points manuellement, cliquez dans la fiche de configuration avec le bouton droit de la souris et 
sélectionnez un protocole dans le sous-menu Convertir en. L�onglet Communs contient les points des 
protocoles DF1, DH485, DH +, RIO ou ControlNet non prioritaire. Ces protocoles se présentent comme une 
seule option de menu parce qu�ils utilisent des champs de données communs. 

Enregistrement de points
Les points ne sont pas enregistrés automatiquement. Il faut cliquer sur l'outil Enregistrer ou 
sélectionner Fichier>Enregistrer le projet. Les points sont vérifiés puis enregistrés dans la base de 

données de points ou dans le projet associé à l'application. La vérification d�erreurs recherche uniquement les 
données manquantes. Elle ne valide pas le contenu d�un champ, comme la syntaxe d�adressage par exemple. 
Consultez la section suivante pour plus d'informations sur la correction des erreurs.
Il ne suffit pas d'enregistrer les points dans l'éditeur de points ; il faut également les enregistrer 
(Fichier>Enregistrer) sous PanelBuilder32 pour pouvoir les utiliser dans l'application (à moins d'utiliser un 
projet).

Vous pouvez enregistrer ces points provisoirement dans un fichier de brouillon (.tdf) pour les utiliser 
plus tard. Pour ce faire, sélectionnez Fichier> Enregistrer comme brouillon. Ces points ne 

seront pas utilisables par l'application tant qu'ils n'auront pas été enregistrés sans erreurs. Remarquez que les 
fichiers .tdf ne sont utilisés que par PanelBuilder32 et ne sont pas disponibles pour d'autres programmes. Pour 
ouvrir les fichiers .tdf, sélectionnez Fichier>Ouvrir le brouillon. Supprimez tous les points de la fiche de 
configuration active avant d'ouvrir un fichier de brouillon sous peine de vous retrouver avec des points en 
double. 
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Vérification des points
Lorsque vous enregistrez des points, le programme les vérifie automatiquement pour détecter les 
informations manquantes. S'il n'y a pas d'erreurs ou de mises en garde, le message suivant s'affiche : 
Vérification terminée - Pas d'erreurs.

Si des erreurs ou mises en garde sont détectées, la fiche Erreurs est activée. Il s'agit d'une fiche en lecture seule 
qui vous aide à corriger les erreurs. La correction des erreurs est obligatoire, celle des mises en garde facultative. 
Lorsque les erreurs sont corrigées, la fiche se ferme.
 

La fiche Erreurs affiche les erreurs, mises en garde et messages d'information. Chaque ligne comporte les 
champs suivants :

• type d'information (Erreur, Mise en garde, Information) ;
• numéro de la ligne contenant l'erreur ;
• message relatif à l'erreur ou à la mise en garde.

L'exemple ci-dessous présente les erreurs des lignes 4 et 6. Le nom de station manque dans la ligne 4 et le champ 
Tag Name (Nom du point) est vide dans la ligne 6.

IMPORTANT
La vérification d�erreurs recherche uniquement les données manquantes. Elle ne valide pas le contenu 
d�un champ, comme la syntaxe d�adressage par exemple.
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Impression des erreurs de points

Pour imprimer toutes les erreurs de la fiche d'erreurs :

1. Cliquez sur l'onglet Erreurs pour activer la fiche.
2. Cliquez sur l'outil Imprimer ou sélectionnez Fichier>Imprimer.

La fiche s'imprime selon les paramètres définis dans la boîte de dialogue Fichier>Configuration de 
l'impression.

Correction des erreurs et des mises en garde

Lorsque la fiche Erreurs est active, le sous-menu Affichage>Erreurs et les icônes ci-dessous deviennent 
disponibles. 

Pour corriger les erreurs :

1. Cliquez deux fois sur une ligne de la fenêtre Erreurs pour sélectionner l�erreur à corriger. Ou cliquez 
deux fois sur les icônes ci-dessus pour naviguer d'une erreur à l'autre.
Vous êtes directement amené au point contenant l�erreur. Ce point porte un code de couleur 
correspondant au type d�erreur (les erreurs sont rouges, les mises en garde jaunes et les messages 
d�information verts).

2. Cliquez dans la cellule appropriée pour corriger l�erreur.
3. Répétez ces étapes jusqu'à ce que toutes les erreurs soient corrigées.

Pour : Action :

activer l'onglet Erreurs
Cliquez sur , sélectionnez Affichage>Erreurs>Fenêtre ou 
cliquez sur l'onglet Erreurs.

localiser la première erreur
Cliquez sur  ou sélectionnez Affichage>Erreurs>Première.

localiser l'erreur suivante
Cliquez sur  ou sélectionnez Affichage>Erreurs>Suivante.

localiser la dernière erreur
Cliquez sur  ou sélectionnez Affichage>Erreurs>Dernière.
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Importation et exportation de points
Vous pouvez importer et exporter des points dans l�éditeur de points depuis et vers les formats de fichier 
suivants :

• Formats APS ou 6200 d'Allen-Bradley (*.txt)
• Format AI de RSI (*.eas)
• Format ASCII de RS-Logix-5 (*.eas) ou format CSV (*.csv)
• Format ASCII de RS-Logix-500 (*.eas) ou format CSV (*.csv) 
• Format ASCII de RS-Logix 5000 (*.eas) ou format CSV (*.csv)
• Format CSV de PanelBuilder32 (*.csv)
• Format Selected Tags de PanelBuilder32 (*.tag)

Tous les formats de fichier n'importent/exportent que le nom et l'adresse du point et les champs de description, 
à l'exception du format Selected Tags de PanelBuilder32. Le format Selected Tags de PanelBuilder32 (*.tag) 
importe/exporte tous les champs de données des points.

Pour plus de détails sur ces formats, reportez-vous à la documentation de l�automate. 

Importer des points

Pour importer des points à partir d'un format de fichier pris en charge, sélectionnez Fichier>Importer des 
points. 

Entrez le nom du fichier à importer.

Sélectionnez un fichier dont le format 
correspond au nom du fichier.

Tapez ou sélectionnez le nom à entrer dans le 
champ Node name (Nom de station) de l'éditeur 
de points pour les points importés. 

Cliquez pour lancer l’importation

Si l'application utilise un projet partagé, 
sélectionnez le nom de protocole de la fiche 
vers laquelle les points seront importés.
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Les points sont importés dans l'éditeur de points suivant l'ordre des colonnes défini dans la première ligne du 
fichier d'importation. Si vous modifiez l�ordre des colonnes dans l�éditeur de points avant d'importer les points, 
les colonnes ne seront pas importées correctement. Si des noms de points en double sont détectés pendant 
l�importation, ces points ne sont pas importés à partir du fichier source.

A la fin de l�importation, une boîte de dialogue indique le nombre de lignes et de points traités et affiche les 
erreurs et les mises en garde. Cette boîte de dialogue récapitule les points importés et peut être imprimée dans un 
fichier.

En cas de conflit lors de l'importation des points (tels que des noms de points en double), la boîte de dialogue 
Conflit de points s'ouvre pour vous demander comment gérer le conflit. Vous avez l'option d'utiliser les 
points du fichier d'importation ou ceux de l'éditeur de points.
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Importer des points au format Selected Tags de PanelBuilder32 (*.tag) 

Les points sont généralement importés selon l'ordre spécifié dans la première ligne du fichier source. Le tableau 
suivant indique l�ordre par défaut des colonnes (1 à 12) dans l�éditeur de points.

Les mots clés suivants sont insérés dans la première ligne du fichier source pour indiquer l'ordre de colonne par 
défaut.

Name,TagType,ArrayLength,Description,Node,Address,Initial,UpdateFreq,Scale,Offset,Min,Max

Motor_Start,Bit,0,Starts motor,LC_1,B3:0/0,0,1,1,0,0,0

Motor_Stop,Bit,0,Stops motor,LC_1,B3:0/1,0,1,1,0,0,0

Motor_Speed,UnsignedInteger,0,Controls motor speed,LC_1,N7:1,0,1,1,0,0,65535

Motor_Speed_Ind,UnsignedInteger,0,Indicates motor speed,LC_1,N7:2,0,1,1,0,0,65535

Chaque ligne de données de point du fichier source est importée dans l�éditeur de points selon l�ordre des 
mots-clés spécifié sur la première ligne. 

Colonne DonnŽes Colonne DonnŽes

1 Nom du point 7 Valeur initiale

2 Type de donnŽes 8 FrŽquence de mise ˆ jour

3 Taille de l'ensemble 9 Echelle

4 Description 10 Offset

5 Nom de station 11 Minimum

6 Adresse 12 Maximum
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Exporter des points

Pour exporter des points de l'éditeur de points vers l'un des formats de fichier pris en charge, sélectionnez 
Fichier>Exporter des points. La boîte de dialogue qui s�ouvre est similaire à la boîte de dialogue 
d'importation.

Lorsque vous cliquez sur Enregistrer, les points sont exportés vers le fichier dans l�ordre et le format prévus 
par le format du fichier. A la fin de l�exportation, une boîte de dialogue indique le nombre de lignes et de points 
traités et affiche les erreurs et les mises en garde, le cas échéant. Cette boîte de dialogue récapitule les points 
exportés et permet d�enregistrer les détails dans un fichier.

Seuls sont exportés les points de la fiche de configuration active. Si votre application stocke les points dans un 
projet, l'éditeur de points peut contenir plusieurs fiches de configuration. Pour exporter les données de toutes les 
fiches, cochez la case Exporter toutes les fiches dans l'onglet Edition de points de la boîte de dialogue 
Outils>Options. La boîte de dialogue Exporter s'ouvre automatiquement pour chaque fiche de configuration 
pour vous permettre d'entrer les informations de fichier nécessaires. 

Acceptez le nom par défaut (correspondant au 
nom de l'onglet de la fiche de configuration) ou 
entrez un autre nom de fichier.

Sélectionnez un format de fichier. Il doit avoir un type 
de fichier correspondant au nom du fichier entré.

Tapez ou sélectionnez un nom de station à 
associer à chaque point exporté. 

Cliquez pour exporter les points vers le fichier. 
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Exporter des points au format Selected Tags de PanelBuilder32 (*.tag) 

Le format Selected Tags de PanelBuilder32 (*.tag) est le seul format qui exporte tous les champs de 
données de l'éditeur de points. 
Les points sont exportés avec l'ordre de colonnes suivant : 

Les mots-clés suivants sont insérés dans la première ligne du fichier d'exportation.
Name,Address,TagType,Description,ArrayLength,Node,Initial,UpdateFreq,Scale,Offset,Min,Max 

Le fichier d'exportation a l'aspect suivant :
Motor_Start,Bit,0,Starts motor,LC_1,B3:0/0,0,1,1,0,0,0

Motor_Stop,Bit,0,Stops motor,LC_1,B3:0/1,0,1,1,0,0,0

Motor_Speed,UnsignedInteger,0,Controls motor speed,LC_1,N7:1,0,1,1,0,0,65535

Motor_Speed_Ind,UnsignedInteger,0,Indicates motor speed,LC_1,N7:2,0,1,1,0,0,65535

Remarque : d'autres champs de données de points sont exportés pour DeviceNet.

Colonne Données Colonne Données

1 Nom du point 7 Valeur initiale

2 Type de données 8 Fréquence de mise à jour

3 Taille de l'ensemble 9 Echelle

4 Description 10 Offset

5 Nom de station 11 Minimum

6 Adresse 12 Maximum
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Utilisation de projets pour le partage de points
Chaque application possède des points enregistrés avec l�application. En d�autres termes, ces informations sont 
privées et utilisées seulement par l�application dans laquelle elles ont été définies. 

Sont également enregistrées avec l�application des informations sur les équipements utilisant les points :
• le nom de station de l�automate ;
• le nom du terminal ;
• les paramètres de communication réseau pour chaque équipement.

La création d�un projet distinct permet d�enregistrer les points de l�application et les informations de 
l�équipement sur le disque dur dans un fichier de base de données. Les points de ce fichier peuvent alors aussi 
être utilisés par d�autres applications PanelBuilder32. La base de données du projet est stockée sur le disque dur 
dans un dossier distinct de celui de l�application. L�emplacement par défaut pour les projets est \PB32\Projects 
ou l�emplacement spécifié pendant l�installation.

Suggestion : pour modifier l�emplacement de stockage des projets, sélectionnez l�onglet Enregistrer dans la 
boîte de dialogue Outils>Options.

Pour activer l�utilisation des projets, cliquez sur l�onglet Projets de la boîte de dialogue 
Configuration de l’application. Attribuez un nom au projet. Un fichier portant le 
nom du projet est créé dans le répertoire \PB32\Projects. Le dossier Projet est 
également créé dans la fenêtre d'application avec le nom du projet entre parenthèses. 
L'éditeur de points de ce dossier est utilisé par l�application mais peut également servir à 
d�autres applications.

Pour créer ou modifier les points de l�application stockés dans un projet, vous pouvez ouvrir l'éditeur de points 
depuis le dossier Projet ou sélectionner Outils>Editeur de points.  

Pour créer, copier, supprimer ou renommer des projets, ouvrez la boîte de dialogue Outils>Gestionnaire de 
projets. Cette commande n�est activée que lorsque aucune application n�est ouverte dans PanelBuilder32. Pour 
copier, supprimer ou renommer des équipements utilisés par une application ou un projet, ouvrez la boîte de dialogue 
Outils>Gestionnaire d'équipements.

IMPORTANT Vous ne pouvez pas activer ou désactiver l'utilisation d'un projet tant que l'éditeur de points 
est ouvert. 
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Créer des fiches de configuration de projets

D'autres fiches de configuration apparaissent dans l'éditeur de points lorsque l�application est activée pour 
utiliser une base de données de projets distincte pour les points partagés. Ces fiches sont les suivantes :

• Tous les points : cette fiche de configuration contient les points du projet qui possèdent des champs 
communs à tous les protocoles. Elle est en lecture seule et ne peut pas être modifiée. Elle vous permet de 
rechercher, copier, trier et filtrer les données des points.

Vous pouvez créer des fiches de configuration distinctes pour entrer des points et les grouper par protocole. 
Pour créer une fiche de configuration, sélectionnez une option de protocole dans le sous-menu Edition>Créer 
des points. Les fiches de configuration disponibles sont : 

• Communs : affiche les points des messages DH-485, DH+, DF1, RIO ou ControlNet non prioritaires. 
Ces protocoles sont groupés sur une seule fiche de configuration parce qu�ils utilisent des champs de 
données communs.

• ControlNet Prioritaire
• DeviceNet (E/S esclaves, Client explicite, Serveur explicite ou Ecoute seule)
• EtherNet/IP (Adresse de l'automate, CIP, Objet groupe)
• Modbus
• Profibus

Chaque fiche est identifiée par un nom de protocole. Pour passer d'une fiche de configuration à l'autre, cliquez 
sur l�onglet approprié.
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Chapitre 10

Configuration de l'application

Ce chapitre explique comment :
• configurer la communication pour le terminal et l�automate ;
• définir les options par défaut à la mise sous tension du terminal ;
• modifier le format d�heure ou de date utilisé par le terminal ;
• configurer le port RS-232 du terminal pour l�impression ;
• convertir une application pour l'exécuter sur un terminal différent ;
• définir les points de commande utilisés par l�automate pour modifier la vue courante, l�heure ou la date ;
• définir les points d�état utilisés par l�automate pour lire la vue, l�heure ou la date courantes ;
• activer un fichier de polices externes pour la saisie de texte dans une autre langue ;
• modifier la configuration évoluée du terminal et de l�écran ;
• activer ou désactiver l'utilisation d'un projet associé à une application ;
• définir la protection des vues et du terminal.

Pour plus de détails sur le terminal et la configuration de l�application, ouvrez le livre Configuration du 
terminal dans l'onglet Sommaire de l�aide.

Configuration de la communication
Le terminal PanelView communique avec les automates et les équipements décentralisés sur différents réseaux, 
tels que DH-485, DH+, RIO, DF1, DeviceNet, ControlNet, EtherNet/IP, Modbus et autres protocoles.

Chaque terminal prend en charge un protocole de communication spécifique sélectionné au moment de la 
création de l�application. Avant de charger une application, il faut configurer le terminal et l�automate pour 
permettre la communication.

Pour plus d�informations sur les différents protocoles, ouvrez le livre Communication dans l'onglet 
Sommaire de l�aide.
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Pour configurer la communication :

• cliquez deux fois sur l�icône Configuration de la communication dans le dossier Application 
Settings (Configuration de l’application) de la fenêtre d�application ou

• sélectionnez Application>Configuration puis cliquez sur le bouton Config. Com.

La boîte de dialogue qui s�ouvre affiche les paramètres spécifiques au protocole de communication du terminal. 
Dans la plupart des cas, vous aurez à configurer les paramètres de réseau pour le terminal et l�automate. Pour 
avoir des informations sur une boîte de dialogue spécifique, cliquez sur le bouton Aide ou appuyez sur F1 pour 
obtenir de l�aide sur un champ spécifique.

Les informations d�automate (nom de station, adresse de station, type de station) sont généralement entrées de 
la même façon pour la plupart des protocoles. Sous Network Nodes (Stations du réseau), cliquez dans 
n�importe quel champ avec le bouton droit de la souris et sélectionnez Insérer une station dans le menu 
contextuel. Cliquez dans un champ pour entrer des données ou sélectionner une option. Un astérisque (*) 
apparaît à gauche de la ligne en cours d�édition. 

IMPORTANT Le nom de station entré pour l�automate sous Stations du réseau doit correspondre à celui 
entré dans la boîte de dialogue Masque du point ou dans l�éditeur de points.
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Définition des options à la mise sous tension
L'onglet Mise sous tension de la boîte de dialogue Configuration de 
l’application définit les paramètres par défaut à la mise sous tension du terminal 
PanelView. Pour modifier ces paramètres :
•  cliquez deux fois sur l�icône Power-Up (Mise sous tension) dans le dossier 
Application Settings (Configuration de l’application) ou
•  sélectionnez Application>Configuration puis cliquez sur le bouton Mise sous 
tension.

Vue de démarrage (obligatoire)
Spécifie la vue qui doit s�afficher en premier lorsque l�application est exécutée sur le terminal.
Ecriture dans l'automate au démarrage
Cochez cette case pour écrire dans l�automate les présélections des objets à la mise sous tension. Vous pouvez 
choisir l�une des deux options suivantes :

• Présélections du terminal : valeurs initiales fixées par l�application
• Etats précédents du terminal : valeurs présentes avant la mise sous tension

Les terminaux RIO, les terminaux DeviceNet utilisant des points d'entrée et de sortie Serveur explicite, les 
terminaux ControlNet utilisant des points prioritaires et les terminaux EtherNet/IP utilisant des points Objet 
groupe écrivent toujours des valeurs prédéfinies vers l'automate. Vous pouvez cocher/décocher cette case pour les 
terminaux DeviceNet utilisant des points Client explicite et pour les terminaux ControlNet utilisant des points de 
messages non prioritaires. 
Les présélections des objets sont entrées dans la boîte de dialogue de l�objet. Ces valeurs remplacent les valeurs 
initiales entrées dans l�éditeur de points sauf pour les objets d�entrée numérique.
Afficher dernière vue utilisateur au redémarrage
Spécifie la vue à afficher à la réinitialisation du terminal : la dernière vue affichée ou la vue de démarrage. Par 
défaut, c�est la vue de démarrage qui est affichée.
Carte mémoire
Spécifie l'action à entreprendre par le terminal si une carte mémoire est chargée. 

• Toujours charger depuis la carte : charge l�application de la carte si elle est différente de celle qui est 
chargée dans le terminal. C�est l�option par défaut.

• Ne jamais charger depuis la carte : ne charge pas l�application de la carte si cette option est choisie. 
L�opérateur doit alors charger une application spécifique.

• Si application invalide détectée, charger depuis la carte : charge l�application de la carte seulement si 
l�application courante est incorrecte.

Si aucune carte mémoire n'est chargée ou si la carte contient plus d'une application, le terminal redémarre avec 
l'application exécutée avant le redémarrage.
Utiliser les paramètres de configuration chargés
Spécifie s'il faut ou non utiliser les paramètres de configuration chargés avec l'application au redémarrage du 
terminal. C�est l�option par défaut. 
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Modification du format de la date et de l’heure
Vous pouvez modifier la façon dont l�heure et la date sont affichées sur le terminal 
PanelView. Ces modifications affecteront tous les objets contenant une variable d�heure 
ou de date. 

L�heure peut s�afficher en format 12 ou 24 heures, avec ou sans zéros et avec ou sans 
secondes. Vous pouvez également ajouter ou modifier les suffixes. Pour les dates, vous 
pouvez changer l�ordre des mois, jour et année et spécifier si l�année doit apparaître avec 
2 ou 4 chiffres.

Pour modifier les paramètres d'heure et de date :

• cliquez deux fois sur l�icône Time / Date (Heure / date) dans le dossier Application Settings 
(Configuration de l’application) ou

• sélectionnez Application>Configuration puis cliquez sur le bouton Heure/Date.

Le format d�heure et de date est chargé dans le terminal avec l�application si la case Utiliser les paramètres 
de configuration chargés est cochée dans l'onglet Mise sous tension.

Formats de date
Mois/Jour/Année

7/3/02

Jour/Mois/Année
3/7/02

Année/Mois/Jour
02/7/3

avec zéros
07/03/02

avec quatre chiffres
3/7/2002

séparateur différent
7*3*02

Formats d'heure
sur 12 heures

2:56

sur 24 heures
14:56

avec secondes
14:56:29

avec suffixes
2:56 AM ou 23:50 CST

avec zéros
03:56

séparateur différent
14*56*29
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Configuration du port imprimante
L'onglet Printer (Imprimante) de la boîte de dialogue Application Settings 
(Configuration de l’application) permet de configurer le port RS-232 du 
terminal PanelView pour l�impression. Y sont configurés :
•  les paramètres du port imprimante ;
•  les paramètres de l�imprimante.

Pour modifier ces paramètres :

• cliquez deux fois sur l�icône Imprimante dans le dossier Configuration de l’application ou
• sélectionnez Application>Configuration, puis cliquez sur le bouton Imprimante.

Voici les paramètres par défaut du port. Ils doivent correspondre à ceux de votre imprimante. 

L�échange n�est activé qu�après la réinitialisation du terminal.

La configuration par défaut de l�imprimante est :

Les paramètres de configuration de l�imprimante sont chargés dans le terminal avec l�application si la case Utiliser les 
paramètres de configuration chargés est cochée dans l'onglet Mise sous tension.

Vitesse (bauds) 9600

Bits de données 8

Bits d'arrêt 1

Parité Aucun

Echange Aucun

Marge gauche 0

Largeur de page 80

Valeur de saut des perforations 6

Caractère de fin de ligne RC

Longueur de page 66

Commande Nouvelle page Saut de page

Chaîne d’initialisation de 
l’imprimante

-

Publication 2711-GR003C-FR-P



130          Configuration de l'application
Conversion d’une application pour un type de terminal différent
Une application peut être convertie pour être exécutée sur un autre terminal. Il faut 
cependant en modifier les propriétés pour la rendre compatible avec le terminal.
Pour convertir une application en vue de l'exécuter sur un autre 
terminal :

•  cliquez deux fois sur l�icône Terminal Setup (Configuration du terminal) 
dans le dossier Application Settings (Configuration de l’application) ou
•  sélectionnez Application>Configuration puis cliquez sur l�onglet 
Configuration du terminal.

Sélectionnez le terminal pour lequel vous souhaitez convertir l�application. Lorsque vous cliquez sur OK 
l�application est validée. Les erreurs et mises en garde s'affichent dans la fenêtre de résultats. 

Pour convertir une application : Action :

D’un terminal à écran tactile à un terminal à 
clavier

Affectez des touches de fonction aux objets de contrôle.

D’une taille de terminal à une autre Déplacez/redimensionnez des objets ou ajustez l'espacement du 
quadrillage. Vous pouvez avoir besoin de réduire le nombre d'objets placés 
sur la vue. Le texte est converti à la taille la plus proche.

D’un protocole à un autre Mettez à jour les paramètres de communication du terminal et de 
l’automate. Mettez à jour les points (adresse et nom de station) si 
nécessaire.

De monochrome à couleur ou niveaux de gris Une boîte de dialogue s’ouvre ; sélectionnez une couleur d’arrière-plan pour 
la vue et les couleurs par défaut pour le premier plan et l’arrière-plan des 
objets. Le texte est converti à la taille la plus proche.

De couleurs à niveaux de gris L'arrière-plan de la vue est converti en noir ; les couleurs sont converties au 
ton de gris le plus proche ; les images bitmap couleur sont converties en 
niveaux de gris. Le texte est converti à la taille la plus proche.

De couleurs à monochrome L’arrière-plan de la vue est converti en blanc, les objets sont convertis en 
blanc ou en noir, les images bitmap couleur sont converties en 
monochrome. Le texte est converti à la taille la plus proche.

D’un terminal avec capacité d’impression à un 
terminal sans capacité d'impression

L’attribut Imprimer est retiré des objets appropriés. Un message d’erreur 
est généré pour les objets d’impression seule utilisés par l’application. Le 
message indique l’objet spécifique.

D’un terminal avec capacité d’alarmes à un 
terminal sans capacité d'alarmes

Un message d’erreur est généré pour indiquer que le terminal cible ne 
prend pas les alarmes en charge. Retirez les alarmes de l’application.
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Définition des points de commande utilisés par l’automate
Les points de commande sont utilisés par l�automate pour modifier la vue courante ou 
la date et l�heure affichées sur le terminal. Un changement de vue par l�automate annule 
la sélection de vue courante de l�opérateur. L�heure et la date sont mises à jour toutes les 
minutes.

Pour définir des points de commande :

• cliquez deux fois sur l�icône Control Tags (Points de commande) dans le dossier Application 
Settings (Configuration de l’application) ou

• sélectionnez Application>Configuration puis cliquez sur l'onglet Points de commande.

Après avoir entré un nom de point, entrez des attributs en cliquant sur le bouton Editer le point de la boîte de 
dialogue. Le point doit être un nombre entier non signé.

Points de commande Description

Numéro de vue Nom de l’adresse de point utilisée par l’automate pour écrire le numéro de la nouvelle vue à 
afficher. Pour les changements de vues contrôlés par l’opérateur, l’adresse de point du Numéro de 
vue doit être 0.

Date Nom des adresses de points utilisées par le terminal pour lire l’année, le mois et le jour courants 
pour afficher la date. La valeur du point de l’année doit avoir 2 chiffres (90-99 pour 1990-1999 ou 
00-89 pour 2000-2089).

En vue de maintenir la conformité pour le passage à l’an 2000, la logique à relais doit effectuer 
les conversions suivantes avant d’envoyer la valeur au terminal :

• Si l’année est ≤1999, la logique à relais doit soustraire 1900
• Si l’année est >1999, la logique à relais doit soustraire 2000

Heure Nom des adresses de points utilisées par le terminal pour écrire l’heure, les minutes et les 
secondes courantes en vue d'afficher l’heure.
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Définition des points d’état utilisés par l’automate
Les points d�état sont utilisés par l�automate pour lire le numéro de la vue courante, 
l�heure ou la date.

L�heure et la date sont mises à jour chaque minute. Vous pouvez définir un intervalle de 
mise à jour de l'heure/date compris entre 1 et 60 minutes. L�augmentation de l�intervalle 
réduit le trafic du réseau mais réduit également la précision de l�heure.

Pour définir des points d’état :

• cliquez deux fois sur l�icône Status Tags (Points d’état) dans le dossier Application Settings 
(Configuration de l’application) ou

• sélectionnez Application>Configuration puis cliquez sur l�onglet Points d’état.

Après avoir entré un nom de point, entrez des attributs en cliquant sur le bouton Editer le point de la boîte de 
dialogue. Le point doit être un nombre entier non signé.

Point d’état Description

Numéro de vue Nom de l’adresse de point où le terminal écrit le numéro de la vue courante. 
L’automate peut lire ce numéro de vue.

Date Nom de l’adresse de point où le terminal écrit l’année, le mois et le jour courants. La 
valeur du point de l’année doit avoir 2 chiffres (90-99 pour 1990-1999 ou 00-89 pour 
2000-2089).

La logique à relais doit effectuer les conversions suivantes avant d’envoyer la valeur à 
l’automate :

• ajouter 1900 à l’année sur 2 chiffres (90-99)
• ajouter 2000 à l’année sur 2 chiffres (00-89)

Heure Nom des adresses de points utilisées par l’automate pour écrire l’heure, les minutes et 
les secondes courantes en vue d'afficher l’heure.
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Activation des polices externes
Vous pouvez saisir le texte de l'application dans une autre langue (ou jeu de caractères) 
au moyen d�un fichier de polices (*.OTF) spécifique à la langue. Le fichier de polices est 
créé avec l�utilitaire FontTool, hors de PanelBuilder32. Vous devez activer le fichier de 
polices dans PanelBuilder32 avant de pouvoir utiliser le jeu de caractères qui lui est 
propre. 

Pour activer un fichier de polices :

• cliquez deux fois sur l�icône External Fonts (Polices externes) dans le dossier Application 
Settings (Configuration de l’application) ou

• sélectionnez Application>Configuration, puis cliquez sur l�onglet Polices externes.

Cochez la case Polices externes validées puis sélectionnez le fichier que vous souhaitez utiliser dans 
Fichier de polices. 

Depuis l'onglet Polices externes, vous pouvez également traduire le texte du pavé numérique de sorte qu�il 
apparaisse dans la langue correcte sur le terminal PanelView. Cochez la case Utiliser le texte personnalisé 
pour traduire (ou modifier) le texte du pavé numérique.

Les tailles de texte du jeu de caractères du fichier de polices apparaissent entre parenthèses au bas des menus de 
taille de texte. Cela vous permet de distinguer clairement les tailles de texte du fichier de polices par rapport aux 
tailles de texte par défaut de PanelBuilder32. 

Reportez-vous au chapitre 6 pour plus de détails sur la saisie de texte dans d'autres langues.
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Définition des options évoluées du terminal
L'onglet Evoluée de la boîte de dialogue Configuration de l’application définit les valeurs par défaut de 
paramètres spécifiques aux terminaux PanelView. Il n�est pas nécessaire d�accéder à cet onglet à moins de vouloir 
:

• modifier les paramètres de répétition automatique pour les cellules tactiles ou les touches de fonctions
• (utilisés seulement par les touches fléchées haut/bas pour déplacer le curseur dans les listes)
• régler l�intensité de l�affichage (intensité de l�écran, vidéo inverse)
• activer le mode de mise en veille
• sélectionner une langue autre que le français pour les messages du terminal

Si le support multilingue est activé pour l'application, ce paramètre doit être défini sur la langue active de 
l'application avant le téléchargement. 

• modifier le timeout d�échange utilisé par les objets avec point d�échange 
• modifier le planning de maintenance pour la régénération de l�écran d�un terminal PanelView 900 

monochrome ou pour le dégausse (démagnétisation) de l�écran d�un PanelView 1400.

Pour modifier les paramètres de configuration évolués :

•  cliquez deux fois sur l�icône Advanced (Evoluée) dans le dossier Application 
Settings (Configuration de l’application) ou
•  sélectionnez Application>Configuration puis cliquez sur l�onglet Evoluée.
L'onglet qui apparaît indique les champs spécifiques à votre terminal. Pour plus 
d�informations sur les options évoluées, cliquez sur le bouton Aide de la boîte de 
dialogue ou, pour plus de détails sur un champ spécifique, appuyez sur F1 dans le 
champ.

Toutes les modifications que vous apportez sont chargées dans le terminal avec l�application si la case Utiliser les 
paramètres de configuration chargés est cochée dans l'onglet Mise sous tension.

Activation ou désactivation de l'utilisation d'un projet
L'onglet Projet de la boîte de dialogue Configuration de l'application active ou désactive l'utilisation d'un 
projet associé à une application. Si vous activez l'utilisation de projets associés à votre application afin qu'une 
base de données de points puisse être partagée ou utilisée par d'autres applications, l'icône du projet sera 
disponible dans le dossier Configuration de l'application. Reportez-vous à la page 122 pour plus de détails.

Pour activer ou désactiver l'utilisation d'un projet :
• cliquez deux fois sur l'icône Protection dans le dossier Configuration de l'application ou
• sélectionnez Application>Configuration, puis cliquez sur l�onglet Projet.
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Configuration de la protection pour une application
PanelBuilder32 offre des fonctions de protection par mot de passe qui permettent de 
limiter l'accès des vues et du terminal (écrans de configuration inclus) aux opérateurs 
habilités. Vous pouvez également créer des vues pour permettre aux opérateurs habilités 
de sélectionner et de modifier les mots de passe des autres opérateurs. 

Pour accéder aux options de protection pour une application :

• cliquez deux fois sur l'icône Security (Protection) dans le dossier Application Settings 
(Configuration de l'application) ou

• sélectionnez Application>Protection

La plupart des options de protection peuvent être configurées à partir de l'un des 3 onglets de la boîte de 
dialogue Protection.

Propriétés : définit les propriétés générales de protection :

• vue, connexion ou autoconnexion ;
• mots de passe numériques ou alphanumériques ;
• entrée masquée du mot de passe ;
• protection des écrans de configuration du terminal ;
• protection du terminal lorsqu'il est inactif.

Opérateurs : définit les droits d'accès opérateurs :

• nom et mot de passe de chaque opérateur ;
• accès aux écrans de configuration du terminal ;
• autorisation de modifier le mot de passe des autres opérateurs ;
• possibilité de modifier le mot de passe d'un opérateur ;
• désactivation de l'affichage du mot de passe d'un opérateur sur le terminal.

Infos protection des vues : donne une liste de toutes les vues de l'application et limite l'accès opérateur aux 
vues protégées. Vous pouvez spécifier pour chaque vue :

• si elle est protégée ;
• les opérateurs ayant le droit d'accéder aux vues protégées.

Suggestion : vous pouvez également protéger une vue et indiquer les opérateurs autoriser à y accéder dans la 
boîte de dialogue Vue>Nouvelle ou la boîte de dialogue Propriétés. Toutefois, les droits d'accès opérateurs 
doivent être définis dans la boîte de dialogue Application>Protection. 
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Dans l'onglet Operators (Opérateur) présenté en exemple ci-dessous, un nom et un mot de passe sont 
attribués à deux opérateurs : Supervisor (directeur) et Engineering (ingénieur). Les deux opérateurs ont accès 
aux écrans de configuration du terminal. Le directeur est autorisé à modifier le mot de passe de l'ingénieur. 
Remarquez que le mot de passe de l'ingénieur est modifiable par d'autres opérateurs (Case Changeable 
(Modifiable) cochée).

L'onglet Secured Screen Info (Infos protection des vues) indique que toutes les vues sont protégées 
(Main Menu, Pump Controls, Changing Security). Le directeur a accès à toutes les vues tandis que le service 
d'ingénierie n'a pas accès à la vue Modification de la protection.

Touches de protection

Il s'agit d'objets de vues utilisés sur le terminal pour réaliser les opérations suivantes :
• entrée/vérification des mots de passe ;
• connexion/déconnexion ;
• sélection et modification des mots de passe opérateurs ;
• désactivation/activation de la protection du terminal.

Ces touches se trouvent dans le menu Objets>Touches de protection.
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Chapitre 11

Transfert des applications

Ce chapitre couvre les sujets suivants :
• options de transfert des applications ;
• utilisation d�une carte mémoire ;
• drivers de communication ;
• validation d'une application ;
• chargement d�une application directement dans un terminal ;
• chargement d�une application via un réseau ;
• chargement d�une application dans une carte mémoire ;
• transfert d�une application directement depuis un terminal ;
• transfert d�une application via un réseau ;
• utilisation de l�utilitaire de transfert de fichiers.

Pour plus de détails sur le chargement et le transfert d�applications, ouvrez le livre Travailler avec les 
applications dans l'onglet Sommaire de l�aide.

Options de transfert des applications
Vous pouvez transférer des applications entre un ordinateur et un terminal PanelView ou une carte mémoire en 
utilisant :

• les commandes Fichier>Charger ou Fichier>Transférer de PanelBuilder32 ;
• l�utilitaire de transfert de fichiers (WinPFT) hors de PanelBuilder32.

Si vous utilisez l�utilitaire de transfert de fichiers, vous devez d�abord enregistrer l�application au format de 
fichier .PVA avec la commande Fichier>Enregistrer sous. L�utilitaire de transfert de fichiers ne transfère 
que des fichiers .PVA du terminal PanelView.

Suggestion : vous pouvez également utiliser la commande Fichier>Enregistrer sous de PanelBuilder32 
pour enregistrer un fichier .PVA directement dans un lecteur de carte mémoire ATA. 
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Utilisation d’une carte mémoire
Les ordinateurs ayant un lecteur de carte ATA ou DataBook TMB240/TMB250 peuvent transférer des 
applications sur carte mémoire. 

• Les lecteurs de carte ATA acceptent les cartes 2711-NM2xx. 
• Les lecteurs de carte DataBook acceptent les cartes2711-NMx. 

Vous pouvez insérer la carte mémoire dans le logement de carte d�un terminal PanelView et charger l�application 
dans le terminal dans le mode Configuration du terminal. Les cartes mémoire permettent de charger des 
applications sur plusieurs terminaux d'un atelier sans avoir à utiliser un ordinateur.

Vous pouvez utiliser une carte mémoire même si votre ordinateur n�est pas muni d�un lecteur de carte ATA. 
Pour ce faire, chargez l'application sur un terminal, puis transférez l'application chargée sur le terminal vers une 
carte mémoire. Utilisez ensuite cette carte mémoire pour charger l�application sur les autres terminaux de 
l�atelier.

Drivers de communication 
Avant de transférer les applications entre un ordinateur et un terminal PanelView, vous devez avoir installé le 
driver de communication approprié sur l�ordinateur. Le driver établit la communication nécessaire pour le 
transfert des fichiers. Le driver dépend de la configuration du réseau.

Driver DF1 interne

Pour transférer des applications point à point entre le port COM série de votre ordinateur et le port 
RS-232/DF1 d�un terminal PanelView, utilisez le driver DF1 interne de PanelBuilder32. Ce driver est disponible 
automatiquement lors du chargement ou du transfert de l�application. Vous n'avez rien besoin de faire. Le driver 
DF1 utilise des paramètres qui doivent correspondre à ceux du terminal PanelView.

Vitesse (bauds) 19200

Parité Aucun

Détection d’erreurs CRC

Bits d'arrêt 1

Protocole Full duplex
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Vous ne pouvez pas utiliser le driver DF1 pour transférer des applications entre un ordinateur et un terminal 
PanelView DH-485 ou RS-232 (DH-485). Il faut utiliser le driver matériel RSLinx 1747-PIC. 

Utilisation de drivers RSLinx

Pour transférer des applications sur un réseau ou entre deux réseaux de communication, il faut configurer le 
driver RSLinx approprié sur l'ordinateur. RSLinx est installé en même temps que PanelBuilder32.

Pour accéder à RSLinx : 

• cliquez sur Démarrer, Programmes, Rockwell Software, puis sur le sous-menu RSLinx et 
sélectionnez RSLinx.

• ou cliquez sur Fichier>Config Station dans PanelBuilder 32.
Pour plus de détails sur la configuration du driver RSLinx, reportez-vous à la documentation en ligne de RSLinx. 
La configuration des drivers s'effectue généralement en sélectionnant Communications>Configure 
Drivers dans RSLinx ou à partir des boîtes de dialogue WinPFT.

IMPORTANT Le driver DF1 n'est pas utilisable si le port série de l'ordinateur est configuré pour un driver 
RSLinx ou s'il est utilisé par une autre application.
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Validation d'une application
Une application est automatiquement validée (c'est-à-dire que le programme vérifie 
qu'elle ne contient pas d'erreur) lorsqu'elle est chargée dans un terminal. Vous pouvez 
également valider une application en sélectionnant la commande Valider tout ou 
Valider les modifications dans le menu Application. Si des erreurs ou des mises 
en garde sont détectées, la fenêtre de résultats s'ouvre. La correction des erreurs est 
nécessaire, celle des mises en garde facultative. Les mises en garde n�affectent pas 
l�intégrité de l�application.

Lorsque la fenêtre de résultats s�ouvre, le menu Exceptions (Résultats) est activé. Ce menu contient des 
commandes qui agissent sur les erreurs/mises en garde depuis la fenêtre elle-même. Sélectionnez une erreur ou 
une mise en garde puis sélectionnez une commande du menu Résultats (ou cliquez avec le bouton droit de la 
souris et sélectionnez une commande du menu contextuel). 
 

Le menu Résultats reste actif jusqu�à ce que la fenêtre de résultats soit fermée dans le menu Affichage ou en 
cliquant sur le X dans le coin de la fenêtre.

Sélectionnez : Pour :

Aller à Passer à la source de l'erreur sélectionnée.

Détails Afficher l’aide pour l’erreur sélectionnée.

Supprimer les mises en garde 
sélectionnées

Empêcher le message de mise en garde sélectionné d’être affiché dans la fenêtre 
de résultats.

Supprimer les mises en garde Empêcher les messages correspondant à des codes spécifiques d’apparaître dans 
la fenêtre de résultats. Vous ne pouvez pas supprimer les messages d’erreur.

Imprimer tout Imprimer toutes les erreurs et les mises en garde de la fenêtre de résultats.

Autoriser l'ancrage Ancrer la fenêtre de résultats contre un bord de la fenêtre ou la laisser libre 
comme toute autre fenêtre.
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Surveillance de la progression du chargement ou du transfert
Lors du chargement et du transfert d�applications, une boîte de dialogue s�ouvre pour vous permettre de suivre 
la progression du transfert.

• La zone Download Tasks (Tâches du chargement) surveille chaque étape du transfert et indique 
la tâche courante. 

• La zone Status (Etat) d�avancement indique les erreurs qui se produisent pendant la transmission. Pour 
obtenir de l�aide, cliquez deux fois sur une erreur. 

• L�indicateur de progression (Progress) indique l'état et le pourcentage du chargement effectué.

Le terminal PanelView montre également l�état d�un chargement ou d�un transfert en cours.

Indique la tâche en cours, 
pendant le chargement ou 
le transfert 

Indique l’état 
de chaque tâche

Si une erreur apparaît, 
cliquez deux fois dessus 
pour obtenir l’aide.

Cliquez pour annuler 
le transfert
Publication 2711-GR003C-FR-P



142          Transfert des applications
Chargement d’une application directement dans un terminal 
Cette section explique comment charger une application depuis le port COM série de l�ordinateur dans le port 
RS-232/DF1 du terminal PanelView à l�aide d�une connexion point à point. Le chargement utilise le driver DF1 
interne du port COM1- COM9 de l�ordinateur. 
Utilisez le câble 2711-NC13 ou 2706-NC13 (connecteur 9 broches) pour la connexion point à point. Pour 
PanelView 300 Micro, utilisez le câble 2711-CBL-PM05. Vérifiez les connexions de câble avant de lancer le 
chargement.

Ouvrez l�application à charger et sélectionnez Fichier>Charger. L�application est validée pendant le 
chargement. Toute erreur se produisant à la validation doit être corrigée avant de pouvoir poursuivre le 
chargement.

 

Quand le chargement est terminé, le terminal se réinitialise, vérifie l'application et la lance.

IMPORTANT Pour transférer des applications entre un ordinateur et un terminal PanelView DH-485 ou 
RS-232 (DH-485), vous devez utiliser le driver matériel RSLinx 1747-PIC et non le driver 
interne DF1.

Sélectionnez un 
port COM pour le 
chargement 

Lance le 
chargement 

Nom de l’application 
chargée

Paramètres par défaut devant 
correspondre aux paramètres fixes du 
terminal PanelView
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Chargement d’une application via un réseau
Pour charger des applications sur un réseau ou entre différents réseaux, vous devez avoir configuré et exécuté le 
driver RSLinx approprié sur votre ordinateur. 

Pour une liste des configurations de réseau prises en charge par les terminaux PanelView, ouvrez le livre 
Transférer des applications dans l'onglet Sommaire de l�aide et sélectionnez Chemins du 
réseau RSLinx. 

Ouvrez l�application à charger et sélectionnez Fichier>Charger. L�application est automatiquement validée. 
Vous devez corriger toute erreur se produisant avant de pouvoir poursuivre le chargement.

Suggestion : vous pouvez également charger un fichier depuis la boîte de dialogue de démarrage de 
PanelBuilder32. Du fait qu�aucun fichier n�est ouvert, vous serez invité à saisir le nom d�une application ou à 
sélectionner une application enregistrée au format .PVA de PanelView.

Quand le chargement est terminé, le terminal se réinitialise, vérifie l'application et la lance.

Nom de l’application 
chargée

Sélectionnez Réseau RSLinx 
pour charger l’application 
sur un réseau

Présente une liste ou les icônes des équipements 
du réseau pour le driver sélectionné.

Sélectionnez la station 
cible pour le chargement

Drivers RSLinx sur l’ordinateur

Cliquez sur + pour voir les 
équipements pour chaque driver 
ou sur - pour réduire l’affichage
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Utilisation de Pass-Through RIO
Pour transférer une application entre un ordinateur et un terminal PanelView sur un réseau RIO, sélectionnez 
Pass-Through RIO dans la zone Type de transfert de la boîte de dialogue Chargement ou Transfert. A 
l'aide de RSWho, sélectionnez le scrutateur PLC, SLC ou 1756-DH RIO auquel PanelView est connecté sur le 
réseau RIO. Cliquez sur le bouton Configuration pour configurer les paramètres présentés ci-dessous.
Important : la case Pass-Through doit être cochée dans la section Bloc-transfert de la boîte de dialogue 
Configuration de la communication.

ATTENTION

!
Si vous effectuez un chargement alors que le processeur est en mode d�exécution, vérifiez 
l�adresse de rack du terminal cible. Charger à une adresse incorrecte peut entraîner un 
fonctionnement imprévu ou endommager le matériel.

Scrutateur PLC ou 1756-DH RIO Scrutateur SLC

Paramètres PLC
Rack address 
(Adresse de rack)

Pour un scrutateur de type PLC, sélectionnez 
l’adresse de rack (0 - 76 octal) du terminal 
PanelView sur la liaison RIO.

Starting Module 
(Module de 
début)

Sélectionnez le groupe module de début (0,1 
2,3 4,5 ou 6,7) du terminal PanelView dans le 
rack RIO.

Paramètres SLC
SLC Scanner 
Location 
(Emplacement du 
scrutateur SLC)

Sélectionnez le numéro d’emplacement où 
réside le scrutateur SLC. Par défaut, c’est celui 
qui est le plus à gauche (carte de scrutateur la 
plus proche du processeur).

Rack Address 
(Adresse de rack)

Spécifiez l’adresse de rack du terminal 
PanelView sur le réseau RIO.

Starting Module 
(Module de début)

Sélectionnez le groupe module de début (0,1  
2,3  4,5 ou 6,7) du terminal PanelView dans le 
rack RIO.
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Chargement d’une application dans une carte mémoire
Cette section explique comment charger une application dans une carte mémoire. Ouvrez l'application à charger 
et sélectionnez Fichier>Charger. L'application est automatiquement validée, convertie en fichier .PVA et 
copiée sur la carte. 

Suggestion : la commande Fichier>Enregistrer sous de PanelBuilder32 permet également d�enregistrer 
un fichier .PVA directement sur un lecteur de carte ATA.

Sélectionnez Carte mémoire 
et cliquez sur Configuration

Pour cartes flash linéaires

Entrez le nom d’un fichier .PVA dans lequel 
enregistrer l'application .PBA convertie ou cliquez 
sur Browse (Parcourir) pour rechercher un fichier.

Pour les lecteurs de cartes DataBook TMB240 ou TMB250, 
entrez la chaîne de commande suivante :

CMD %s Lecteur :
CMD Commande DOS de copie de fichier sur la carte. La 

commande est spécifique au lecteur. Voir les 
instructions du lecteur de carte.

%s Caractère générique par lequel PanelBuilder 
remplace le nom du fichier d’application. 

Lecteur : Lecteur de carte mémoire de l’ordinateur (F: ).

2711-NM1x2711-NM2x

 

La prochaine fois que vous chargerez sur une carte mémoire, vous 
n’aurez qu’à sélectionner cette ligne dans la liste de commandes.

Exemple : TCXCOPY  %s  F:

Pour cartes ATA
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Transfert d’une application directement depuis un terminal
Cette section explique comment transférer une application depuis le port RS-232/DF1 du terminal PanelView 
dans le port COM série de l�ordinateur à l�aide d�une connexion point à point. Le chargement utilise le driver 
DF1 interne du port COM1- COM9 de l�ordinateur. 

Utilisez le câble 2711-NC13 (connecteur 9 broches) pour la connexion point à point. Pour PanelView 300 Micro, 
utilisez le câble 2711-CBL-PM05. Vérifiez les connexions de câble avant de lancer le chargement.

Pour transférer une application, sélectionnez Fichier>Transférer. Vous pouvez également transférer un 
fichier depuis la boîte de dialogue de démarrage de PanelBuilder32. 

Quand le transfert est terminé, l'application s�ouvre dans PanelBuilder32 à moins que vous n�ayez transféré 
l�application sur fichier disque. 

IMPORTANT Pour transférer des applications entre un ordinateur et un terminal PanelView DH-485 ou 
RS-232 (DH-485), vous devez utiliser le driver matériel RSLinx 1747-PIC et non le driver 
interne DF1.

Sélectionnez la destination du fichier transféré :
• sur fichier disque (sans l’ouvrir dans 

PanelBuilder32)
• sur fichier disque, puis ouverture dans 

PanelBuilder32 
• dans PanelBuider32 (sans sauvegarder sur disque)

Transfère le fichier vers l’emplacement par défaut ou 
vers un autre emplacement

Transfère le fichier sous son nom 
d’origine ou sous un autre nom

Sélectionnez un port COM à utiliser pour 
le transfert  Sélectionnez les valeurs à transférer avec l'application.
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Transfert d’une application via un réseau
Cette section explique comment transférer des applications via un réseau ou entre différents réseaux au moyen 
des drivers RSLinx. Le driver RSLinx approprié doit être configuré et exécuté sur l�ordinateur. Pour transférer 
une application, sélectionnez Fichier>Transférer.

Pour une liste des configurations de réseau prises en charge par les terminaux PanelView, ouvrez le livre 
Transférer des applications dans l'onglet Sommaire de l�aide et sélectionnez Chemins du 
réseau RSLinx.

Quand le transfert est terminé, l'application s�ouvre dans PanelBuilder32 à moins que vous n�ayez transféré 
l�application sur fichier disque. 

Transfère le fichier sous son nom d’origine ou sous un 
autre nom

Sélectionnez la destination du fichier transféré :
• sur fichier disque (sans l’ouvrir dans PanelBuilder32)
• sur fichier disque, puis ouverture dans 

PanelBuilder32
• dans PanelBuider32 (sans sauvegarder sur disque)

Transfère le fichier vers l’emplacement par défaut ou 
vers un autre emplacement

Sélectionnez les valeurs à transférer avec l'application 

Sélectionnez Réseau RSLinx pour 
transférer l’application sur un réseau

Sélectionnez la station 
PanelView depuis laquelle 
l’application sera transférée

Drivers RSLinx sur l’ordinateur 

Cliquez sur + pour voir les équipements 
pour chaque driver ou sur - pour réduire 
l’affichage

Présente une liste ou les icônes des équipements 
du réseau pour le driver sélectionné
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Utilisation de l’utilitaire de transfert de fichiers WinPFT
Utilisez l�utilitaire de transfert de fichiers WinPFT pour transférer des applications entre un terminal PanelView 
et un ordinateur sous Windows sans ouvrir PanelBuilder32. 

 

Pour utiliser l�utilitaire de transfert de fichiers, sélectionnez Programmes>PanelBuilder32>WinPFT dans 
le menu Démarrer.

IMPORTANT L�utilitaire de transfert de fichiers permet uniquement de charger des fichiers au format 
.PVA du terminal PanelView. Utilisez la commande Fichier>Enregistrer sous dans 
PanelBuilder32 pour enregistrer des applications sous ce format.

CONSEIL Si vous décochez la case Utiliser RSLinx si disponible, le réseau RSLinx et 
Pass-Through RIO ne seront plus disponibles en tant qu'options de type de 
transfert dans les boîtes de dialogue. Pour transférer les fichiers directement à l'aide 
du driver DF1, décochez cette case. Le fait de décocher cette case accélère le 
traitement car RSLinx n'est plus chargé dans la mémoire.

Charge un fichier .PVA sur un terminal ou une carte mémoire.

Transfère l’application depuis 
le terminal vers l’ordinateur.

Compare une application à celle du terminal 
ou d’un fichier sur disque.

Sélectionnez PanelView.
Sélectionnez cette option pour activer RSLinx pour 
réseau ou transfert Pass-Through. Désélectionnez 
cette option pour désactiver RSLinx et effectuer 
uniquement des transferts directs à l'aide du 
driver DF1.
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La boîte de dialogue de Download Files (Chargement de fichiers) de l�utilitaire de transfert de fichiers 
est la même que celle de PanelBuilder32 à quelques exceptions près.

• Vous devez saisir le nom d�un fichier .PVA à charger puisque l�utilitaire de transfert de fichiers ne charge 
des applications qu�au format de terminal .PVA.

• Vous pouvez choisir de ne charger l�application que si elle est différente de l�application chargée dans le 
terminal PanelView cible.

La boîte de dialogue Transfert de fichiers est identique à celle de PanelBuilder32.
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Vérification d'une application

Cliquez sur Vérification dans la boîte de dialogue de l�utilitaire de transfert de fichiers pour comparer 
l�application à charger à une application déjà chargée dans un terminal PanelView ou sur un fichier disque. Cela 
vous permet de vérifier les éventuelles différences avant de charger une application dans un terminal. Vous avez 
aussi la possibilité de charger l�application si l�application de référence est différente de celle déjà chargée dans le 
terminal.

Entrez le nom du fichier disque à comparer à 
l’application d’un terminal ou d’un fichier disque 
ou cliquez sur Parcourir pour le rechercher. 

Sélectionnez l’emplacement cible de l’application 
à vérifier.

• DF1Point-à-Point
• Réseau RSLinx ou Pass-Through RIO
• Application sur disque

Choisissez de charger l’application si elle est différente de l’application 
chargée dans le terminal.

Entrez le nom du fichier .PVA à 
comparer à l’application de 
référence, ou cliquez sur 
Parcourir pour le trouver.

Sélectionnez la station du terminal 
PanelView à comparer à l’application 
de référence. 
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